


Editorial

“We need a new
frame of reference

for what our
expectations from

robots are”

W HAT IS THE first image that
comes to your mind when
you hear the term ‘robot’?

Most likely it will be R2D2 or C-3PO or
even Hal (from 2001: A Space Odyssey). If
indeed 'robot' conjures up any of these
images, then this term is actually
jeopardising the future of robotics by
a decade or more. The complexities
that are implicit in these images are so
high that no company in the world can
make it a reality today.    

The answer lies in simplifying the
entire field of robotics. We need a new
frame of reference for what our
expectations from a robot are. In the
industrial setup, we have made
significant progress through
simplification—we have robots that
can weld and those that can lift heavy
machinery. Then there are those that
can test products for defects again and
again and again… taking away the rote
mechanical and menial jobs from us
humans, dramatically increasing
efficiencies and removing the element
of human error. 

Similarly, early computers started
with the ability to perform simple

tasks with unerring accuracy, be it
calculations or record keeping. The
success of the computer industry was
predicated on taking care of simple
tasks before entrusting and
developing machines to handle things
more complex, such as cleaning dishes
and washing clothes! 

Technologies required to develop
truly consumer friendly robots already
exist. We have made progress in the
motion sensors, voice recognition, and
processing power of robots in the past
several years. We have also seen
significant progress on the AI
(artificial intelligence) front. Carnegie
Mellon and other universities have
been able to develop this technology to
such levels that a robot is able to drive
a car at speeds of up to 20mph. 

Then the obvious question is: So
why have we not seen an explosion of
the consumer robotics industry?

The future of consumer robotics
depends on—knowing what the
customers want and what they are
willing to pay for it.  This is easier said
than done. An industry driven by the
nerds and people who love robotics for
its own sake may not help consumers
meet their needs. Today, robotics is
more like a solution in search of a
problem. Too many robotics
businesses are built as if they were
part of a university programme where
every graduate student wants to add
that one last feature to the product,
just because he or she can. Sounds
familiar to the Silicon Valley of three
decades ago?

Let us start simple… Define the
need. That may be the first step for the
consumer robotics industry.

Maulik Jasubhai Publisher

Robots-Much Misunderstood
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25 Movie Madness 
Movies today use technology more than
ever—think breathtaking special effects
and digitised post-production techniques.
But what about when it comes to depicting
technology and how it is used?  

Enter

16
With a digital
camcoder, a
smartphone
and a penchant
for gadget
shopping,
Pooja Bedi is
our celeb geek
this month

16
You’ll soon be
able to buy
MP3s on
Amazon

24
A quick guide
to Podcasting
in our W5H
section

Digital Passion

Contents Magazine

116 How OLED Works 
A visual walkthrough that tells you how the
latest display technology functions, here’s a
crash course on the working of OLED

74 Megapixel Mania 
A spread of 40 digital cameras reviewed and rated
just to help you make the right pick. A comprehen-
sive test, covering three categories—Entry-level, Mid-
range and High-end cameras 

32 I, Robot - Your Friend 
Will robots become commonplace in our
lives in the years to come? How different
would our world be with robots co-existing
with us? Re-visit the sci-fi books—take a peek
into the future

42 GRR-aphics Cards
Which one will fit your budget? Which one
will make your processor look like a wimp?
Which is a true-blue beefcake? All this in the
graphics card shootout

Digital Tools

64 An Online Cache Of LNG
From journalism to a one-stop shop for all things LNG,
we see how Kamlesh Trivedi jumpstarted himself onto
the Internet with www.LNGworldwide.com

110 New & Notable 
Take a look at all the new and notable stuff
this month, and also get a sneak peek at
Windows Vista, Microsoft’s latest offering
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122 Smart Access 
The days of an attendance muster in an office are
long gone, but swipe cards and punch cards are on
their way out too. Offices are going smart with
Access Control

124 Is Paperless The Way To Be?
Does a paperless office increase productivity? Are the
security concerns of a paperless office for real? We
conduct an interesting debate on the need to go
completely digital at your workplace

125 Ergonomics At Work 
Get the right keyboard for your computer
and save yourself from injuries due to
constant typing. It’s all about ergonomics 

130 Let’s Play, Gentlemen
Cricket games are always hot in India. We
take a critical look at Brian Lara International
Cricket 2005

132 Tech Shopping
With the festive season fast approaching, Digit
takes you on the essential electronic goods
shopping tour 

119 Playing Mailman
How effective are the paid-for mailboxes provided by
e-mail service providers? Is having a personalised e-mail
ID really Smart Business?

Digital Business

Escape

142
Jon Von
Neumann is the
father of the
stored-program
concept 

143
Can you imagine
getting mugged
online? It hap-
pened last
month in Japan
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F.E.A.R. Demo
This single-player demo for the action-
horror FPS F.E.A.R. features an
introductory cut-scene and a portion of
the mission from the full game where you
must find and neutralise Paxon Fettel

Brian Lara International
Cricket 2005 Demo
Brian Lara
International Cricket
2005 delivers all the
atmosphere and
excitement of major
international cricket,
in one-dayers, tests
and tournaments
(Read the review of the game on page 130)

ASP Express DotNet
Edition 4.1
ASP Express provides
extensive automation
for laborious
ASP/ASP.Net chores
without having to give up the
necessary HTML automation needed to
provide ASP documents

DEVELOPER TOOLS
n EasyASP 4.0.2
n InstallWizard XP 2005 4.7
n Visual Basic Express Edition Beta 2
n Visual C# Express Edition Beta 2
n Visual C++ Express Edition Beta 2
n Visual Web Developer 2005 Express

Edition Beta 2

LINUX
n ImageMagick version 6.2.3
n Cycas version 3.20
n Griffith version 0.3
n Opera version 8.02
n SWF Widgets version 1.5
n Wine version 20050725
n Xpdf version 3.00pl3

GAMES
n War World: Tactical Combat 

n Worms 4: Mayhem

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Adobe Illustrator CS2 tryout
Rediscover what you
love about illustration
with the new Adobe
Illustrator CS2.
Convert bitmaps to
scalable, editable
artwork in seconds

Internet
Explorer 7.0
Beta 1
The first stage of the
beta process for
Internet Explorer 7
has begun—developer

testing! The latest version of the
world’s most popular browser has been
released for technical evaluation

Adobe Encore DVD 1.5
Adobe Encore takes DVD authoring to a
new level of
creativity with a
streamlined
workflow, a
comprehensive set
of design tools, and
smooth integration
with other Adobe
software

MULTIMEDIA
n Adobe InDesign CS2 tryout
n Roxio Easy Media Creator 7.5.0.47
n Nero 6 Ultra Edition 6.6.0.15
n Photo2DVD Studio 4.5
n Media Center 11.0.309
n Video Edit Magic 4.09
n Nero Media Player 1.4.0.34a
n Winamp 5.094 Full

INTERNET

n DKMessenger 4.1.8
n Mozilla 1.7.11
n Internet Explorer 7.0 beta
n Webserver Stress Tool 7.0.3.187
n Mozilla Thunderbird 1.0.6
n RSS Aggregator 3.32

SYSTEM
n ZoneAlarm Antivirus 6.0.631.003
n AutoPatcher XP July 2005
n Windows 2000 Service Pack 4 (SP4)
n SiS SiS650/SiS740 Family

Chipset Graphics Driver
(Windows 2000/XP) 2.22

n Acronis Migrate Easy 7.0
n JiWire SpotLock 1.6.91
n LogiGuard Master Mechanic 1.4
n MindSoft Utilities XP 8.2
n Automize 6.21

DIGIT IN PDF
By popular demand, archives of the
past 12 months are back!

The Logo Creator 3.6.1
This software consists of professional
logo templates you can manipulate in
dozens of ways with designs that will
help brand your company

Solid Converter
PDF to Word 2.2
Recover and reuse
your PDF content with
Solid Converter PDF
to Word

Whitepapers on
Bluetooth Security
Think your piconet is
safe while you’re
sitting in a coffee
shop? These
whitepapers should
give you
a better idea

PRODUCTIVITY TOOLS 
n Visual Studio .Net - Step by Step 7.0
n Learn Java (GUI Applications) 2.0

n PHP Designer 2005 3.0.6
n EasyOffice with PDF Filter 9.0
n MOBILedit Lite 1.97.7

WHITEPAPERS
n Bluetooth And Bluetooth Internet

Access Points
n Bluetooth Networking—Taking

Handheld Computing
to the Next Level

n Intel Software Insight:
Multi-Core Capability
by Intel

n Maximise the Business
Value of Software
by Borland Software Corporation

n Successfully Managing Geographically
Distributed Development
by IBM Software Group

NASA World Wind 1.3.1.1
World Wind lets you zoom from satellite
altitude into any place
on Earth. Leveraging
Landsat satellite
imagery and Shuttle
Radar Topography
Mission data, World
Wind lets you
experience terrain in visually rich 3D, just
as if you were there

Google Earth
Want to know more
about a specific
location? Dive right
in—Google Earth
combines satellite
imagery, maps and the
power of Google Search to put
the world’s geographic information at
your fingertips

Star Wars:
Empire At War
Official Trailer 1
Storm troopers,
rancours, and even the
occasional Sith lord
enter the fray in Star Wars:
Empire at War

E-BOOKS
n Sherlock Holmes: The

Complete Collection
n A reader's

Roadmap For The
21st Century

n Netwriting Masters
n The Mulder Dreams

Series by xgirl
n Have Some Fun :

Laugh Your Blues Away
n 130 Funniest News Stories
n Twilight: In the Spaces Between

VIDEOS
n Open Book
n Final Fantasy VII:

Advent Children Official Trailer 2

n Project Gotham Racing 3
Official Trailer 2

n Ninja Gaiden Black Official Trailer 1

NNoottee::  If you do not want to boot from the DVD, remove it from the drive at startup

Certain systems need Macromedia Flash Player to view the contents of the DVD/CD. Get it from http://snipurl.com/90oh
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MyDbConverter 3.0
A very powerful tool to convert your
MS Access databases to MySQL or
MySQL to MS Access, which features
an easy-to-use Wizard-style interface

ToWeb 1.01

ToWeb is designed for persons and
organisations without any Web
designing skills wishing to quickly
create a blog or Web site 

AVIRA for Unix Server
AVIRA for Unix Server is a
versatile AntiVirus
solution designed to
ensure flawless
protection against
viruses and unwanted
programs in any-size
corporate networks

DEVELOPER TOOLS
n VLViewPort 1.0
n VLPropertyList 1.2
n Doodle 2.1

n Visual Web Developer 2005 Express
Edition Beta 2

n Gecko.NET GIS Control and Library 1.0
ProxyGen 1.1

n HTML To PHP Converter 4.2.1.9
n VLFullScreen 1.0
n MyDbConverter 3.0
n ToWeb 1.01
n Power Website Builder 1.5

LINUX
n Console Tools 0.2.3
n Comanche 3.0 Beta 4
n Xmahjongg 3.6.1
n Snes9express 1.26-2
n XFree86 Base 3.3.6 glibc

DIGITAL PASSION DIGITAL TOOLS DIGITAL BUSINESS DIGITAL LEISURE

Contents Interactive

Mozilla Firefox 1.0.6
Mozilla Firefox is a fast,
full-featured Web
browser that makes
browsing more efficient
than ever before

MSN Messenger 7.0
This is the latest version of
the ever-popular MSN
Messenger. Check out its
new features

Spybot - Search &
Destroy 1.4
Spybot - Search & Destroy can detect
and remove a multitude of adware files
and modules from your computer.

MULTIMEDIA
n Visual Communicator 1.60.1297
n Meedio Express 1.36.1
n Video Edit Magic 4.09
n RealPlayer 10
n Slideshow Pro 9.6.6
n DSH Jukebox 9.0
n Ultra Video Splitter 3.3.4
n Alcohol 120% 1.9.5.3105

INTERNET
n Ad-Aware SE Personal Edition 1.06
n Multi-Browser XP 10.1.2
n PhaseOut 5.4.3
n Web Monitor 2.11
n Gogo Explorer 2.0.3.634
n ICQ 5.04
n RoboForm 6.3.98
n 1-Click Answers

1.0.6.171
n Google Toolbar 3.0.124.6
n MSN Search Toolbar with Windows    

Desktop Search 2.02
n Fax4Outlook 2.50.0005

ESSENTIALS
n Avast Home Edition 4.6
n Spybot - Search &
Destroy 1.4
n WinZip 9.0 SR-1
n DivX Play Bundle with
DivX Player 6.0
n WinRAR 3.42
n SpywareBlaster 3.4
n IrfanView 3.97
n ZoneAlarm 6.0.631.003
n Mozilla Firefox 1.0.6
n MSN Messenger 7.0
n Norton AntiVirus Definitions

Update 5/8/2005
n Kerio Personal Firewall 4.0
n MSI Nvidia-based Graphics Drivers

(Windows 2000/XP) 31.0
n Opera for Windows (Non-Java) 8.02

SYSTEM
n iMesh 5.2
n BitComet 0.57
n FoldMonkey 1.34
n Nucleus Kernel Undelete 4.02
n PDF Compress 1.0
n AllKeys 1.032
n Folder Lock 5.2.4
n Keynesis Lockngo Professional 3.1
n JiWire SpotLock 1.6.91

Xingtone Ringtone Maker  
Make your own true-tone ringtones from
your favourite audio files and send them
to your phone wirelessly without cables
or Bluetooth

OmniFleet Shop 8.1 
OmniFleet Shop is an easy-to-use
maintenance management
application for in-house
repair shops. Track
information for
equipment, employees,
vendors, repairs, fuel,
parts inventory, and PM

RelayFax Server 6.5.1
RelayFax is an e-mail-to-fax and fax-to-
e-mail fax server. RelayFax Pro
automates the process of sending,
receiving, and managing your network
fax traffic

PRODUCTIVITY TOOLS
n Art-Copy Business Edition 7.5.4
n DataTrakScheduler 1.0
n RelayFax Server 6.5.1
n OmniFleet Shop 8.1
n PDF2Htm 1.0
n Kernel Word - Repair

Corrupted Word
n Documents 4.02
n Ocean Mail Server 1.07
n Outlook Helper 1.1
n Yeah Write 1.7
n Jetsoft P2S Converter 1.07

MOBILE APPS
n Xingtone Ringtone Maker 4.1.76
n Smart VAS J2ME Client 1.0.5
n World History Trivia 1.5
n Commander Mobile Anti-Virus 3.0
n BeetzStream SmartRss for Windows
n SmartPhone 2.0
n Maxinote 1.10
n Webcam SMS 4.0.1

Wedding Crashers Trailer
Watch the trailer for the latest comedy
staring Vince Vaughn and Owen Wilson 

Mario Forever 2.16
This Super Mario 3 clone from Poland
features a mustachioed plumber on a
quest to save his true love

ICC Cricket
Captain 2005
Exciting cricket action
comes to your desktop

100 WALLPAPERS 
n Wallpapers based on aircraft,

nature, animals and celebs

SIMS 2 VIDEO REVIEW
Street Challenge is an authentic, free,
online multiplayer drag racing simulator

CD

DIGIT SEPTEMBER 2005
For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the
subject. If the subject is not mentioned, your mail might not reach the right person.

Certain systems need Macromedia Flash Player to view the contents of the DVD/CD. Get it from http://snipurl.com/90oh
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By Demand
You get to choose what goes in Digit
Interactive. This month, you chose:

F.E.A.R. Game Demo
Google Earth

Online Digit Patrons
It really does

pay to be loyal!

Find out more

on www.
thinkdigit.com

Digit Reader Poll

This Month’s Question

How much will you spend on
technology-related products
this festive season?

Nothing

Up to Rs 5,000

Rs 5,000 to Rs 15,000

Rs 15,000 to Rs 30,000

Rs 30,000 to Rs 50,000

More than Rs 50,000

Log on to www.thinkdigit.com
and vote

taste technology at www.thinkdigit.com

September 2005

There’s something for everyone on the Digit Forum www.thinkdigit.com/forum

Last Month’s Question:

Which section of Digit is your favourite?

infographic Vijay Padaya

What are sections? 10%

Digital Leisure 11%

Digital Business 4% Digital Tools 59%

Enter/Escape 4%

Digital Passion 12%
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Pooja Bedi
Actress and model

Pooja Bedi is India’s original
glam girl and is today a

name that commands respect in
the glam industry. As a model,
actress, TV host, author, candid
columnist and a doting mom,
Bedi is a trendsetter. Here’s her
take on technology.

What does technology
mean to you?

Technology helps me
enhance my life in
more ways than you
can imagine. It’s a

necessity when it
comes to work,

entertainment, recreation
and even on the household front.

How do you use technology in
your day-to-day life?
I am very computer-savvy. At
home, I make extensive use of
the Internet. I love music and I
burn and compile my own music
collection. I like the facility of
online photo albums as well—
and I even take prints as and
when needed!  

What gadgets do you own?
I have a smartphone on which I
can record one hour of video.
My mobile helps me remain
accessible at all times—I realise
its importance even more when
I am overseas. I also use a
digital camcorder. I love
shopping for gadgets.

Has technology influenced
your career?
Technology has increased my
productivity manifold. For
instance, when I’m researching
a topic or person for my TV
show, I get lots of data online. I
consider Google a good friend!
Essentially, technology is a
requisite and I advocate using it
to the fullest to make life easier
and more exciting.

Pre-Paid Phone Tabs
The Malaysian government will stop the anonymous use of
mobiles—people using prepaid services will have to register their
details with phone companies. The decision follows worries
about the use of unregistered phones by members of violent
militant groups, either to communicate or to trigger explosions. 

Xbox Pricing Announced
Microsoft will be selling the Xbox 360 at $299 (Rs 13,000).
A more expensive version costing $399 (Rs 17,400) will
include a 20 GB hard drive, wireless controller, headset
and remote control. Microsoft is aiming to get the console
onto shelves in time for Christmas this year. 

Although there’s
still more than a
year before

Microsoft’s new Vista
OS hits the shelves,
work is on in full swing
to bring it down! Virus
writers are already
working on ways of
hacking Vista.

An Austrian
programmer has
published examples of
malicious code that
exploits loopholes in
technology which could
be part of Vista. The
viruses affect
Microsoft’s command
shell technology,
which is expected to
replace the current
command prompt.
Security company
F-Secure described the
malicious code as proof-
of-concept viruses to
highlight potential
vulnerabilities in Vista.

Security experts had, in
2004, sounded warning bells
about a possible attack on
the command shell. But
Microsoft has announced
that the new technology will
not ship with the final
version of Vista.

Windows runs on
almost 90 per cent of PCs
worldwide. In view of this,
the security risks that an
exploit might pose are
heightened.

According to Microsoft,
security would not be an
add-on but an integral part
of the operating system.

As it stands, though, one

has to wonder whether
things would be any
different with Vista if MS
cannot plug information
holes within its
organisation to start with.

For a sneak peek at Vista, turn to
‘New and Notable’ in this issue

THEY’VE JOINED THE
BANDWAGON

Download
MP3s @
Amazon.com

They already sell books,
clothes, computers and

peripherals, sporting goods,
electronics, shoes and what
not! But online retail major
Amazon.com is preparing to
offer a digital-music service.
According to The Wall Street
Journal executives, the
online retailer recently held
talks with record-label
executives. The licensing
options discussed included
song-by-song downloads and
a monthly subscription
service similar to the iTunes
music download packages. 

The paper also reported
that Amazon has discussed
tapping MusicNet, a New
York distributor of digital
music, to support the
service. The online retailer

Enter
FOES IN WAITING

Hackers And Virus Writers
Eye Vista 

Illustrations Harsho Mohan Chattoraj



indicated it is interested in
launching a digital-music
service by the end of 2005.

The company had earlier
posted a job listing on its
Web site for a content
acquisition manager for
“our forthcoming Digital
Music Service.” This
employee “would seek and
license digital-music
content worldwide,
including content from
major recording labels and
independent recording
labels and artists.”

Amazon CEO Jeff Bezos
had stated he wanted to
increase the digital content
offerings on the site.
Explaining that the move
would bring in larger
volumes of traffic to the
site, Bezos said that
streaming content and
video downloads were also
being looked into as future
options. 

With this move, Amazon
would join an already
crowded but continuously
growing segment of online
music retailers, led by Apple
Computer, Napster and
RealNetworks.

CHAMELEON KEYBOARDS

Keyboards
To Change
Characters
For You

Is your 104-key keyboard
boring you to death? How

about a set of new
programmable keyboards? A
couple of Russian

companies are working on
just that so you don’t have
to deal with those dreary
QWERTY keys any more.

iKeyInfinity, a Moscow-
based company, is expected
to launch its new multi-
language design for the
Windows and Macintosh
platforms early next year.
Connected via a USB 2.0
cable, each key has a 17 x 17
pixel LCD to show the
character according to the
language used in the
operating system. 

When the language
changes, the image on each
key changes accordingly.
The company says the
image could be any
alphabetic letter,
mathematic symbol,
punctuation or musical
notation—or any graphic
symbol or glyph. 

In addition to English,
the keyboard can switch
over to Cyrillic, Ancient
Greek, Georgian or Arabic,
just by changing the
language configuration on
the computer.

Designers at Art Lebedev
Studio have come up with a
keyboard called the
Optimus. The group hopes
to have the final product
ready by next year. Similar
to the iKeyInfinity device,
Optimus can handle non-
English characters as well
as special symbols, HTML
codes and the like. Two
versions on the Web site
show keyboards specially
designed for someone using
Adobe Photoshop and
another for someone who
might be playing Quake. 

Designers said the
keyboard will be OS-

independent, and will use
organic light-emitting diode
(OLED) technology to give it
a soft glow. The software
development kit will be
made available as an open-
source code package.  

STAMP HERE!

A New ‘Fing-
erprinting’
Technique

Alow-cost laser scanning
system could help in the

fight against document and
ID fraud, according to its
developers at Imperial
College in London. 

The Laser Surface
Authentication (LSA) system
scans tiny surface variations
of paper, plastic, metal and
ceramics to detect the

Roshni Daver, Mumbai
Ketaki Likhite, Goa

RSS-
Enabled
Browsers 
What better
than getting

news and updates straight
into your browser? All
major browsers, such as
Firefox, Opera and IE7 Beta
1, today integrate multiple
RSS feed readers.

RSS Aggregators
Why
waste
hard disk
space on
an RSS Aggregator when
you can get the same feeds
in your browser? In
addition, RSS Agregators
are cluttered and are not
easy to use. 

“Until all my dreams and hopes are

fulfilled!”
“I don’t really know. Maybe not
very long”

Bhavik Shah, Gujarat “I want a short and sweet life 
within

which I can achieve everything”

Priyanka Likhite, Mumbai
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Security Watch

Adobe Buffer Overflow

The Problem
On August 16, Adobe reported a
vulnerability in Reader and
Acrobat. The vulnerability is
caused due to a ‘boundary
error’ in the core application
plug-in, and can be exploited to
cause a buffer overflow when a
specially-crafted file is opened.

A boundary error happens
due to an invalid value entered
into an application. For
example, if there are too many
characters in a text entry, a
boundary error occurs.

The Damages
If the vulnerability were
successfully exploited, the
application could crash, with an
increased risk of arbitrary code
execution by the hacker.

Precautions
Since the vulnerability is rated as
“highly critical”, you’ll need to
update your Adobe software.

For Reader versions 7.0-
7.0.2, use the automatic update
facility. The 7.0.3 update files can
also be manually installed from
www.adobe.com/support/
downloads. This is the page for
all the updates mentioned below. 

For Reader versions prior to
7.0, Adobe strongly recommends
upgrading to Reader 7.0.3.

For Acrobat versions 7.0-
7.0.2, use the automatic update
facility. The update files can
also be manually installed from
the site.

For Acrobat versions 6.0-
6.0.3, use the automatic update
facility, or install the update
from the site. And for Acrobat
versions 5.0-5.0.5, download and
install the 5.0.10 update from
the download site.

One Silly Question

“As long as possible, as I am a doctorand I would like to help others”

“How long would you like to live if you were a Cyborg?”

“A hundred years would beenough”
Ninad Kotkar, Mumbai
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Info, scams, and news insights

iinnffoopplleeaassee
Here’s “all the knowlede you need”, as
the homepage says. You need to take a
look at this site to believe the sheer
amount and range of information
available. Quizzes, polls, crosswords,
culture, almanacs, atlases, history, an
encyclopaedia, a dictionary, a
thesaurus...

SSccaammBBuusstteerrss..oorrgg
“ScamBusters Helps You Protect
Yourself From Clever Scams—Online
and Offline," and there are a variety of
resources and links on this page to that
end. Even if you don't think you are or
will be a victim of fraud, the site is fun
to navigate—it has links such as ‘Urban
Legends’, ‘Scam Check’, ‘Viruses’,
‘Credit Card Fraud’, and so on.

SSTTOORRYYDDAATTAA..CCOOMM
The homepage says the site helps you
get “more insight out of the stories that
affect our world.” When we last
checked, featured stories included
‘fiscal implications of ageing,’ ‘patterns
of global terrorism,’ ‘the costs of a
bioterrorist attack,’ and many more.
The stories here seem genuinely
insightful, and all the sources of
information seem authentic. 

www.scambusters.org

www.storydata.com

www.infoplease.com

material’s ‘fingerprint’. 
The system then records 
the naturally-occurring
pattern of imperfections.
These are impossible to
replicate as they are very
minute in nature. 

This technology could be
used on materials such as
passports, ID cards, credit
cards, CDs and DVDs,
banknotes, and packaging.

The scientists involved
in the project said this
system offers a much
simpler, largely foolproof,
and inbuilt—thus cheaper—
way to authenticate and
track sensitive documents
than current methods such
as holographs.

The ‘fingerprints’ of the
materials are made up of
variations of ridges and
grooves, which characterise
materials. These
imperfections are of the
order of a few hundred
nanometers. 

Scientists at Imperial
College and Durham
University used an optical
phenomenon known as
‘laser speckle’ to detect the
variations in surfaces. Laser
speckle occurs when a
focused beam of laser light
scatters over a random

system, such as a paper
surface. The scanner records
the way the laser light is
reflected off the surface of
the paper or plastic. 

The speckles, as with
human fingerprints, are
almost unique. The
researchers working on the
system said it could help to
clamp down on fraud, drug
counterfeiting, terrorism
and identity theft.

EVEN CHEAPER CELL
PHONES?

New Platform
To Lower
Handset
Costs

Infineon Technologies has
announced sample

availability of its first
reference design for ultra-
low-cost handsets. Using
their new ULC reference
platform based on a single-
chip GSM solution, costs for
GSM handsets with SMS
functionality could be
reduced by nearly half in
the near future.

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

UNITED STATES

It has recently been reported that high-tech
companies are going overseas to find talent
not being produced in the US. More than
half of the computer scientists in the US are
foreign-born. From Google's Sergey Brin
(Russia) to Yahoo's Jerry Yang (Taiwan),
immigrants are rising to the top of US-
based high-tech industries.

CHINA

South Korea's Samsung has
announced it plans to make China its
second R&D base and its global R&D
centre. At a conference on R&D
strategy in China, which ended August
16, Lee Yoon-woo, vice chairman of
Samsung Electronics, said China was
of strategic importance.

FINLAND

Digital signatures via SIM cards and
mobile phones have taken off in
Finland. The Finnish Population
Register Centre now offers its citizens
the option of conducting official
business over the Internet. This allows
the citizen to use a mobile telephone
when secure identification is required
for online services or requests.

AUSTRALIA

Australia said on August 17 it was
developing battlefield robots capable of
military operations that could free soldiers
from some dangerous tasks. The new
systems will be intelligent and largely
autonomous.

UAE

On August 8, Samsung announced plans to kick
off the Olympics of the cyber-gaming community,
the ‘World Cyber Games 2005’, in the UAE. The
first cyber-gaming championship, too, took place
in the UAE. This year again, Samsung will host the
UAE round in alliance with its local partner
eCompany’s online gaming service engine
www.mplayer-arabia.com.

MALAYSIA

The number of broadband users is
growing by 30,000 new users per
month. At that rate, it is expected
that Malaysia will have 700,000
broadband users by the middle of
2006. Malaysia's population is about
24 million.
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Photograph Jiten Gandhi

Last Month’s Winner!
Ratan Sharma ,
17, Mansarovar,
Meerut 205 006
“Aage baitha driver, phir bhi
passenger dhoondhe driver(s)”

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win Solaris 7
Administrator 
Certification 
by Bill Calkins 
Published by Techmedia, 
New Delhi

Every month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 15th of this month.

Digit Caption
“Not quite computer
heaven...”
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Present costs for
handsets include all
electronic components, the
printed circuit board,
connectors, casing with
keypad and display, all
software components,
rechargeable batteries,
charger, packaging and
documentation. 

Infineon’s platform
provides all the electronic
hardware and software
components needed in dual-
band handsets complying

with the GSM900/1800 and
GSM850/1900 standards. It
includes a single-chip GSM
radio/baseband, other RF
components, power supply,
memory, operating system,
hardware drivers, GSM
protocol stack and a
reference MMI (Man
Machine Interface) for
simple and intuitive use of
SMS and telephone
functionalities. Volume
production is expected to
start in the first quarter of
2006, which means that

ultra-low-cost
handsets could

be in the shops
a few months
later.

Power
consumption has
also been

optimised so 
that cheap
rechargeable
batteries such as

nickel metal
hydride (NiMH)
AAA micro-cells
can be used to
power the
phone. With
standard
rechargeable
mobile phone
batteries, an

estimated standby time of
more than ten days and a
talk time of four hours is
what the company is
projecting, once the
platform comes into use.

IMAGINE IN INDIA

MS Brings
Global
Contest To
India

Microsoft has
announced that India

will be the venue for
Imagine Cup 2006, an
annual worldwide contest
held by Microsoft to help
students across the world
showcase their software
development skills. 

The contest aims at
empowering students to
apply their creativity,
knowledge and technical
abilities towards making
the world not only a more
connected place but also 
a better place through
technology. 

In keeping with this,
the theme for next year’s

contest is “Imagine a world
where technology enables
us to live healthier lives.”
India has emerged as the
world’s IT nation with
diverse technology talent,
making it an ideal
destination for a global
showcase of innovative
solutions. 

This announcement
was made at the Imagine
Cup 2005 world finals,
which recently concluded
in Japan. Over 16,000
students from 92 countries
participated in the contest
this year. Nearly 6,000 of
these participants were
students from India,
making it the country with
the second-highest entries
worldwide.

The contest includes
nine ‘open’ categories such
as Software Design,
Technology Business Plan
and Rendering, and three
special categories created
only for school students.

The theme for Imagine
Cup 2005 was “Breaking
down Boundaries”, and
students were encouraged
to conceptualise
technology solutions to
help address emerging
social issues.
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YAHOO! IS AUDIBLE

Now Find
That Podcast
On Yahoo!

Web media giant Yahoo!
has launched a free

Web audio search service
that helps users find, hear
and buy everything from

music downloads,
interviews, Podcasts and
other Web audio content. 

Although Yahoo! Audio
Search, at http://audio.
search.yahoo.com, is still in
testing, it gives users access
to more than 50 million
audio files as the Web site
increases the amount of
media content it offers.

Apart from the well-
known record labels and
music artists, the service

also taps independent
publishers and the Web,
helping users find such
things as music videos,
reviews and photographs
of artists. 

Yahoo! and rivals such as
Google and Blinkx have
already launched video
search services as the
Internet’s role in
entertainment grows, and
ad revenues pour in.

The company has
integrated Yahoo! Audio
Search with its video search
service, and has invited
people to submit videos and
music through Media
Really Simple
Syndication, so it
can be found by
the new audio
search engine. It
also integrated
tools from its
comparison
shopping search
engine, which
helps users find
CD prices and
make purchases
from a variety of
retailers.

In doing this,
Yahoo! has forayed
into all forms of
Internet search and
cataloguing—the fastest
growing source of income
for most online companies.

YES, DOWNLOAD IT!

Britons Take
Initiative In
Legal Movie
Downloads

AUK firm has started a
video download service

in the hope of creating a

viable commercial
alternative to renting or
buying DVDs. The service,
called BoxOffice365.com,
allows customers to
download videos of
VHS quality.

As of now, only a few
live comedy and music
video services are available,
but the British Internet
Broadcasting Company
(BiBC), the entity behind the
service, promises a
significant content
catalogue will be uploaded
by the end of September.

Some of the content,
such as The Sex Pistols’ TV
debut of Anarchy in the UK
will be made available for
purchase for the first time.
The firm has signed
publishing agreements
with a number of
publishers including V2,
ITN and Laughing Stock.

However, only one film
studio—Universal—has so
far signed an agreement.
BiBC’s founder Paul Hague
admitted Hollywood has
been reticent about
offering legal downloads

GENDER 

BENDERS

Googlewhacking was the last thing Vikram had expected.
Pensively, he chose his first search phrase—‘icosahedron
history’ (of course, he had the dictionary to help him). That
got him 25,900 links. The other terms he used were ‘raitt
factfile’, ‘nanovalent’ and ‘hexanumeric’. His performance
improved with each attempt, and his last attempt of
‘hexanumeric’ gave him a commendable five links. Keep
trying, Vikram, and you’ll get there!

Vikram Rajagopal vs Jisha Punyani   

Googlewhacking

5 links

1 link

On hearing about the task, Jisha seemed clueless at first. After
understanding the concept of Googlewhacking, she seemed
reluctant to start. Four attempts were given to the duo and
their task was to return only one search result. Jisha tried
combinations such as ‘aberdeen angus’, ‘jujube’, ‘mutex
vlogging’, and ‘mutex hydration’. She got a high number of
links every time—8,52,000 hits for ‘Aberdeen Angus’! Her final
attempt comprised the words ‘mutex vlogging’, and Google
displayed just one link. Good going, Jisha!

No, Googlewhacking is not beating the hell out of
someone who says Google has the most number of

indexed pages! It is the art and science of searching
with two dictionary-recognised words such that the
query yields just one result. For example,
“orchestrator bamboozling”, “metronome dewpoint”,
and so on. So it’s a bit like hitting a bulls-eye with
Google search.

The term is a brainchild of Gary Stock—he was so
obsessed with finding such results that he created this
game with rules called Googlewhacking.

Stock lays out the rules for keeping score: one
point for a pure Googlewhack, meaning a single
result for your query; one point if you learn
something; and a bonus point if you “laugh even
more” at the results.

Googlewhacking
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of films, even though
content is wrapped in
copy- protection
technology to prevent
unauthorised sharing.

Downloads are available
on a ‘pay-as-you-go’ basis
with prices of between £1.50
(Rs 118) for a music video,
and £6.99 (Rs 550) and
upwards for a full DVD.
That’s more expensive than
renting a DVD, but the BiBC
hopes the convenience of
not having to go to a shop
will appeal to potential
customers. 

By the looks of it,
BoxOffice365. com wants to
do for video downloads
what iTunes did for legal
music downloads. It’s one of
a small group of companies
trying to change the way
people enjoy films and
video downloads.

SHOWTIME!

Hackers
Demonstrate
Their Skills
In Vegas

Even the ATM machines
were suspect at this

year’s Defcon conference,
where hackers played
intrusion games at the
bleeding edge of computer
security. With some of the
world’s best digital break-in
artists pecking away at their
laptops, sending e-mails or
answering cell phones could
also be risky.

Defcon is a no-man’s
land where customary
adversaries—Government
Security and technology
experts—spar with digital
mavericks. The result is
sharing ideas about making
the Internet a safer place. In
reality, however, it’s just
hackers flexing their wits
and muscles.

This year’s hot topics
included a demonstration of
just how easy it may be to
attack supposedly foolproof
biometric safeguards, which
determine a person’s
identity by scanning such
things as thumbprints,

irises and voice patterns.
Banks, supermarkets and
even some airports have
begun to rely on such
systems, but a security
analyst who goes by the
name Zamboni challenged
hackers to bypass biometrics
by attacking their backend
systems networks. 

Also on hand at the
conference was Robert
Morris, former chief scientist
for the National Security
Agency, to lecture on the
vulnerabilities of banking
ATMs, which he predicted
would become the next “pot
of gold” for hackers.

Hackers and the
computer security experts
who make a living on
tripping up systems say
security would be better if
people were less lazy. To
make their point, they
pilfered Internet passwords
from convention attendees.
Anyone naive enough to
access the Internet through
the hotel’s unsecured
wireless system could see
their name and part of their
passwords scrolling across
a huge public screen. It
was dubbed the ‘The Wall
of Sheep’. 

Amongst the exposed
sheep were an engineer
from Cisco Systems,
multiple employees from

Apple Computer, and a
Harvard professor. Baa!

CORPORATE PODCASTS?

Big Blue To
Podcast 

IBM is all set to embrace
Podcasting, the digital

audio craze that allows
consumers to take audio
programming off the
Web and listen to it on
portable music players. The

company
plans to introduce a
series of occasional
Podcasts on its investor
relations site as part of
a broader effort to
communicate directly
to its investors and the
wider public about
hot topics.

The Podcasts would be
insights on emerging issues.
The company has
emphasised that the
Podcasts would not be IBM
commercials. The company
also sees these Podcasts
replacing the traditional
whitepapers. 

Compiled by Aditya Kuber,
Mithun Kidambi, Ram Mohan Rao

and Renuka Rane
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Podcasting

What is podcasting?
Podcasting is a way of
delivering audio over the
Internet. It’s something like
Internet radio, with the
difference being that you can
subscribe to a podcast, have it
downloaded, and listen to it at
any time you wish.

Where can I listen to a
podcast?
Although the word
‘podcasting’ is derived from
‘iPod’ and ‘broadcasting’, you
don’t need an iPod to listen to
a podcast. All you need is the
requisite software, and you
can listen to a podcast on any
computer that has the
software.

Why is podcasting an
interesting development?
Podcasting is sort of like
Internet radio with the added
benefit that you can listen to
the show any time you want.
It allows individuals to
distribute shows over the
Internet. While it’s not
possible for any individual to
walk into a radio station and
demand a certain broadcast,
any individual with the right
equipment can do a podcast.

How does podcasting work?
You can subscribe to a
podcast using a software
called a podcatcher. The
system uses the format called
RSS 2.0 (or RDF XML) with
enclosures (the podcast is the
enclosed data). This is
somewhat similar to the RSS
feeds on the Internet many of
us subscribe to.

When did podcasting first
become popular?
It’s possible that the first use
of the term ‘podcasting’ was
in an article by Ben
Hammersley in The Guardian
on February 12, 2004. By
October 2004, detailed how-
to-podcast articles had begun
to appear online.

Who can podcast?
Anyone! With the right
software and minimal
hardware requirements, that
is. Just Google “How do I
create a podcast” and find the
answers!
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MOVIE
MADNESS Robert Sovereign-Smith

hose of us who watched War Of The Worlds
were captivated by its special effects.
Almost everyone muttered some sort of

expletive at the end, angered by the quick and
hurried ending. “Bacteria killed them all” was a
wholly unexpected finale—perhaps one of the
most anti-climactic endings of all time—except
for the few who had read the book first!

Movies have this magical power over
people. Music is what perhaps comes closest
in this regard, but even the power of music
pales in comparison to the emotions that
movies are able to elicit from even the most
stoic. Women and macho-men alike cried like
babies when they saw that little red cape
covering one of the corpses in Schindler’s List;
we all laughed whole-heartedly at Jim Carrey’s
antics in Liar, Liar, and every Indian learnt
more about the Mahatma by watching Gandhi
than we ever did in school! 

Even multi-million dollar movies
make silly mistakes when depicting
technology. Here are a few...
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India has the most
prolific movie industry in
the world, with more
movies being made here per
year than in Hollywood!
Only here can a simple family movie such as
Dilwale Dulhaniya Le Jayenge run in packed
cinemas for years at a stretch, primarily
because it was a movie every Indian could
relate to. Of course we also have the epic
Sholay—a film that’s even popular among
those who snub Bollywood productions.

However, since reams have been written
in praise of the all-time greats of the big
screen, we’ll stop here. Here, we applaud
the tremendous effort and love that movie
makers knead into their creations, but also
highlight the technological changes that
have occurred over the years—which not
every movie maker has been able to meet.

Evolved Audiences
Though there’s no lack of creativity in
movies, as is apparent from their contin-
ued success in the entertainment indus-
try, there is a need for realism. When we
say ‘realism’, we do not imply that every
movie needs to be made like a reality
show; we mean that movies should not
depend on the audience’s ignorance of a
subject to make sense.

People have changed, and the inclusion
of Internet access in our everyday lives
means that we’re free to learn about any
subject we desire. There was a time when
one could safely make a space movie with
unrealistic physics and technology, and no
one would notice. The people who would
know right from wrong were a minority,
and in all probability, locked in a super-
secret basement somewhere in Area 51,
doing top-secret research. Today, anyone
with the desire to learn can log on to
www.nasa.gov and read up on absolutely
anything to do with space exploration.

This easy access to information has
transformed today’s movie audience into
experts in their own rights. Unfortu-
nately, some elements of movies, or for
that matter, some movies in their
entirety, require audiences that do not
think for themselves.

Goof-ups 
A whole range of Web sites have
sprung up over the last few
years that talk about flaws in
movies. Even The Internet

Movie Database (IMDb.com) has a whole section
dedicated to movie goof-ups. The most popular
goof-up is one done by poor editing and script-
ing. These goofs, also called continuity goofs,
happen when a particular scene is shot again
and again-things around a set are bound to
change. Like when shooting a scene, if there’s a
coffee cup on the table, after the twelfth take,
the coffee cup may have been moved, or even
taken out of the shot. When editing, this may
be overlooked, but of course, audience mem-
bers will notice it, and a few days later, you have
a dozen new posts in IMDb’s ‘goof’ section.

Another, more serious, type of goof-up is the
type where you can see people or equipment used
in the production of a movie. The simplest exam-
ple is the boom microphone peeping in from the
top of a shot, or a not-so-well-concealed person trig-
gering smoke, or some other background effect.

However, without a doubt, the most serious
flaws in movies are caused by bad research of a
topic. Considering that trillions of dollars are
spent on making movies every year, most of it
on special effects and actor’s fees, it’s not too
big an ask to expect directors and script writ-
ers to do their homework. Perhaps you could
even go as far as to say, “If I can spot bad
research in your multi-million dollar block-
buster, then, well, you suck!”

As Digit readers, it’s especially bad when you
see mistakes relating to technology in block-
buster movies. In fact, the idea for this story
came about when a few of us watched the movie
Constantine. Here’s what happens:

Constantine
Angela is mourning her sister’s death, and is
watching the security camera video of her sis-
ter jumping off the top of the building. All
well and good so far. Then we start to see the
errors creep in. First of all, security cameras do
not follow subjects around like a diligent cam-
era-man. Secondly, since when do security
videos have close-ups? There’s a shot of
Angela’s sister whispering the name
Constantine, and of course we get to see it per-
fectly—those security cameras must be top-of-
the-line Hollywood movie cameras! 

‘Angela’ uses QuickTime player on her laptop...

...unfortunately, she doesn’t know her buttons!



However, this is not what
made those of us watching the
movie burst into peals of laugh-
ter. No, it took a special goof to
do that! Angela is watching the
security camera footage on her laptop. She’s
using Apple’s QuickTime Media Player, the ‘Q’
icon is clearly visible, and when she notices her
sister say something, she rewinds the clip.
However, unlike any of us normal, everyday tech-
nology users, she doesn’t use the progress bar;
instead, she presses the ‘Previous track’ button.

There is a ‘Rewind’ button, but she clicks on
the ‘Previous’ button. As any of us who have
used a software media player will tell you, this
button will take you back to the beginning of a
clip, or even to a previous clip, but in this case,
Angela magically rewinds the clip to exactly the
right spot—talk about divine intervention!

OK, so some of you may argue that such a
mistake isn’t even noticeable and that we’re nit-
picking. True, perhaps most people will not even
notice this error, and it is sort of minor, especially
in a movie that deals with a much more serious
subject—judgement day, evil, and God versus the
devil! So what about movies that cover computers
as a subject, and are targeted at us geeks?

The Net
Constantine merely started us off on this goof-
hunt. The very next movie we decided to watch
was The Net, starring Sandra Bullock. In no time
flat, we were again rolling on the floor laugh-
ing. Sure, the movie is really old; sure, technol-
ogy was just entering our lives back then, but
the movie is about technology being evil and
how our identities can be stolen using the Net!

This movie was a cult movie for us geeks,
and was what sparked the interest in computers
for quite a few of us. So imagine when we see
the IP 23.75.345.200 being used in the movie! As
most of us know, IP addresses are 8-bit numbers,
and thus can only have values between zero and
255. The fact that the IP contains 345 means
that someone didn’t do their research properly.

Other stupid technology mistakes in The Net
include viruses that blur your screen, obviously
attacking your graphics card drivers and giving
them the ability to display cool-looking distor-
tions on the display. Yes, we are being sarcastic!

Overall, the way computer technology was
depicted in The Net was unbelievable. Sure, the
idea was that someone’s electronic identity
can be erased, but come on! Did she never sign

anything in her life?
She never went to
college? Had pictures
taken for the annual
yearbook? What about

college friends? Don’t banks expect you
to sign cheques?

The Net expected us to believe in a paper-
less world, yet even today, the world isn’t
that way. Still, it was a good movie that
made us all a little scared of the Internet
even in 1995.

The Core
In The Core, which was recently doing the
rounds on a popular movie channel,
there’s a character called Rat who is sup-
posed to be the world’s best hacker. This
character is skinny, sickly-looking and

the stereotypical nerd. However, the task
assigned to him is a little far-fetched:
hack the Internet!

He is given the job of hacking the
entire Internet, and prevent news of the
mission to the centre of the earth from
leaking. Sure, hackers have much power
in the world of the Internet, but
preventing the flow of information?
Ridiculous at best!

He also hacks into any and everything
in under two minutes flat!

However, computer technology had a
very small role in this movie—most of it
was dominated by unbelievable physics.
For example, there is talk about the
frequency of sound waves changing when
passing through different mediums. Any
physics student should be able to tell you
that this is impossible—the amplitude and
velocity can change, not the frequency.

Then there’s Unobtanium! It’s a magi-
cal metal that gets stronger with
increased temperatures and pressures.
Perhaps they should have called the metal
“Unbelievable-anium”…

Overall, this movie was really bad for
any science student to watch, not just
computer geeks!

Hackers
Here’s a movie that should send all Digit
readers into fits of laughter!Ficticious IPs were never ‘that’ unbelievable

Apparently, viruses can infect your monitor as well!



The year 1995 did not belong to Sandra
Bullock in The Net, not as far as we are
concerned. Angelina Jolie, in Hackers, took
the baker home with her!

The plot is about hackers in 1995
who stumble upon a huge plot to swin-
dle money from a corporation, and
somewhere along the line, the plot
involves the American Secret Service.
Billions of dollars at stake? Nope, not
quite; all this racket is created over the
attempted theft of a mere 25 million
dollars. If anything, here’s one aspect of
the movie that goes against Hollywood
norms of exaggeration!

Coming back to goofs and unbelievable
technology… we’re not quite sure where to
begin with this one!

The plot involves a hacker called ‘Ice
Cool’ who creates a virus in 1988 at the
tender age of 11, a virus that crashes
1,507 computers - surely a huge deal in
1988! It’s 1995 now, and he’s finally
allowed to touch computers again - and
of course, his first act in the movie is to
hack a television station. Here he meets
(in the virtual world) another hacker
called ‘Acid Burn’, who
promptly manages to
terminate his connec-
tion… so far so good.

However, this is where technology takes a
backseat and Hollywood effects kick in.

Throughout the movie, you see unbelievable
displays on computer screens, a lot of useless
jargon such as RISC, PCI-BUS, and so on being
thrown at you out of context, but by far, the
juiciest of all blunders is when Acid Burn (Jolie)
shows off her new laptop, which is a Mac, to Ice
Cool, and boasts of it having a P6 chip! Were the
writers of this movie soothsayers? Apple just
recently announced its plans to use Intel’s chips
for the first time!

As for the rest of the movie, we’ll let the
screenshots do the talking!

Independence Day
Yes, there was computer technology used in
the plot of Independence Day; though most of
us were busy oohing and aahing at the
effects, some computer nerds were asking,
“So how exactly does Jeff Goldblum interface
with Alien technology?”

It takes the best hackers and virus writers
on the planet a good deal of time to come up
with a virus for, say, Windows XP. In order to
find a flaw in an operating system, you need to
be an expert in that system! And that’s for just

finding a flaw - writing a virus
that’s undetectable and
exploits that flaw is another
ballgame altogether!

Thus far, Bollywood has been known more for
the antics of characters portrayed by actors

such as Mithun Chakraborty and Rajnikant!
We’re used to seeing people leap up to the
fourth floor of a building—backwards! People
think nothing of a hero who can split a bullet on
a blade and kill two baddies with one shot! It’s
cinema, it’s supposed to be unbelievable!

However, more people are attempting to
make serious, well-researched movies. Although
we applaud their effort, we should also point out
flaws in their research. Bollywood’s version of a
mish-mash of Hollywood’s Close Encounters of a
Third Kind, and ET: The Extraterrestrial, called
Koi… Mil Gaya, stars Hrithik Roshan as a
mentally challenged man. His father, a scientist
devoted to finding extraterrestrial life-forms,
invented various techniques of contacting alien
life forms. One works! It’s a computer that
transmits sound to outer space—the sounds are
very similar to what you’ll hear when you watch
Close Encounters Of The Third Kind, except that
they’re the holy word ‘Om’ in different notes!

What’s hilarious is the ‘computer’ that
Hrithik’s father uses: it looks like an old
oscilloscope was picked out from hospital trash
and a small TV fitted into it. Then, someone
used some Windows Media Player visualisations
to try and make it look like the ‘computer’ was
actually transmitting and receiving sound!

Though the computer only plays a small
part in the story, it would have been nice for
someone to actually dig up an old 486 and try

and make the computer a little more believable!
Another recent Bollywood movie is 16

December—it’s about secret agents and spies
for the Indian government looking to track
down terrorists. Keeping with the tradition of
portraying hackers as young geniuses, this
movie has a hacker who looks no older than 10.

He’s a Mac user as well!
There’s a scene in the movie where he’s

Bollywood

Above: These keys produce sounds; but what you
don’t see is the piano. Now why didn’t they use that?

Below: The monitor used on the ‘old’ PC looks more
like a oscilloscope than a monitor
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Jeff Goldblum’s character manages to do
this in a matter of hours! 

Let’s not even begin to talk about an alien
race that traverses the universe to go to war
with us, runs everything on computers, and
does not believe in anti-virus software to
protect against viruses created by those much
lower down in the technology chain!

We’re Not Stupid
There are perhaps thousands
of movies out there that have
loads of technology goof-ups,
but it’s good to see the effort

logged on to a bank’s Web site, and is looking for
the password to one of the Ambanis’ accounts. His
‘program’ is a little genie that appears on the Web
page and scrapes off data from the site while
looking for a password. In the end, the password he
finds is ‘gudiya’. If Milind Soman hadn’t stopped
him, he would have stolen crores from the
Ambanis, using the username ‘Ambani and the
password ‘gudiya’.

that movie makers are putting in to
improve the believability of their sto-
ries. As technology invades more and
more people’s lives, perhaps soon we’ll
see movies that don’t divert our minds
from plots by making silly mistakes.
After all, in all the movies mentioned
here (with the exception of Hackers and
The Net, perhaps) technology was just a
prop, but ended up taking centre stage
because of glaring errors.

It’s time that the Holly- and Bollywoods
of the world start accepting that we, their
audience, are not stupid any more, and
will not just sit down and believe or accept
anything they throw at us. 

Some people might argue that movies
are meant to be journeys of fantasy, and
need not conform to real-world bound-
aries. However, to be truly immersive,
movies need to be based firmly on reality.
This is the reason why horror movies may
not scare us, but walking down a dark,
desolate street in the middle of the night
makes us edgy!

We’d love to hear your take on this
subject, and also hear about more tech-

nology goofs you might
have seen! Write in to us. 

robert_smith@thinkdigit.com

So basically the movie expects you to
believe that one of the Ambanis has Rs 70
crore in his personal savings account, which
is accessible via the Internet, and is protected
with only the password ‘gudiya’. Yawn!

So we sat through the rest of this movie,
looking for more mistakes. We got tired of
counting. Someone tell Bollywood makers
that we still do not have 3D-holographic
displays! And even if there are any, no 10-
year-old would be allowed to touch them! 

At the end, there’s a scene where the
same child prodigy is copy-pasting wave
graphs so he can match the villain’s voice and
disable the nuclear bomb that’s about to
blow Delhi to smithereens. The computer
screen clearly shows a mouse action of
dragging and dropping, yet all this kid is
doing is rattling away at his keyboard. The
funniest part is when he finally gets the
specific word phrase he is looking for he does
nothing, until our hero Milind Soman
helpfully reminds him to press [Enter]!

If Hollywood has a long way to go before
making truly immersive movies, let’s not
even imagine how much help Bollywood is
going to need. With all the computer whizzes
we have walking about our streets, it’s
shameful to see directors not consulting with
them to understand the limits to which they
can stretch our imaginations—at least in
terms of technology. The least they could do
is pick up a copy of Digit every now and then!

Above: Wow! The Ambanis really use stupid passwords
for their Net Banking accounts

Below: An 11 year old disarms a nuclear bomb with 1
second to spare!

How Jeff Goldblum manages to interface with an alien
system and create a virus to crash it is beyond us



Aditya Kuber

Ever since science fiction took over the minds
of inventors and the world at large, we have
been yearning to create that perfect robot

who would be our best friend, maid, pet, driver,
vacuum cleaner… a veritable all-in-one that

would rid us of having to do our daily
chores, and not ask for leave either!

How close are we to this becom-
ing a reality? Going by recent inven-
tions and developments, not too

far… robots are already begin-
ning to walk, talk and yes, in

some cases, even think
like people. 

Back in 1996,
along with partner

Yoshihiro Kuroki, Tatsuzo Ishida, Sony Corp’s ace
robotics engineer suggested the creation of a new
species of humanoid entertainment bots along
the lines of C-3PO, the golden chatterbox in Star
Wars. Creating robotic  workers for factories is one
thing, but the technical challenge of creating
something like a humanoid is tremendous. 

And what about the potential hazards that
such a creature could pose? Until these creatures
are smart enough to ‘understand’ what it’s like
to walk, they could just trip over and fall, injur-
ing someone in their path and bring lawsuits
against Sony in their wake!

Sony, though, decided to go in for the idea
anyway. Thus was born the SDR or Sony Dream
Robot. At a time when the world was gaping over
Aibo, Sony’s cute robotic puppy, Ishida and
Kuroki were displaying half-a-dozen prototype
humanoids at Yokohama at Robodex, an expo for
personal robots. 

Robots are still considered largely outlandish, but advancements over the
years may soon change that... and with it, probably the way we live

Illustration Pradeep Ingale

Your Friend
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I, Robot—



That was 2001. Since then, there hasn’t been
much progress—and developers in labs around
the world are still struggling to build bots that
are spitting images of humans in movement
and possibly behaviour. But when will they be
ready? Will we, in our lifetime, ever be able to
summon someone like Rosie—the robot maid
from The Jetsons?

Rough estimates based on developments
indicate that 2010 could well be the year when
robots walk the street. Considering that’s just
five years away, it does seem rather impossible.
They were also saying back in the ‘60s that
everyone would fly by 2000 and that cars would
be obsolete!

But what is it that we are looking to create
here? Is a lump of wires and metal that vaguely
resembles the human form the final objective?
Not quite. Researchers around the world have
since long achieved the human form—bipedal
(two-footed) movement included—and work is
now focused more on making these bots behave
more like humans and understand what we are
saying. Artificial Intelligence (or in fact, the
lack of it) has been the stumbling block. 

Coming Of Age
There are several things that differentiate
humans from relatively simple creatures such as
lizards, cockroaches and so on. Consider our
sense of sight and our emotions. 

Cockroach-like robots are relatively easy to
build. But it’s a tremendous challenge to create
a bot that even vaguely resembles a human in
the departments that matter. For instance, how
do we imbue a robot with the emotion of fear?
And how do we enable it to distinguish between
a living and a non-living thing—something even
a child can do when it is a year old?

Humans have normally overcome most of
the challenges they have faced—and success-
fully built skyscrapers and supercomputers,
and have even put men on the moon. But
getting a robot to smell something, feel and

identify, touch, see and imbue motor skills
similar to humans is a task that is comparable
only to the creation of a whole new world.

But why are emotions for a robot so impor-
tant? Simply because for robots to be meaningful
companions, they must be ‘socially savvy’. At the
MIT’s Media Labs, work is being done on ‘Kismet’
(see box below), who is learning to recognise
human emotions—and also has a face to express
its own moods.

The image of a genie that has long been
imbibed into the human psyche makes us want
something—or someone—who can do more than
us in terms of memory and mental and physical
skills. Is a robot companion the answer?

The industrial world wants robots for work in
hazardous surroundings; the military, to fight
on the battlefield. But one place most humans
would want them is in their homes. Why? For
doing mundane, daily tasks like cleaning the
house, washing clothes and cleaning the dishes.
Driving you to work and shopping for groceries
would figure next on the list, and an added
bonus would be if they could tutor the kids after
school. That’s the ideal home AIO (all-in-one).

That’s your genie right there, but given the
state of AI and the current expertise in this
field, getting your dream bot home may take
some time. As of right now, they are prone to
mistakes and a lot of them. But wouldn’t that
make them that much more human? Yes, but
that’s not what we’re looking for, is it?

None of today’s robots can do any of the
household chores we would want them to. They
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MIT Labs had two humanoid robots to its credit. Unfortunately, both have
retired and are now part of the MIT’s Museum. During their 10-year lifecycle,

these robots successfully mimicked emotions, and showed that it was possible to
really ‘grow up a bot’.

Kismet
Kismet was an expressive robot that could communicate
with humans socially. It was capable of showing emotions
such as sadness, happiness, excitement, and so on. A lot of
computers worked together so Kismet could function
socially at the level of a young person!

Kismet really could understand the human it was interacting with, and it
processed the inputs it received (visual and auditory) from the human and
adjusted its behaviour accordingly. It was designed such that it could learn the
way an infant learns, and to this end, it needed a caretaker! 

The caretaker had to provide a proper ‘learning environment’ for Kismet, and
also understand how Kismet was ‘feeling’ at any given moment, so as to behave
accordingly with the bot. Just like a child: if it was under-stimulated, Kismet acted
bored—and was difficult to interact with. If over-stimulated, it showed fear, and if
the excess stimulation continued, it shut itself down at some point.

Cog
Cog was an experiment in robotic cognition. The goal of
the Cog project was to get it to the ‘IQ’ of a three-year-
old. This humanoid torso had been learning to interact
with its surroundings—including people—since its
inception in 1993. Cog’s intelligence levels progressed to
the crawling-infant stage. Its ‘eyes’—cameras, of
course—tracked people moving, and it could establish
eye contact with people. This may not seem like much, but consider the fact that
most general robots can’t distinguish a person from an object such as a wall.

Growing Up Botty

Honda’s Asimo can also be your tour guide
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can’t even pick up a broom! But the next gener-
ation that is being created—in the shapes of
animals—could well be more capable. There is a
good chance that an Aibo could be sitting at
your door, at guard in the night after a hard
day’s work inside the house.

Great Expectations
As humans, we always have great expectations
from our friends, families and ourselves. But will
our robot friend understand it? To be honest, it’s
best if they didn’t. So long as they just did what
is asked of them, we’ll be happy!

And no, this is not fantasy. Already, some
toy-like robots are reminding the elderly to take
medicine and keep appointments. And future
plans call for bundling more advanced mecha-
nisms into roving maids and butlers. 

Ah… a butler that will be at hand for your
whims and fancies. While most inventors main-
tain that robots are ‘almost intelligent’, the
question is, will there be a time when they
could be more intelligent than us? And this
question wakes the doomsday soothsayers from
their slumber. But they can rest easy for a while
as inventors and creators of the modern day
maids and butlers are still worrying about
issues like movement and response times. 

Hollywood has already done its bit to scare us
out of our wits by depicting robots as evil beings
whose only purpose of existence is to take over
the earth. One question: why? What on earth
might push them to take over? Is it the fact that
they no longer want to be ruled and want to be
masters of their own destiny? But that would
mean they are able to think and understand
emotions and have aspirations. Unfortunately,
that’s happening only in Hollywood.

When Can You Buy One?
Your dreams of having a butler and/or a maid
scooting around the house may not be fulfilled
this decade, but some of the early developed
bots are functioning as guards, delivering

hospital food trays and carrying documents
from one office to another. 

The Japan Robot Association (JRA) had esti-
mated that by 2002, nearly 11,000 service robots
would have been deployed, 65 per cent of them
in hospitals and nursing homes. JRA projected
that by 2005, healthcare robots would be a $250
million market, which would then hit $1 billion
by 2010—approaching 10 per cent of the total
market that year. As for personal bots, a panel of
industry and academic experts predicted they
will be as common as PCs and cell phones within
10 to 15 years. You could finally draw a bath
that’s exactly 29.4o C every day! 

Growing Up A Bot
Aibo, Asimo, Robosapien and any of the other
similar bots have one thing missing when
compared to Rosie. They do not have a character
of their own.

Bots like Aibo can learn tricks and respond
to voice commands, and are touted to be the
next big thing, but what good are a few tricks
when you want the whole circus? 

While researchers everywhere are fasci-
nated by the potential of home robots and
cyber-companions, there are labs that are
counting on biological approaches to help
produce mechanical beings—known as evolu-
tionary robotics. 

The basic idea of evolutionary robotics is to
be able to raise a machine like a child, letting it
learn from its own experiences and sensory
impressions, rather than feeding it canned soft-
ware written by humans. Leading places for
such research include the University of Sussex
in Britain, Switzerland’s University of
Lausanne, and the MIT and Michigan State
University in the US. 

MIT’s Cog and Kismet are probably the most
famous of the self-educated bots. But no matter
how personable the Cog may seem, a robot
with human-level intelligence still remains a
faraway dream. 

Evolutionary
robotics aims to
raise a machine
like a child—
letting it learn
from its own
experiences and
sensory
impressions,
rather than
feeding it canned
software written
by humans

Researchers in corporate and academic labs are racing to
develop working models that, within a few years, may become

our cohabitants and co-workers. The leaders include companies
such as Matsushita Electric Industrial, NEC, Sony and Omron and
are literally investing millions in the development of personal
robots. Here are some bots that have so far seen light of they day:

Asimo (Honda Motors): One of the first ‘robo
sapiens’ to be developed was Honda’s Asimo, a
1.2-metre-tall android that resembled a child
astronaut. It could stride like a human, climb
stairs, and negotiate corners. It could even
turn the lights on and off, and to show off, it
could walk a figure eight! 

Asimo, however, was blind, deaf and dumb
—to be able to perform its antics, it had to be
remotely controlled. It may seem that a
remote-controlled robot is no big deal, but like
we’ve mentioned, the very fact that it could
stride and climb stairs is a massive feat of
engineering and computer science.

Aibo (Sony Electronics): Aibo is controlled by
its Mind 2 Software located on a removable
Memory Stick. This Memory Stick dictates
Aibo’s behaviour. This is even possible using a
PC or a mobile device.

In daily life, Aibo can communicate with
and entertain its owner. As time passes, Aibo
also starts to identify its owner’s voice and
face and it can even recharge itself!

Roomba (iRobot): Developed by
iRobot, Roomba is an intelligent robotic
vacuum cleaner. All Roomba ‘Robotic
Floorvacs’ feature iRobot’s AWARE
Robotic Intelligence System, which uses
lots of sensors to monitor Roomba’s
environment, and adjusts the bot’s
behaviour up to 67 times per second,
ensuring that Roomba cleans effectively, intelligently and safely.

Roomba is also the first cleaning robot to have hit the market
commercially, and has already tasted success.

The Evolution Chart
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For true versatility, robots need to be mobile.
Robot companions must be able walk on two
legs. And this is still an engineering challenge.
Bipedal movement is essentially a continuous,
controlled fall that’s avoided only by precisely
timing each step. 

Humans do it without thinking, so it seems
simple. But the fact is, it takes a fabulous amount
of computational horsepower just to prevent a
two-footed, walking bot from falling. Early
mobile robots had to drag a cable connecting
them to a fairly big computer—which meant
limited mobility. 

A lot of the focus in robotics now is on creat-
ing bots that walk like humans without help.
And a lot of this behaviour—including walking—
is learned by the robot, instead of being hard-
coded. It may seem that hardcoding the behav-
iour is simpler, but it’s not: it’s easier to program
robots so they learn by themselves.

According to some sources, computing
power increases a thousandfold every 15 years. If
this is the case and if the trend continues it’s
only a matter of time before even little metal
pets like the Aibo become intelligent. Still,
many experts believe truly smart robots are
inevitable, given the ever-growing power of
computer chips. One hopes so.

Household Help
Despite all the advances and inventions in robot-
ics, one unanimous feeling is that the future of
robots is at home. That is, home robots; your maid
or butler. These creatures would be expected to
wake you up and have your morning cuppa ready,
draw your bath, iron your clothes, make your
breakfast, clean the house, probably read you your
newspaper, make your lunch… the list continues.

But our existing technology may prove
restrictive, and while work continues in this
field, there is a certain amount of scepticism that
has to be countered before intelligent robots can
really become a part of mainstream life.

There are, for example, reasons to believe
that research in the US is not as extensive as in
Japan thanks to Hollywood’s depiction of robots
as evil beings. In Japan, though, robots have been
widely shown as helpers and may hence just be
accepted more easily. But what about the rest of
the world? Being fed off Hollywood may even
mar the widespread use of robots elsewhere.

Some interesting research from the creators
of the Roomba has shown that more than
anything else, people want to know if the robot
can ‘clean their floors’. The second most wanted
feature humans want in a robot is the ability to
wash clothes. Roomba seems to have fulfilled
the first desire. Time to wait and watch how
long before the next is fulfilled.

Can I Afford One?
US, Europe and Japan notwithstanding, can the
rest of the world afford a robot even if they became
reality? Developers and manufacturers predict that
the prices of these household helpers may not
exceed those of a high-end laptop. Say around
$1,000 (Rs 45,000). In which case, your dream bot
may just be reality. Start saving! 

aditya_kuber@thinkdigit.com
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Ram Mohan Rao

The only constant is change. In the computer
world, the only constant is increase in
speeds—read gigahertz. Ever since the public

got sold on the idea of faster processors, Intel and
AMD and the smaller processor manufacturers
have been making their millions off just one
idea—that people want faster computers. Of
course, many things go into the making of a faster
computer, but a faster processor is perhaps most
important. So how do AMD and Intel make proces-
sors faster?

In what follows, we dwell on the why and
what else and what if of dual-core processors
more than on the processors themselves. This is
because the actual concept is straightforward
enough—it’s the peripheral issues that are 
more pressing.

So, how does one make a faster processor? The
first and most obvious answer is to make changes
in the design of the processor such that it is intrin-
sically faster. To illustrate, pipeline implementa-
tions (see box Instructions And Pipelines) have a huge
impact on processor performance—and break-
throughs that improve processor design come
about once in a while. But some fundamental
barriers are being reached, and the need is for a
quick-fix solution to the ‘gigahertz problem’:
faster processors, right now!

The second thing one could do is increase
clock speeds. But that’s another fundamental
barrier that’s being reached: the rate at which
chips have been shrinking, manufacturers can’t
seem to achieve higher clock speeds without over-
heating the chip. Mandatory water cooling? That’s
a possibility… But even then, the heat we’re talk-
ing about is due to the power that’s supplied to
the chip, and it takes a lot of power to get a

Im
aging A

khilesh Prasad

The RACE
For Speed

For years, Intel and AMD upped speeds the gigahertz way. They’re now
pushing dual-core processors. We look at the why and the what of dual-core
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processor working at high clock speeds. Now, a
processor with a lot of electricity all around the
die is prone to electrical noise. This electrical
noise causes interference between the ‘wires’, or
pathways, on the processor. There could then be
some electrical radiation between adjacent path-
ways, which could, in turn, corrupt data.

Another solution lies in keeping the proces-
sor busy for more of the time. This is achieved
via HyperThreading, for example (see box
HyperThreading).

One more possible solution is increasing the
L1 and L2 caches (See box Processor Caches for more).
This is a definite possibility, and is being done—
but cache memory is expensive, and increases the
total cost of the chip. Both Intel and AMD have
been increasing the size of the L2 caches. Intel has
even added an L3 cache to the ‘Extreme’ Pentium
versions—this was previously unheard of in a desk-
top processor.

However, it must be borne in mind that
increasing the cache is a diminishing-returns situ-
ation: beyond a certain point, increasing the
cache just doesn’t help. 

As for increasing transistor count, processors
are already cramped. While it may be possible to
cram more in the future, it doesn’t seem feasible
right now.

The most elegant solution comes about when
you think of the way computers are used these
days: one person running several applications at
the same time. A quick-fix solution would seem to
be, why not delegate two processors for the same
jobs? In other words, if there are four tasks being
performed, how about two processors for the job—
each of them doing two tasks, both working at
the same time?

In principle, that’s what dual-core processors
are about: they’re essentially two processor cores
on one die. They’re not two physically separate

processors—the cores are on the same die, and
internally share the L1 and L2 caches (See box
Processor Caches). The two cores also have separate
pipelines (See box Instructions And Pipelines), so data
gets processed that much faster. (A die is an inte-
grated circuit chip as diced or cut from a finished
wafer; a wafer itself is a thin slice of semi-conduct-
ing material, such as a silicon crystal, upon which
the microcircuits are constructed.)

The two cores share some hardware, such as
the memory controller and the bus, whereas a
dual-processor system has completely separate
resources—such as the caches—for each processor.

Remember that in general, a dual-core proces-
sor won’t be as fast as a dual-processor configura-
tion. There could be exceptions to this, depending
on the software that runs on these newer
systems—so we’ll have to wait and watch to see if
dual-core beats dual-processor.

So then, why two cores on one die, when you
could have a dual-processor rig? The answer is
cost. A dual-core processor works out cheaper in
terms of production cost than two processors
taken together. This is not to mention that the
motherboards required for a dual-processor
configuration are more expensive too, because of
the extra circuitry, and for other reasons as well.

Think now about how two cores would help:
the simplest scenario is when your computer is
doing two entirely different things. One could be
the encoding of a video file, and the other could
be the manipulation of an image in Photoshop.
These two tasks could, in principle, be handled by
the two cores independently. There’s another
scenario here: the second processor will be able to
keep the system running smoothly if the first core
is being put to 100 per cent use. Think about how
your system slows down when you’re encoding a
video file… with the help of the second processor

Processor cache memory is expensive, very fast memory—much more
expensive than, say, DDR-RAM. It is located on the same die as the

processor. The processor cache is used by the processor to reduce the
average time that it takes to access memory.

To understand how cache memory works, think about two
instructions—“add A and B to make C” and “add D to C”. Now, after the
processor has added A and B to make C, C is stored in main memory (the
RAM) as a value. But it’s also stored in the cache. This is because it’s very
likely that there will be some instructions in the near future that will need
C. Sure enough, our next instruction goes “Add D to C”, and the processor,
when it looks for the value of C, looks in the cache first. In our example, it
will definitely find it in the cache, because just the previous instruction
mentioned C. So overall, the CPU has to ‘go’ to main memory less often,
with the help of caches. (Remember that main memory is much slower to
respond than cache memory. Since the cache needs to be fast, it has to be
placed physically very close to the processor.)

Now where ‘L1’ and ‘L2’ come in is when you consider the fact that L1
cache—the memory that is physically closest to the processor, after the
actual CPU registers—is prohibitively expensive. Processors therefore can
only afford a small L1 cache. If the cache size is to be increased, one needs
to resort to a slower, larger L2 cache, which is further away from the
processor. This is the multi-level cache concept.

The L1 cache, typically 8 to 64 KB in size, is where the processor looks
first. If the item is not found, the processor looks in the larger (typically
256 KB to 2 MB), slower L2 cache, and so on, all the way to main memory.

Processor Caches

Execution
Core

2MB 
L2 Cache

Bus Interface

Execution
Core

2MB 
L2 Cache

Bus Interface

MCH FSB

Intel’s Dual-Core Approach

The Intel approach to dual-core seems more like a quick-fix solution than something
built from the ground up. The two cores have their own L2 caches and bus interfaces,
but the communication between the cores happens via the Northbridge and FSB out-
side the chip. The ‘MCH’ here is the Memory Controller Hub.
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core, you wouldn’t even notice that there’s some
encoding going on in the background!

The Software Aspect
There’s a difference between multi-tasking
faster, and a single program running faster. You
could expect a performance boost if, like we said,
you’re running two very different programs. But
the story is different if you’re running just one
program. In this case, you may not even notice
the difference between a regular processor and a
dual-core.

So overall, what kind of an improvement can
you expect with dual-core? The operating system
and the software have to be aware that there are
two cores out there doing the work, and make the
threads accordingly. Remember that the two cores
make sense only if there are entirely different
threads to exploit—so the separate threads have
to be created somehow. And it is one of the jobs of
the OS and the software to do this. On top of that,
they obviously cannot do it with 100 per cent effi-
ciency (or segregation).

So can current OSes and software do this?
Unfortunately, not all. Some OSes, such as
Windows XP Home, simply cannot acknowledge
that there are two processor cores. And most
games and applications aren’t written with this in
mind. (Adobe Photoshop, amongst other
programs, happens to be, so if you use it exten-
sively, go right out and buy a dual-core!)

Meta Group vice president Steve Kleynhans
says, “It's a lot more complex to write software
that's multithreaded. It's also harder to check for
errors. We could find ourselves with buggier soft-
ware. Certainly software vendors have known this
and been working on multithreaded applications
for some time, but it is more complex.”

That makes it sound like a pretty dismal situ-
ation. But keep in mind two things—first, that as
dual-core becomes mainstream, operating
systems and software will definitely evolve
towards being multithreaded, complex though it
may be. The market will demand it. And secondly,
as we mentioned before, even if your applications
aren’t currently aware of two processors, and if
one app maxes out one core, the other core will
prevent your system from lagging.

But then again, another question raises its
head. If dual-processor-aware applications aren’t

so many, why are the chipmakers pushing for
their release right now, in their desktop avatars?
The answer probably lies in competition—and
early adopters of the technology apart, neither
AMD nor Intel can afford to lag behind too much,
lest its marketshare be gone by the time it gets in!

AMD’s And Intel’s Approaches
AMD’s and Intel’s approaches to dual-core is
very different. In AMD dual-core processors, the
two cores communicate via a Northbridge-like
provision (see box The Northbridge) within the
chip itself. AMD had to add this provision to the
Athlon 64 die so as to support the onboard
memory controller and HyperTransport link
(see box HyperTransport), and this now comes in
handy—a second core can easily be accommo-
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Acomputer instruction is not as simple as “add A and B”.
There’s more to it than that. For example, if you’re talking

about A and B, the instruction needs to be read first; then, the
data needs to be brought from wherever it is—either from the
CPU registers, the CPU cache, or from main memory. After
that, the addition operation must be done, and the result
placed somewhere so it can be accessed.

There are independent units in the processor that do each
of these things. For example, one unit fetches the instruction;
another checks where in the system the values are (assuming
it’s an ‘add’ operation we’re talking about); another brings the
values in; another does the actual calculation; and finally, one
unit places the result in a suitable location.

What happens in pipelining is that sequential instructions
are carried out simultaneously, based on the principle that

each of the units mentioned above can do different things in
different instructions.

To illustrate, suppose “add A and B” is followed by “add C
and D”. What happens? First, the “add A and B” instruction is
fetched by the instruction fetcher. Then, while the appropriate
unit is figuring out where A and B are, the “add C and D”
instruction is fetched by the instruction fetcher. After that,
while A and B are being added by the adding unit, the
‘location figuring’ unit is figuring where C and D are.

The basic idea of pipelining is as simple as that—each unit
of the CPU is always doing something, instead of each
instruction finishing before the next one is brought in.

Modern advances in computer architecture consist largely
in figuring out how to make the pipeline architecture on the
chip work better.

Instructions And Pipelines

AMD’s Dual-Core Approach

CPU 0

L2 Cache
(for CPU 0)

Crossbar Switch

CPU 1

L2 Cache
(for CPU 1)

Memory Controller HyperTransport Technology

System Request Interface

Because AMD added a Northbridge-like provision to the Athlon64 die to support the
memory controller and the HyperTransport link, the two cores can communicate
with each other within the processor itself. The ‘crossbar switch’ handles requests to
the memory controller and the HyperTransport link to the rest of the system.
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dated, with all inter-core communication hap-
pening within the chip.

By contrast, in Intel dual-core processors, the
communication has to happen via the front-side
bus and the Northbridge on the motherboard,
meaning external access.

So are AMD’s dual-core chips “better and
faster” than the Intel one? It seems so. To quote
News.com, “Both Anandtech and Tom’s Hard-
ware—two hardware benchmarking sites—have
published reports stating that, in their own
tests, the dual-core Athlon 64 X2 chips gener-
ally edge out the Intel Pentium D and the dual-
core Pentium 4 Extreme Edition, although the
results vary by the tests. Anandtech found that
the fastest dual-core Athlon, the 4800+, and
often other dual-core Athlons, typically outper-
formed the Intel chips on tests for single appli-
cations, such as running Adobe Photoshop 
or DivX.”

This is not surprising, since it seems that
Intel’s Pentium D, a dual-core processor, is just
like two identical P4 Prescott processor dies
tacked together.

Heat
Heat is the enemy of processors, to the extent
that one of the reasons clock speeds can’t just be
bumped up is heat! How much heat do dual-core
processors produce? Fortunately, not too much.
AMD says their dual-cores will produce about the
same amount of heat as their single-cores. Intel’s
dual-core processors, like the Pentium D, pro-

duce more heat than AMDs—but even this is not
alarmingly high.

We’ve all heard about heating issues with
processors, and now, when there are two cores on
a single die, shouldn’t there be double the
amount of heat?

There are a couple of reasons that this is not
the case, apart from the obvious fact that not
both cores will be maxed out at the same time.
Firstly, clock speeds: dual-core processors are,
in general, clocked somewhat slower than their
single-core brethren. And secondly, dual-core
processors are being manufactured using the
90 nm fabrication process, just like the latest
single-cores. The “90 nm” refers to the smallest
‘feature’ size on the die, usually the gate width
of the transistors. A smaller fabrication size
leads to less power dissipation, and therefore
less heat.

The Northbridge is one of the two chips in the core logic chipset on a
motherboard, the other being the Southbridge. Sometimes-but not

too often-the two have been combined on to one die, when design
complexity and fabrication processes permitted it. But in general, core
logic chipsets are divided into these two main parts. The Northbridge
typically handles communications between the CPU, RAM, AGP port or
PCI Express, and the Southbridge. Some Northbridges also have
integrated video controllers.

In our context, the point is that AMD’s dual-cores have a Northbridge-
like provision within the chip itself, so there’s no need to go to the
motherboard for inter-processor communication.

The Northbridge

0 1 2 3 4 5 6 7 8 9

L1 D1 E1 E2 E3 E4 WR

L1 D1 E1 E2 E3 E4 WR

L1 D1 E1 E2 E3 E4 WR

L1 D1 E1 E2 E3 E4 WR

L1 D1 E1 E2 E3 E4 WR

Inst 1

Inst 2

Inst 3

Inst 4

Inst 5

How Pipelining Works

Clock cycle 

Pipelining is one of the fundamental techniques to speed up processors. The orange
blocks above are instructions, broken into their component parts. ‘L1’ stands for
‘Load’; ‘D1’ stands for ‘Decipher’; ‘E’ stands for ‘Execute’. So here, in clock cycle 1, the
processor loads instruction 1. In cycle 2, the first instruction is being deciphered,
while at the same time, the second instruction is being loaded. Clock cycle 3 sees
instruction 1 being executed, instruction 2 being deciphered, and so on. In dual-core
processors, each core has its own pipeline.
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The Motherboard Issue
The first run of the dual-core Athlon 64 X2 chips
are compatible with any Socket 939/940 mother-
board. All that’s required is a BIOS update! But
in the case of Intel, you need a new pair of sup-
porting chipsets—the Intel 945P and 955X—
meaning you’ll have to buy a new motherboard
if you want an Intel dual-core. This really makes
it seem like AMD is already ahead in the race
when it comes to dual-core.

Licensing issues
With the advent of dual-core, licensing issues
have cropped up. If a software is licensed for one
‘computer’, but it’s assumed that the computer
has only one processor, what happens when the
computer happens to have more than one
processor? Does a dual-core processor count as
two processors or one?

How multi-core chips will affect licensing
is unclear, but industry analysts say a simple,
uniform system is unlikely anytime soon. AMD
recently released recommendations for how
software companies should charge: it said
companies should count processors based on
the number of physical sockets used. This
would mean a dual-core chip would count as a
single processor. Microsoft, too, has said that

it will consider a dual-core processor a single
processor, and will charge per processor, not
per core.

Oracle, on the other hand, considers a dual-
core server a two-processor server when charg-
ing for its server software. Similarly, IBM
considers two cores as two processors for soft-
ware licensing purposes. But other software sell-
ers are taking the opposite stance: Sun not only
prefers the socket definition for a processor, it
argues for a radical pricing structure change.
When selling its server and desktop software, it
charges a fixed annual fee based on the
customer’s total number of employees.

Kuldip Hillyer, a manager in the strategic
marketing group at BEA, gives a compelling
argument: “Dual-core does not equal two CPUs
in terms of performance. Hardware vendors
don’t charge you double; they charge a 30 to 40
per cent premium.”

Dwight Davis, vice president and Practice
Director at Summit Strategies, sums it up: “Some
licensing models are showing signs of strain,
none more than the per-CPU model common to
databases and application servers. The static per-
CPU model seems destined for extinction.”

Here To Stay
Call it a game. Or a race. The chipmakers simply
had to get faster CPUs out there, and dual-core
seems the best approach—regardless of how
much software support currently exists.

However, regardless of whether the soft-
ware supports it, the fact is that more and
more applications are being run these days at
the same time. We routinely run anti-virus soft-
ware, firewalls, CD-burning, Web browsing,
and much more, all at the same time. If the OS
can properly schedule these software to run on
two cores, you will see the difference. In addi-
tion, software will evolve, and individual pieces
of software will soon become amenable to
being run on two cores.

Whatever the case may be, you’re going
to get a dual-core processor soon. They will be
mainstream by 2006—there’s no escaping that! 

ram_mohan@thinkdigit.com

AMD could
already be
ahead in the
race when it
comes to
dual-core

HyperTransport is a high-speed technology
for data transfer within the integrated

circuits in computers and other devices. The
technology allows data throughput in excess of
12.8 gigabytes per second. HyperTransport was
developed by AMD in co-operation with several
other companies, and is a trademark of the
HyperTransport Consortium.

HyperTransport

To understand HyperThreading (HT), one needs to first understand what
threads are. Threads are something that programs create. Think about

threads not as programs, but as independent execution lines. An example is
seen in browser software: the graphics, text, sound, all seem to load
independently-that’s because each of these elements is a thread, which are
interpreted by the browser as such.

Intel’s HT technology basically fools the OS into thinking that there are
two processors. If there had been two processors, it would have been
possible to hand one thread to one processor and the other thread to the
other one; with HT, that’s what it seems like to the OS. 

This ideally doubles the activity in the chip, and speeds it up. One
example of how this speedup takes place is that with two threads being
handed to the processor, there are fewer cache misses—a cache miss, as the
term suggests, occurs when the processor requests something that isn’t there
in the cache.

Intel has estimated that a single instruction thread uses only about 35
per cent of a processor’s available resources.

If there had been ideal division of labour between the two threads, they
could have done something totally different—for example, one thread could
operate on fetching data from the hard disk, and the other could do integer
arithmetic. Of course, that’s the ideal scenario, and the reality is that HT can
increase the performance of some applications by “up to” 30 per cent,
according to Intel.

The Pentium Extreme Edition 840 is a dual-core processor that supports
HyperThreading within each core—so this means it appears as four logical
processors to the OS!

HyperThreading
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I
n January 2005, we touched upon and
compared AGP cards. Our prediction that
PCIe video cards would take some time to
pick up in the market has been correct to an

extent. However, the lower end of the spectrum
has not conformed to this, and it’s certain that
the popularity of low-end PCIe cards is on the
rise—while the mid-range and high-end
segments have yet to make its mark.

In this comparison, we opted for the same
method of categorising our cards—in three
segments; low-end, mid-range and high-end, like
we did last time. Most of the cards we received
this time are also available in the AGP flavour
except for the nVidia 5XXX series and the ATi
9XXX series.

Do refer to the AGP comparison in our Janu-
ary issue. This will help you gain an overall
perspective into the performance difference
between the two platforms.

We tested 32 cards this time in sum across all
categories with a modified test process (See box
How we tested). The test process was modified
keeping in mind the powerful GPUs that are
available on current video cards. We got to lay
our hands on some of the best cards available in
the market—and some not-so-available ones—
including the GeForce 7800GTX and the 6800
Ultra Dual GPU.

LOW-END CARDS
Would you have imagined six months ago that
PCI-Express products would be available for the
low-end market so soon? PCI-Express has pene-
trated the budget segment big-time. This could
partly be credited to the plummeting prices of
PCI-Express motherboards which, as you’re
probably aware, we reviewed last month.

The eight PCI-Express low-end graphics cards
we received were from Gainward, Gigabyte,
MaxForce, MSI, PowerColor and XFX. Even the
big players, thus, have a presence in this
segment. The cards in this segment were obvi-
ously based on the lower-performing GPUs—the
nVidia GeForce 6200TC and the ATi X300.

Features
Both the nVidia and ATi GPUs in this segment
featured new memory management tech-
niques. While nVidia featured TurboCache,
ATi featured HyperMemory. (More on these
technologies later). The Gainward, PowerColor
and XFX GeForce 6200TC supported 256 MB,
while the rest supported 128 MB of memory.
Of these, only the PowerColor X300 256 MB
card sported a 128-bit memory interface,
while the rest had either a 64- or a 32-bit mem-
ory interface. We therefore expected the
PowerColor X300 to be the top performing
card in this category.

Most of the cards came bundled with a S-
Video cable—except the MSI GeForce 6200TC 128
MB, which came only with a driver CD. Some
cards came bundled with a DVI to VGA adapter.
Dual-monitor, which was a feature found only
on high-end cards just a few years ago, was avail-

able on all the cards here—except for the Giga-
byte GeForce 6200.

All the nVidia-based cards supported DirectX
9.0c, which essentially means Shader Model 3.0,
whereas the ATi-based cards supported DirectX
9.0b, which means Shader Model 2.0. The core of
the nVidia cards is clocked at 350 MHz, whereas
that of the PowerColor X300 is clocked at 400
MHz—while the other ATi-based cards had a
stock core speed of 325 MHz. The 256 MB nVidia
cards had memories running at effective speeds
of 700 MHz, while all the ATi based cards had
their memories clocked at 400 MHz.

The GeForce 6200TC has all the features of
the high-end cards from nVidia. So why are these
cards in this category? It is crippled by only four
pipelines and a single texture mapped unit per
pipeline. Also, the core and memory clock speeds
are much lower than the GT cards in the mid-
range and the high-end. This, in addition to the
shared memory, causes them to yield much
lower performance than the mid-range and high-
end cards. This is also applicable to the cards
based on the ATi chips.

Performance
As expected, the top performer in this category
was the PowerColor X300 256 MB card, with its
comparatively higher clock speeds and a wider,
128-bit memory interface.

At 1024 x 768 in Doom 3, this card posted a
score of 22.20 fps, followed closely by the Gain-
ward GeForce 6200TC 256 MB 20.30. In Half-Life 2
at 1024 x 768, it logged 65.07, while the Gain-
ward scored 48.13 fps. The same was the case
with FarCry—the PowerColor churned out 72.19
fps, while the Gainward followed with 58.80.

In 3DMark 03 at default settings, this card
scored 3098, which is the highest in this cate-
gory, followed by the Gainward at 2659.

Conclusion
Remember that this category, which we have
called ‘low-end’, is nothing but the budget cate-
gory, and pricing a card too high in this catego-
ry is alienating the card from the consumers in
this segment. The fight would have been
between the MSI GeForce 6200 256 MB and the
Gainward GeForce 6200 256 MB. But the MSI

was priced way too high at Rs 6,300, where-
as the Gainward was priced at Rs 3,950 - and
thus, won the Digit Best Buy Gold because of
its best price-to-performance ratio.
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PCI-Express cards
are much faster
than their AGP
cousins, and once
you start playing
games on them,
it shows
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Whatever it won in terms of pure performance
and features, the PowerColor X300 256 MB card
lost when considering its price of Rs 5,950. It
still managed to scrape in as our Silver winner.  

MID-RANGE CARDS
The mid-range cards always hold the interest of
those who want the best, but can’t afford it. Such
users usually settle for the next-best. We got
plenty of cards to play with this time—ten cards
from nVidia and three from ATi. We could not
include one card from Asus, the 6600GT, since it
suffered from display corruption. We also had
two new entrants in this category, namely BIG
and Sapphire, who sent us nVidia and ATi
cards respectively. 

Features
Most cards in this category were bundled with
the regular assortment of cables and games, but
some brands stood out. Sapphire, for instance,
bundled a VIVO cable with their card, while it

rained games in the MSI box—we counted 14 CDs,
including game and software application CDs.
As usual, Gigabyte, too, provided an excellent
game and software bundle with their cards.

The rest of the cards were modestly pack-
aged. However, the performance of the cards was
what we were waiting for, and that’s what we
talk about next.

Almost all the cards we tested in this cate-
gory were based on either the 6600 or 6600GT
chips from nVidia, or the X600 or 600XT chips
from ATi. Before we move on to performance,
let’s look at some differences in the cores of
these two chips. This will let us better analyse
the performance difference that will be appar-
ent when you check the scores.

The 6600GT core has been built from the
ground up for the PCIe bus and runs at a core
clock speed of 500 MHz, which is actually faster
than a 7800GTX. It also features eight pixel
pipelines, which puts it in the same class as the
Radeon 9700.

The low-end segment of our tests comprised eight cards based on
the nVidia GeForce 6200TC and the ATi X300 chips. The mid-

range segment comprised thirteen cards based on the nVidia
GeForce 6600 series and the ATi X600 and X700 series chips, while
nine cards based on the nVidia 6800 series and the 7800 GTX and
ATi X8xx series chips were included in the high-end segment. We
also tested the MSI NX6800GT SLI and the ASUS Dual GPU GeForce
6800 Ultra cards separately.

We had two different test beds, one for the low-end and other
for the mid-range and high-end cards. The test bed for the low end
comprised of a 939-pin AMD Athlon64 3800+ on an ECS RS480-M
motherboard with 512 MB of 400 MHz DDR Corsair TwinX RAM
modules and a 120 GB Seagate SATA hard drive.

The other test bed comprised an AMD Athlon64 FX-53 on an
nForce4 SLI edition-based motherboard with high performance and
low latency 1 GB of 400 MHz DDR Corsair XMS TwinX RAM modules,
and a 250 GB Maxtor SATA hard drive. The test beds above were
chosen after careful consideration to eliminate any CPU and
memory bottlenecks in the respective categories. All the tests were
performed at 32-bit colour depth.

Low-end card tests: The testing process for the different
categories was also different. In the low-end segment, we benched
Doom 3, Half-Life 2 and FarCry at lower resolutions of 640 x 480,
800 x 600 and 1,024 x 768, and the frames per second were logged.
Doom 3 tested the OpenGL graphics subsystem, while Half-Life 2
and FarCry tested the Direct3D subsystem. Futuremark’s popular
synthetic benchmark, 3DMark 03, was also run at 800 x 600 and

1024 x 768 at default settings, and the score was noted. During the
tests, anti-aliasing (AA) and anisotropic filtering (AF) was turned off.

Mid-range and high-end card tests: For the mid-range and high-
end cards, we used the above-mentioned games as well as Halo and
Futuremark’s 3DMark 05. All the gaming tests were performed at
1024 x 768 with AA and AF turned off, and the scores were noted.
Doom 3 was tested at 1,024 x 768 at high quality and 4x AA settings.
It was also tested at 1,280 x 1,024 and 1,600 x 1,200 at high quality
settings with AA turned off. Half-Life 2, FarCry and Halo were tested
at high quality settings at 1,024 x 768, 1,280 x 1,024 and 1,600 x
1,200 at high settings, and at low-quality settings at 1,024 x 768.

3DMark 03 and 3DMark 05 were run at default settings at 1,024
x 768 and the scores were noted. In all the cases, AA and AF were
turned off. The MSI NX6800GT SLI and the Asus Dual GeForce 6800
Ultra GPU cards were tested the same way.

How We Awarded
For the low-end products, price was given a considerably higher
weightage than the other categories. The price weightage was
reduced for mid-range and high-end cards in favour of weightage
for performance and features.

The performance weightage for the high-end cards was the
highest. The scores were calculated on the basis of features,
performance and price. 

The card with the highest score was awarded the Digit Best Buy
Gold award and the first runner-up was awarded the Digit Best Buy
Silver award.

How We Tested

PowerColor X300 
128 MB

Gigabyte GeForce 6600
TurboForce Edition 256MB

SEPTEMBER 2005
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Scoreboard                             Low-end PCI Express Graphics CardsSEPTEMBER 2005 SEPTEMBER 2005

Gainward
GeForce 6200 
256 MB
NVIDIA GeForce
6200TC
28.70
4
DVI-to-VGA 
adapter, S-Video
cable, Driver CD

256
110
350
550
64
2048x1536
DX 9.0c/
OpenGL 2.0
4
3.0/3.0
31.98

41.30
29.90
20.30

85.49
68.56
48.13

96.85
83.34
58.80

3602
2659
14.63
3950
75.31

Gigabyte
GeForce 6200 
128 MB
NVIDIA GeForce
6200TC
20.65
6
DVI-to-VGA 
adapter, 
Driver CD

128
110
350
700
32
2048x1536
DX 9.0c/
OpenGL 2.0
4
3.0/3.0
25.96

32.00
22.30
15.40

77.15
60.48
42.14

92.91
69.93
47.47

2721
1997
16.51
3500
63.12

Gigabyte
X300 SE 
128 MB
ATi X300 SE 

21.35
4
S-Video-to-
Composite 
adapter, Driver CD

128
110
325
400
64
2048x1536
DX 9.0b/
OpenGL 2.0
4
2.0/2.0
28.10

32.70
22.10
15.00

93.89
72.25
48.19

104.89
77.88
49.42

1988
2851
16.51
3500
65.96

MaxForce
GeForce 6200 
128 MB
GeForce 6200TC

25.55
4
DVI-to-VGA 
adapter, S-Video 
cable, Driver CD

128
110
350
700
32
2048x1536
DX 9.0c/
OpenGL 2.0
4
3.0/3.0
25.56

32.10
22.20
14.80

76.43
60.20
41.65

90.76
68.35
46.53

2679
1963
17.00
3400
68.11

MaxForce
X300 SE 
128 MB
ATi X300 SE 

21.35
4
S-Video-to-
Composite
adapter, Driver CD

128
110
325
400
64
2048x1536
DX 9.0b/
OpenGL 2.0
4
2.0/2.0
26.96

31.10
21.20
14.40

91.44
71.22
47.44

103.45
75.78
47.72

2711
1890
14.82
3900
63.13

MSI
GeForce 6200
128 MB
NVIDIA GeForce
6200TC
21.35
4
Driver CD

128
110
350
400
64
2048x1536
DX 9.0c/
OpenGL 2.0
4
3.0/3.0
30.59

40.10
28.80
19.70

85.30
37.93
47.22

96.01
84.92
57.99

3595
2641
9.17
6300
61.12

PowerColor
X300 
256 MB
ATi X300 

25.90
4
DVI-to-VGA
adapter, S-Video
cable, Driver CD

256
110
400
400
128
2048x1536
DX 9.0b/
OpenGL 2.0
4
2.0/2.0
38.25

48.40
32.10
22.20

105.25
91.71
65.07

113.66
106.03
72.19

4211
3098
9.71
5950
73.86

XFX
GeForce 6200
256 MB
NVIDIA GeForce
6200TC
27.30
4
S-Video Cable,
Driver CD

256
110
350
400
64
2048x1536
DX 9.0c/
OpenGL 2.0
4
3.0/3.0
27.45

33.40
24.00
16.20

82.61
63.81
43.93

93.53
72.10
49.50

2968
2166
16.51
3500
71.26

On the other hand, the X600 runs a clear 100
MHz less, and has four pixel pipelines less. The
X700 is more in the class of the 6600 GT, but its
performance is much lower, as you will see in
the performance analysis.

Performance
The 6600 series dominated here. In most game
tests, the ATi cards couldn’t match the nVidias.
None of the ATis posted scores that could
match up to the 6600 cards. At higher resolu-
tions, the 6600 non-GT cards and the ATi cards
could only manage a maximum of 40 fps. The
GTs comfortably cruised above 50 fps in most
DirectX games. This translates into a good
gameplay experience.

Users who purchase a mid-range video card
look for value of money as well as a good, if not
excellent, gaming experience. This is what we
based our tests on.

The price these cards retail at is generally in
the range of Rs 5,000 to Rs 15,000. For a user who
wants decent gameplay at resolutions of up to

1024 x 768, a regular non-GT 6600 is more than
enough. In most cases, you can turn on a little

of the eye-candy in games, but not all of it.
The only ATi card we can recommend here is
the X700. The other cards were barely able 
to provide playable frame rates—even at
1024 x 768.

XFX GeForce 6600GT  
256 MB

BRAND
Model

Chipset

Features
Dual Monitor Support
Software Bundle

Specifications
Memory (MB)
Manufacturing (nm)
Core Clock Speed (MHz)
Effective Speed (MHz)
Memory Bus Width (bits)
Max Resolution
Compatibility (DX/OpenGL)

Pixel Pipelines
Pixel Shader/Vertex Shader
PPeerrffoorrmmaannccee
3D - OpenGL
Doom 3
Normal (640x480x32) (fps)
High (800x600x32) (fps)
Max (1024x768x32) (fps)
3D - Direct3D
Half-Life 2
Normal (640x480x32) (fps)
High (800x600x32) (fps)
Max (1024x768x32) (fps)
FarCry
Normal (640x480x32) (fps)
High (800x600x32) (fps)
Max (1024x768x32) (fps)
3DMark 03  score
Low End (800x600x32) 
High End (1024x768x32) (fps)
Price Index
Price (Rs)
Overall Score (Out of 100)
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The culprit in the case of the ATi cards is the
crippled clock speed and pixel pipelines.
Another factor is the older architecture that the
ATi cards are based on, as compared to the 6XXX
series from nVidia, which has been developed
from the ground up. The architectural enhance-
ments do play a major role in the scores that the
6600 cards posted.

The 6600GT definitely costs more, but you
can be sure of the performance of the card,
which is much better in terms of frame rates and
the eye candy possible in games—even at high
resolutions. In fact, it sometimes beat the plain
vanilla X800 in the game tests.

There is a continuous stream of new games
released each year, and with each game the
hardware ante is upped, at least in the video
card department. Any investment on a 6600GT
is money well spent—it will definitely stand you
in good stead for at least the next two years.

Conclusion
The XFX GeForce 6600GT duo was the king
here. No other card could come close to the
scores posted by these two, in any game, be it
OpenGL- or DirectX-based. They even topped
the 3DMark scores. The surprising thing was
that the XFX GeForce 6600GT 128 MB card
posted scores identical to its 256 MB counter-
part in all the games! It seems none of the
games or benchmarks could utilise the extra
128 MB available on the XFX GeForce 6600GT
256 MB card.

In sum, the XFX GeForce 6600GT 256 MB wins
the Digit Best Buy Gold award in the mid-range
PCI-e card category, while the XFX GeForce
6600GT 128 MB wins the Digit Best Buy Silver
award.

HIGH-END CARDS
This is where we talk about the cream of the
crop! Low-end cards are accessible to anyone, and
anyone willing to spend a little extra can get
mid-range cards. However, this is the section
where we talk about the Porsches and the
Maybachs of the desktop graphics world. 

Features
Features-wise, all these cards give you every-
thing, including games, VIVO connectors and all
the other stuff you could possibly expect. The
VIVO connectors are especially mentionable,
since you can directly provide component output
to your HDTV from the card. Imagine playing
Doom 3 on your HDTV!

PowerColor and Asus were the two manu-
facturers that provided HDTV VIVO connectors.
Games were aplenty, and MSI actually provided
five games with the RX800. It’s a pity the card
couldn’t make it to the comparison. On the
other hand, XFX with their eye-catching X-
shaped box provided the regular wires and
cables—there was no HDTV connector. In terms
of games, they bundled the full version of
FarCry (DVD) with their high-end cards, which is
sure to attract users.

Performance
We received 10 cards in this category, discount-
ing the Asus 6800 Ultra Dual GPU monster and
the SLI-setup. Of these, we could only review
nine, since the MSI RX800 provided a corrupted
display, and we could do nothing about it. The
remaining nine are the best to date, anywhere,
worldwide. These included top-of-the-line offer-
ings from ATi and nVidia.

While nVidia has come out with two revi-
sions of the graphics cards in their arsenal, ATi
has stayed put with their X800 series. Sadly
enough, the current nVidia cards make the X800
look and feel aged.

All the cards except the Gigabyte had active
cooling circuits. Gigabyte chose to walk a differ-
ent path and provided a passive pipe cooling

The nVidia GeForce 6200TC and the ATi X300 chips in the low-end segment
featured new memory management techniques. While nVidia featured

TurboCache, ATi featured HyperMemory. The bottomline is that both these
implementations are in many respects similar to each other. In both the cases, the
graphics card has dedicated memory onboard, but in addition to that, it can access
a limited amount of system memory. This is something like AGP on a PCI-Express
bus, because AGP cards can access system memory in a similar way, and this was
known as AGP texturing. Using this method, the requirement of the amount of
onboard memory is greatly reduced, and this contributes to reduction of price.

The concept is somewhat similar to motherboards with onboard graphics, but
the difference is that with graphics cards, there is at least some amount of
dedicated memory, whereas in the on-board graphics of motherboards, there is
usually none. The advantage of TurboCache and HyperMemory is that they bring
most of the features of high-end cards within the reach of the general populace. This
technology provides the highest graphics performance-to-price ratio.

nVidia TurboCache And ATi HyperMemory

XFX GeForce 6600GT  
128 MB

PowerColor X850 XT Platinum Edition 256MB
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system on their ATi X800 card. The cooling was,
however, not very efficient, and the heat-sink
temperature soared when while testing it.

The XFX Geforce 7800GTX was a pleasure to
test. Talk about adrenaline rushes... this one will
get yours into overdrive! It scored a massive
16,649 points in 3DMark 2003 and 7,942 points in
3DMark 2005, second only to the SLI and Dual
GPU monsters. At 2,048 x 1,536 in Half-Life 2, we
could barely manage to read the text on the
monitor, but this card effortlessly shoved a score
of 86 frames per second at our incredulous faces.

The processing power of the GPU is the what
needs to be given the credit here. In the 7800GTX
core—the G70—the number of transistors on the
die has gone through the roof. The performance
boost here is due to the effective implementa-
tion of the G70 architecture and the DDR3
video RAM.

Although it lost out in the 3DMark tests,
the 7800GTX beat the pants off the compe-
tition in the game tests. Just take a look at
the scores table—the rest of the cards
didn’t stand a chance!

W hen you buy a high-end 3D graphics card, you want the card
to play the latest games for the next few years. Alas, newer

technologies develop, and in just about a couple of years, your 3D
graphics card buckles under the pressure of the ever-
increasing polygons that are demanded by newer
games, and you feel your card, which was high-
end just a couple of years ago, is no longer a
worthy gaming card.

nVidia has looked at the past and has
reintroduced a scalable solution for this
problem, known as SLI—Scalable Link
Interface—which was the brainchild of
3DFX in the late 1990s. In an SLI setup,
two graphics cards are mounted on an SLI-
ready motherboard and connected to each
other by a bridge. This enables them to work in
tandem and deliver up to twice the performance of a
single card. The bandwidth between the cards and the
CPU still remains the same as that of a single card,
because each card is limited to work at x8 speed instead of
the x16 speed of a single card.

The MSI NX6800GT SLI is a pair of GeForce 6800GT 256 MB
cards which can be connected in SLI configuration. These cards
came in a nice carry case with some bundled games and OEM

software. Two DVI to VGA adapters, power and S-Video cables
were also provided.

It was mounted on an nForce4 SLI motherboard with an AMD
Athlon64 FX-53 and 1 GB of Corsair XMS DDR RAM in dual-
channel configuration. The benchmark results did not surprise us

at all—they were what we expected from an SLI
setup. The pair delivered fluid frames in all the

benchmarks even at the highest possible
resolution. At 1,600 x 1,200 in Doom 3,

Half-Life 2 and FarCry, the frames per
second logged were 128.6, 85.14 and

122.10 respectively. Even with all
the eye-candy cranked up, the SLI

setup’s hunger for polygons was not
satisfied, and it continued to deliver top-

notch frame rates.
In 3DMark 03 and 3DMark 05, the cards posted

astounding scores of 19,282 and 9,045 respectively.
The MSI NX6800GT SLI is priced at Rs 61,000, which is

much higher than the GeForce 7800 GTX’s price of Rs 35,000. The
MSI NX6800GT SLI beats the GeForce 6800 GTX in the 3DMark
benchmarks, but lags in the gaming benchmarks. If you are a
hardcore gamer, and demand the highest gaming performance,
SLI is the way to go.

MSI NX6800GT SLI

The next-best card was the 6800 Ultra,
which stood up to its reputation of a pixel
cruncher. The ATi cards put up a brave front,
especially the PowerColor X850XT PE, which
was able to take on the XFX and MSI 6800GTs.

All the other cards ended up like extras pn
the set, never making their presence felt. The
XFX GeForce 7800GTX was the show-stealer.

Conclusion
Given the excellent performance of the XFX
7800GTX, we expected it to be expensive. However,
the price will put a smile on your face: it retails for
just Rs 35,000. The XFX Geforce 7800GTX wins the
Digit Best Buy Gold crown in our graphics card
comparison in the high-end category.

The XFX GeForce 6800GT is the runner-up. It
provides blazing fast frame rates which,
although not comparable to the
7800, are fast enough to let you play
any game on it. At Rs 23,000, this card
takes the Digit Best Buy Silver crown
for the high-end graphics card
category.

XFX GeForce 7800 GTX 
256 MB

XFX GeForce 6800GT 
256 MB
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Scoreboard                             Mid Range PCI Express Graphics Cards
ASUS
Extreme N6600
TOP

NVIDIA GeForce
6600
27.40
DVI to VGA
adapter, S-Video
cable

Game CDs, OEM
softeware bundle,
ASUS utilities and
driver CD

128
110
300
550 DDR
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
27.10

74.50
69.20
57.50
44.70

104.71
65.53
44.02
32.13

192.84
75.47
52.96
31.19

70.96
65.78
45.95
33.91
6662
2129
4.29
14700
58.79

BIG
GeForce 6600

NVIDIA GeForce
6600
28.80
DVI to VGA
adapter, S-Video
to composite
cable, Composite
extension cable,
S-video to multi
composite cable

Driver CD

256
110
300
550 DDR
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
23.52

74.90
74.60
51.10
36.80

91.81
62.32
39.91
31.70

185.11
59.79
39.39
28.52

57.01
50.84
34.37
24.92
5266
2087
10.79
5850
63.11

BIG
GeForce
6600GT

NVIDIA GeForce
6600GT
26.80
DVI to VGA
adapter, S-Video
to composite
cable, Composite
extension cable,
S-video to multi
composite cable

Driver CD

128
110
500
1000 GDDR3
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
31.73

84.10
84.10
66.60
53.50

113.96
74.80
52.60
39.01

196.15
88.71
63.33
35.74

85.05
81.10
57.39
42.83
7768
2455
6.82
9250
65.35

Gainward
Ultra/1780 PCX
Golden Sample

NVIDIA GeForce
6600
28.40
DVI to VGA
adapter, ViVo
cable

OEM software,
Driver CD

256
110
300
550 DDR
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
21.97

59.60
59.60
44.90
34.00

85.82
58.12
38.59
31.13

160.23
54.97
38.32
28.35

55.09
49.37
33.96
24.89
5132
2079
12.75
4950
63.12

Gigabyte
GeForce 6600
TurboForce
Edition
NVIDIA GeForce
6600
28.40
DVI to VGA
adapter, S-Video
cable

OEM software,
Driver CD

256
110
300
550 DDR
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
25.47

68.60
69.70
51.80
39.80

102.31
69.34
47.22
38.18

155.79
59.59
41.45
30.82

76.60
60.24
41.56
28.67
5627
2406
6.32
9990
60.19

Gigabyte
X600 XT

ATi X600 XT

23.80
ViVo cable

Game CDs, Driver 
CD

128
110
400
700 GDDR1
128
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
4
14.38

42.00
41.90
26.90
16.10

69.43
44.12
25.63
17.73

135.88
30.67
20.36
12.89

34.57
31.12
22.71
14.58
3438
1367
7.02
8990
45.20

MSI
NX6600

NVIDIA GeForce
6600
27.40
S-Video to compos-
ite cable, S-Video to
multi composite
cable

Game CDs, OEM
software, MSI
Utilities and Driver
CDs

128
110
300
550 DDR
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
21.05

59.50
60.30
44.80
33.90

85.63
51.61
34.72
26.15

159.28
55.65
38.21
24.06

55.13
49.47
34.15
24.13
5115
1654
7.43
8500
55.87

BRAND
Model

Chipset

Features
Accessories/cables

Software Bundle

Specifications
Onboard Memory (MB)
Manufacturing Process (nm)
Core Clock Speed (MHz)
Memory Speed (MHz)
Memory Bus Width (bits)
Max Resolution
Compatibility (DX/OpenGL)

P.S./V.S. Version
Pixel Pipelines
Performance
3D - OpenGL
Doom 3
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
3D - Direct3D
Half-Life 2
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
Far Cry
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
Halo
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
3DMark 03 Scores (Default)
3DMark 05 Scores (Default)
Price Index 
Price (Rs)
Overall Score (Out of 100)
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MSI
NX6600GT

NVIDIA GeForce
6600GT
29.80
DVI to VGA
adapter, S-Video
to composite
cable, S-Video to
multi composite
cable

Game CDs, OEM
software, MSI
Utilities and
Driver CDs

128
110
500
1000 GDDR3
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
30.46

83.60
82.60
65.80
52.00

112.98
73.32
50.60
31.98

195.02
85.68
61.41
34.85

81.18
73.31
52.61
39.74
7570
2397
5.59
11300
65.85

MSI
RX600

ATi X600 XT

22.60
DVI to VGA
adapter, Power
cable

Game CDs, Driver
CD

128
110
400
700 GDDR1
128
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
4
14.02

41.30
41.30
26.80
14.90

67.38
42.71
25.47
17.63

131.46
30.46
20.14
12.80

34.13
30.22
20.16
14.33
3351
1362
8.77
7200
45.38

Sapphire
X700

ATi X700

22.60
ViVo cable, S-
Video to com-
posite cable

Game CDs,
Driver CD

128
110
400
700 GDDR1
128
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
8
20.99

63.70
63.40
41.90
29.50

88.04
53.91
31.35
22.86

140.30
49.48
32.68
21.76

75.62
57.65
39.44
26.49
4570
1591
6.31
10000
49.91

XFX
GeForce 6600

NVIDIA GeForce
6600
25.20
2 DVI to VGA
adapter, S-
Video to com-
posite cable

Game CD,
Driver CD

128
110
300
550 DDR
128
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
8
21.13

59.70
60.50
44.90
34.10

86.59
52.42
34.55
25.71

159.64
55.90
38.25
24.15

55.25
49.56
34.09
24.90
5131
1650
9.02
7000
55.34

XFX
GeForce 6600GT

NVIDIA GeForce
6600GT
25.20
2 DVI to VGA
adapters, S-Video
to composite
cable

Game CDs, Driver
CD

128
110
500
1000 GDDR3
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
37.83

121.20
121.00
88.80
64.60

119.78
88.96
67.97
54.45

197.57
106.39
71.26
52.32

86.07
86.22
59.23
43.18
8498
3611
5.26
12000
68.29

XFX
GeForce
6600GT

NVIDIA GeForce
6600GT
27.20
2 DVI to VGA
adapters, S-
Video to com-
posite cable

Game CDs,
Driver CD

256
110
500
1000 GDDR3
128
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
8
37.73

120.80
120.20
88.70
64.30

118.51
89.89
68.49
55.28

196.85
106.69
72.00
52.20

96.51
79.39
55.84
39.17
8520
3751
4.21
15000
69.14

ASUS
X800 XL

ATi X800 XL

29.80
2 DVI to VGA
adapters, ViVo
cable,  S-Video to
composite cable,
HDTV ViVo cable

Game CDs, Driver
CD

256
110
400
1000 GDDR3
256
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
16
26.61

107.90
107.50
76.10
54.50

125.95
91.25
71.92
58.93

207.18
103.65
67.93
49.37

98.94
96.30
66.64
48.40
8764
4309
4.51
30160
60.92

ASUS
X800 XT

ATi X800 XT

31.60
2 DVI to VGA
adapters, S-
Video to com-
posite cable,
Power cable,
WebCam

Game CDs, OEM
software, ASUS
Utilities and
Driver CDs

256
130
500
1000 GDDR3
256
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
16
31.00

120.60
120.60
93.00
67.10

123.89
91.51
80.38
69.63

208.00
135.67
91.65
65.98

128.50
113.82
81.19
54.06
10389
5529
3.34
40700
65.93

Gigabyte
X800

ATi X800

26.60
DVI to VGA
adapter, S-Video
to multi compos-
ite cable

Game CDs, Driver
CD

256
110
400
700 DDR
256
2048x1536
DX 9.0b/OpenGL
2.0
2.0/2.0
12
22.81

86.90
86.70
60.10
43.30

116.74
82.16
58.65
47.98

207.29
87.47
60.13
44.26

96.93
76.69
53.57
37.22
7599
3859
8.50
15990
57.91
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Scoreboard - High-End PCI Express Graphics Cards
MSI
NX6800GT

NVIDIA GeForce
6800GT
29.80
DVI to VGA
adapter, S-Video
extension cable,
Power cable

Game CDs, OEM
software, MSI
Utilities and
Driver CDs

256
130
350
1000 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
16
31.95

136.80
136.00
114.60
91.40

117.76
89.86
84.37
73.12

196.12
142.23
103.35
79.01

117.55
83.00
70.58
60.71
11524
4911
4.46
30500
66.21

PowerColor
X800 XL

ATi X800 XL

29.00
S-Video to HDTV
cable, S-Video to
composite cable,
S-Video to multi
composite cable,
Power cable

Game CDs,
Driver CD

256
110
400
1000 GDDR3
256
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
16
28.35

110.30
110.50
78.70
56.10

126.29
93.62
77.16
64.06

206.93
123.15
80.45
57.59

129.54
95.55
66.20
45.90
9468
4810
7.17
18950
64.52

PowerColor
X850 XT
Platinum
Edition
ATi X850 XT
Platinum Edition
29.80
2 DVI to VGA
adapters, S-
Video to HDTV
cable, S-Video to
composite cable,
S-Video to multi
composite cable,
Power cable
Game CDs, 
Driver CD

256
110
520
1080 GDDR3
256
2048x1536
DX 9.0b/
OpenGL 2.0
2.0/2.0
16
33.21

124.50
123.90
98.00
73.90

128.84
95.53
85.53
74.96

206.40
144.93
101.21
73.11

150.97
120.48
88.07
65.14
11267
5985
4.86
27950
67.87

XFX
GeForce
6800GT

NVIDIA GeForce
6800GT
30.80
2 DVI to VGA
adapters, S-
Video cable,
Power cable

Game CDs,
Driver CDs

256
130
350
1000 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
16
32.96

136.80
136.20
114.50
91.70

117.30
90.33
84.36
73.36

197.32
143.68
105.77
79.04

135.27
111.73
81.02
60.16
11524
4923
5.91
23000
69.67

XFX
GeForce 6800
Ultra

NVIDIA GeForce
6800 Ultra
31.80
2 DVI to VGA,
S-Video to
composite
cable, Power
cable

Game CDs,
Driver CD

512
130
400
1100 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
16
34.91

140.60
141.00
127.40
106.30

90.60
89.92
88.29
81.69

159.96
149.02
123.16
94.07

149.69
112.12
88.14
67.87
13143
5774
2.42
56200
69.12

XFX
GeForce 7800
GTX

NVIDIA GeForce
7800 GTX
30.80
2 DVI to VGA
adapters, S-
Video cable,
Power cable

Game CDs,
Driver CDs

256
110
450
1250 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
24
40.18

142.80
143.00
141.70
132.10

122.69
93.44
94.15
91.48

196.95
148.88
144.57
124.46

139.62
139.62
125.77
60.16
16649
7942
3.88
35000
74.87

ASUS
Dual VGA

NVIDIA GeForce
6800 Ultra
29.00
2 DVI to VGA
adapters, S-
Video cable, 2
Power cables

Driver CD

512
130
400
1100 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
16
39.65

137.50
137.20
132.70
122.90

115.67
87.64
86.67
84.83

189.78
143.60
138.03
117.60

159.05
116.26
115.73
97.76
18547
8745
2.25
60320
70.90

MSI
NX6800GT SLI

NVIDIA GeForce
6800GT
32.80
DVI to VGA
adapter, S-
Video exten-
sion cable,
Power cable

Game CDs,
OEM software,
MSI Utilities
and Driver CDs

512
130
350
1000 GDDR3
256
2048x1536
DX 9.0c/
OpenGL 2.0
3.0/3.0
16
40.49

138.50
139.10
136.40
128.60

115.76
86.72
87.13
85.14

190.65
143.83
139.92
122.10

160.36
124.21
119.11
100.44
19282
9045
2.23
61000
75.52

BRAND
Model

Chipset

Features
Accessories/cables

Software Bundle

Specifications
Onboard Memory (MB)
Manufacturing Process (nm)
Core Clock Speed (MHz)
Memory Speed (MHz)
Memory bus width (bits)
Max Resolution
Compatibility (DX/OpenGL)

P.S./V.S. Version
Pixel Pipelines
Performance
3D - OpenGL
Doom 3
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
3D - Direct3D
Half-Life 2
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
Far Cry
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
Halo
Normal (1024x768x32) (fps)
High (1024x768x32) (fps)
High (1280x1024) (fps)
Max (1600x1200x32) (fps)
3DMark 03 Scores (Default)
3DMark 05 Scores (Default)
Price Index 
Price (Rs)
Overall Score (Out of 100)

Extreme CardsSEPTEMBER 2005SEPTEMBER 2005
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Summing It All Up
The XFX video cards dominated the graphics cards comparison. We remem-
ber the time last year when XFX made its entry in our comparisons. It was
the underdog, and though it showed promise, could not make it to the big
league. This time round it took over the show and won four coveted awards,
which serve as a benchmark for you, our readers.

None amongst the opposition could stand up to the gauntlet thrown
by XFX. Solid build quality and extremely competitive prices made the
cards sure-fire winners, and so, this year concludes with XFX and nVidia
on top. ATi has a lot of catching up to do, and if the rumour mills are to
be believed, the R600 core is what we will be watching out for.

The next time round when we test graphics cards, we will surely be
seeing more of nVidia's SLI solutions, as prices are sure to plummet. ATi is
also set to bring out its own implementation of multiple-graphics-cards-
in-a-system solutions, known as Crossfire, which is touted to be even more
flexible than nVidia's SLI: here, you will not be required to have two ATi
cards of the exact same model, but you will be able to get away even if the
two are of the same series.

Until then, drive rashly, and go on a killing spree (disclaimer: we're
talking about computer games!!). 

bhaskar_banik@thinkdigit.com
jayesh_limeye@thinkdigit.com

SLI improves and scales gaming performance. But what if this could be achieved
using a single card? What if two GPUs are snug-fit onto a single card?
Remember the Obsidian X-24 in the 3DFX days, which had implemented SLI on

a single board with two Voodoo II chips on-board? The Asus Dual VGA 512 MB card
does just that. It is, in fact, a chip-level SLI implementation—two GeForce 6800
Ultra chips on a single card, eliminating the need to plug in two cards into two
different slots.

You will still need an SLI-capable
motherboard to use this card. On a non-SLI
motherboard, it will run as a single GeForce
6800 Ultra card.

Each of the GPUs gets only half the total
bandwidth and memory of the board, so the
256-bit, 512 MB memory runs as 128-bit 256
MB memory dedicated to two individual
GPUs—and hence is not as fast as a 256-bit,
512 MB memory should be. Hence
theoretically, in high-bandwidth situations
such as 16x AA and 16x AF, the GPUs should
become severely memory bandwidth limited.

We tried to test if this was true. At 1,600 x 1,200 in Doom 3, Half-Life 2 and
FarCry, the frames per second were 122.9, 84.3 and 117.6 respectively. The 3DMark
03 and 3DMark 05 scores were 18547 and 8745 respectively. This card thus
performs better than the GeForce 7800 GTX and a bit poorer than the GeForce
6800GT SLI solution in the 3DMark benchmarks, while in the gaming benchmarks
it comes third, behind the GeForce 7800 GTX and the GeForce 6800GT SLI— even
though this card has two GeForce 6800 Ultra chips onboard.

In a situation involving two GeForce 6800 Ultra cards in SLI configuration, this
dual-GPU card will fade into obscurity. Considering the price of Rs 60,320, this card
at this moment is not worth considering even if you happen to be the most
hardcore of gamers.

Asus Dual VGA/Dual GPU 6800 Ultra 512MB

Web siteCompany E-mailBrand

Contact Sheet Graphic Cards

ASUS
BIG
Gainward
Gigabyte
MaxForce
MSI
Sapphire
PowerColor
XFX

ASUSTeK Computer Inc.
Big Byte Corporation
Mediatech India
Gigabyte Technology (India) Ltd.
Maxtone Electronics
Micro-Star International
ATi Technologies
Mediatech India
Rashi Peripherals

022-56490048
022-23894800
022-26361111
91-22-26526696
022-23016468
011-51758808
022-252470085
022-26361111
022-28221013

Info_india@asus.com.tw
sales@bigbyteindia.com
digit@mediatechindia.com
sales@gigabyte.in
maxtone@vsnl.com
info@msi-india.com
vsingh@ati-india.net
digit@mediatechindia.com
navinderc@rptechindia.com

in.asus.com
www.big-tek.com
www.gainward.de
www.gigabyte.in
www.maxtone.com
www.msi-india.com
www.sapphiretech.com
www.powercolor.com
www.xfxforce.com

Telephone



Watch the telly like
never before… 
with LG’s new Wi-Fi
enabled LCD TV

Fed up of watching TV in your living room?
Hate the messy cable wires when you move

the telly in your bedroom? Well, bid your
miseries goodbye with the new LG 15LW1R, a
15-inch LCD TV enabled with Wi-Fi.  

It’s screen is pretty light at just four kg
and measures a mere 45 x 30 x 5.6 cm. It
supports S Video, Composite Video and has a
16 millisecond response time—fairly fast for a
TV. LG has lent it a really large 160-degree
viewing angle. It also has in-built speakers
which seem to be a bit low on power at three
watts each, but then you can always use a
pair of headphones and enjoy the audio!

All you need to do is connect every single
video input (from the cable wire to your DVD
set) to the base unit of the LCD TV, and set the
base unit in any place that catches your fancy.

This unit will then transmit all video feed to
the screen using Wi-Fi up to an enormous 115
feet—you can freely move the screen within
that area. Unless you live in a place that’s miles
away from civilisation, you can watch the TV in
any location of your house! Now that’s what we
call portable home entertainment!

Imaging Sivalal S

LG 15LW1R

DIGIT SEPTEMBER 200554
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Digital Passion l 30 days with...

Day 1: Bound by habit
About to leave for work, I automatically reached for my cellphone lying on the table along with the car keys. Just then,though, I realised this was the day I was to start learning to live without it.

Day 2: Aah! Peace!
No telemarketers urging me to avail of fabulous offers onpersonal loans or credit cards I didn’t need. No one callingto disturb me as I’m writing this! Even my wife can’t callme now when I’m on my way back from work. It feels good,you know! Freedom! I could get used to this!

Day 5: Missing it already
Almost a week has passed, and I’m still getting used to nothaving to carry around my phone wherever I go, compactand light as it may be. To think I even used to carry it withme to the bathroom so as not to miss any important calls—I’m actually wondering how on earth I’m getting used tonot having it!

Day 10: To buy or not to buyIt’s Saturday and I’m in the local market. For the life of me,I can’t remember whether it was cabbage or cauliflower Iwas supposed to get. No public phone nearby to call up themissus, so I buy both just to be safe.

Day 12: SMS Woes
Running late for office again... I hate Mondays! The alarmfeature in the mobile was really useful. Called up the boss toinform him I’d be late, and realised that an SMS wouldhave been a lot more convenient. Ah, my cell phone…

Day 15: MMS—a bane for celebs, a boon for the restof us
It’s a colleague’s birthday at work, and it’s time to cut thecake. How I wish I had my phone camera to capture his facebeing smothered with cake! Could have MMSed it straight

off to his girlfriend. And it’s oh so difficult to go get mydigicam now!

Day 20: Where’s my swiss army knife?With all my numbers just a keystroke away on my cellphone, I’ve suddenly realised it’s rather difficult to find aphone number now. Have to rely on the good old pocketdiary—I hope I’ve written it where it is supposed to be. Nowdid I classify that by first name or last name?Come to think of it, there was very little my cell phonecouldn’t do—from remembering phone numbers, remindingme about birthdays and tasks that needed to be done, andeven entertaining me with games and music when I wasbored. The GPRS I accessed at least gave me regular newsupdates. Am I missing out on life here?

Day 25: Stuck in a jam
Stuck in traffic and it’s getting really late. No way to get a message home and spare them the anxiety… I’m surethey would be worried by now. Wonder if I can borrow acell from the dude in the next car and call home... 

Day 30: Back to civilisationWell, it’s been an interesting month. It’s about time Irestored my cell phone privileges. I know it can be a littletroublesome at times, but the upside of carrying it along farexceeds the downside. 
It’s really something to be
able to reach your loved
ones wherever you (or
they) may be. The first
thing I do when I reach
office is message my wife
about my eventless drive
to work. Did I hear a sigh
of relief?

deepak_dhingra@thinkdigit.com

Deepak Dhingra 

In today’s age of always-on connectivity, the cell phone has become as ubiquitous as the desktop computer in an office.

So I decided to experiment and see what life would be like without my trusted mate. Here I’m sharing my 30-day tryst

with cellular disconnect. I couldn’t SMS or play a game anyway, so… 

My Cell Phone

Digital Passion l 30 Days Without...

Photograph Sandeep Patil Imaging Sivalal S, Akhilesh Prasad
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Take a Crack 
and Win
Enterprise Application
Architecture
By Joseph Moniz
Published by Shroff Pulishers &
Distributors Pvt. Ltd. 

Rules and Regulations
Readers are requested to send

in their answers by the 15th of
the month of publication.

Employees of Jasubhai
Digital Media and their relatives
are not permitted to participate
in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any damage
to your system that may be
caused while you are trying to
solve the problem.

Many of us have multiple
versions of Windows
running on the same
machine. Can you share
all your Outlook Express
data across these
different Windows
versions?
Write in with the subject
‘Take a crack’, and your
postal address, to
takeacrack@thinkdigit.com
with your solution

To make the safe mode boot
option appear every time
Windows starts up, use the
following steps.
1. In Windows XP, right-click
the ‘My Computer’ icon. 
Select ‘Properties’, and then
select the ‘Advanced’ tab.
2. Under ‘Startup and

Recovery’, click ‘Settings’.
3. In the ‘System Startup’
section, click ‘Edit’. The
‘boot.ini’ file will open in
Notepad.
4. Save the file as
‘boot_ini.bak’ as a backup
option in case something
goes wrong.
5. Now in the boot.ini file,
under [operating systems],
locate the operating system
entry that you want to boot
into safe mode, for
example, the second entry
as below:

[boot loader]
timeout=30
default=multi(0)disk(0)

rdisk(0)partition(1)\WINDOWS
[operating systems]

multi(0)disk(0)rdisk(0)
partition(1)\WINDOWS=”Wind
ows XP Professional”

/fastdetect
multi(0)disk(0)rdisk(0)

partition(3)\WINDOWS=”Wind
ows XP Professional

Safeboot”  /fastdetect
You can modify the entry

in the second line by adding
“Safeboot” after “Windows XP
Professional” to distinguish
between the two OSes.
6. In the second entry, after
“/fastdetect”, add the
following line:

/safemode:minimal /sos
/bootlog /noguiboot

The [operating systems]
section of ‘boot.ini’ file
should now look like the
following.

[operating systems]
multi(0)disk(0)rdisk(0)

partition(1)\WINDOWS=”Win
dows XP Professional”

/fastdetect
multi(0)disk(0)rdisk(0)

partition(3)\WINDOWS=”Win
dows XP Professional

Safeboot”  /fastdetect
/safemode:minimal /sos
/bootlog /noguiboot
7. The other Safe Mode
options are as follows:

Safe mode with
networking switch:

/safemode:network /sos
/bootlog /noguiboot

Safe mode with the
command prompt switch: 

/safemode:minimal
(alternateshell)/sos /bootlog
/noguiboot

Enable VGA mode switch: 
/basevideo

Debugging mode switch: 
/debug

Here, we have used only
the first mode—safe mode. A
combination of switches may
be used if required.
8. Save and close the file.
9. Click OK twice to exit

System Properties.
10. Restart the computer and
select “Windows XP
Professional Safeboot”
to boot into safe mode. (If
something went wrong—like
if you see an error message—
replace ‘boot.ini’ with the
‘boot_ini.bak’ file.) 

Share Outlook
Express across 
multiple versions 
of Windows in a
multi-boot system

THIS MONTH’S CHALLENGE

Make The Safe Mode Boot Option Appear Every Time Windows Starts UpLAST MONTH’S CHALLENGE

Win!

The boot menu shows the ‘Safe Mode’
boot option

Select the Advanced tab in System
Properties

Startup and Recovery Options

Samit Attawar
Flat No. 9, Varundev,
Nr. Standard Chartered Bank,

Opp. Benneton Showroom,
Main Avenue, Linking Road,
Santacruz (W),
Mumbai 400054

LAST MONTH’S WINNER

This solution will also be put up on
www.thinkdigit.com 
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Bhaskar Banik

Ninety per cent of computer users world-
wide start with Microsoft Windows
installed on their computers. Most users

today are actively involved with Microsoft prod-
ucts—using, developing or testing them. 

Though Microsoft’s software products are
easily the most popular, most users also face
issues with them on a regular basis. There are
system crashes, application issues and of course
bugs during coding. However, what most users are
not aware of is the dedicated group of Microsoft
Web sites that provide support for all its products.

Most users are also not aware that Microsoft
is generous enough to offer resources to the
public in general, irrespective of whether your
software is pirated or not. They provide immense
resources that can get you out of the stickiest of
situations. This article will walk you through the
Microsoft.com, and tell you about its support
Web sites for both users and developers alike.

Microsoft Support
Most of us have seen the “Blue Screen of Death”
at least once during the time that we have been

using our computers, irrespective of the flavour
of Windows used. Microsoft.com is the mainstay
for all your support related queries that you have
about your Operating System, (even the now
archaic Windows 98). 

The Web site looks a tad cluttered, but don’t
feel intimidated, all you need is a little patience.
Look for a heading called “Solution Centers” and
click on it. Here you will find ‘Solution Centers’
for all Microsoft products, including Windows
Media Player and the Xbox.

Let’s consider a situation where you get an
“Illegal Operation” error in Windows 98. To find
a solution for this, you can either
use Google, or you can visit
the Microsoft Web site
and paste these two
keywords in the box
called Search KB
(Knowledge Base). 

A better of
understanding
Microsoft.com
can give you the
edge you need 
to get ahead 
at work…

Microsoft To The Rescue

Digital Tools l Jumpstart
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Digital Tools l Enhance

or to learn more about it. This Web page layout
is the general pattern for most Solution Centers. 

If you use Microsoft’s products, you should
visit the Microsoft Support Web site regularly
for information and solutions to problems. Solu-
tion Centers are vast resources that will help
you utilise Microsoft’s software to its full poten-
tial, and only when you know your way around
a software like a professional, will you truly
‘enhance’ your ability. 

Microsoft Windows
To date, Microsoft Windows remains the
Operating System of choice for the masses.
Though most of us know our way around
Windows, first time PC users are still over-
whelmed when trying to use the software.
However, ‘Help’ is just a button click away—
“Press [F1] and all your questions will be
answered”, seems to be the Microsoft way. 

Every level of users, from the beginners to
the advanced will see various expensive books
that are targeted at enhancing your Microsoft
Windows skill-set, but none of them can top the
exhilaration and sense of achievement of self-
learning. Just visit http://www.microsoft.com/
windows and choose the version of Windows
that you want to know more about. The most

Remember, whenever you get an error it is
important to find the keywords present in that
error. For instance, a “Fatal Exception Error” has
the keywords “Fatal” and “Error” and using them
to search the Knowledge Base will provide you with
more valid and suitable results. Once you press
[Enter] after typing in the keywords, you will find
that you are presented with a long list of results.

Though you need to sift through the results,
the solutions are most often bang on target. 

We just used Windows 98 as an example, but
you can search for solutions for everything that
includes Microsoft Operating Systems, Office
Products and Development tools. 

Let’s take a look at some of the other Solu-
tion Centers. A large number of Netizens seem to
have trouble with Internet Explorer 6 the, let’s
check out Microsoft’s IE6 Solution Center.

Right on the first page, you will notice that
everything is arranged under separate headings.
There are ‘How-To’ articles, downloads and
updates for Internet Explorer, and of course,
troubleshooting instructions. In the left hand
pane, you will notice that there are different
topics that are related to using Internet Explorer,
while the right-hand pane contains information
about other Microsoft related products and sites. 

In short, this page is your one-stop resource
shop to nurse your ailing IE back to good health,

Use the Microsoft Support site to find solutions

Search through the Knowledge Base for relevant results

The Microsoft Knowledge Base has documented solutions for your use

Everything you needed to know about Microsoft Internet Explorer 6
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popular Operating System in use today is Windows XP, and if
you want to know more about it visit http://www.microsoft.
com/learning/centers/windowsxp.asp

Once the Web page loads, you will be surprised by the
amount of information that you have access to. You have free
access to the latest expert information in the Windows XP
Expert Zone, plus technical information using the Windows
XP Technical Resources. If you want more information regard-
ing training, or want to hone your career prospects using
Microsoft products as your weapon of choice, look at the
Microsoft Exam Guides. This will let you know what exams you
need to take for a particular career choice.

Informative FAQ’s are also available for beginners and
professionals alike to help you get a good perspective of what
you need to do to get ahead in the rat race.

In the Windows XP Expert Zone, you can get information,
insight and advice regarding everything about Windows. Top
Windows specialists get together on the forums to talk about
issues that users have with it. No, it will not bore you to death,
provided you have a genuine desire to know Windows inside out. 

Microsoft Office
The Microsoft (MS) Office Suite is the most used world-wide,
with Word, Excel and PowerPoint being the most used Office
applications. Though we have provided you with an entire
Fast Track book on the subject, free with the July 2005 issue of
Digit, you will find even more information at http://office.
microsoft.com/en-us/default.aspx—the beauty of using the

Some cool tutorials on Microsoft Windows XP

The Microsoft Windows XP Expert Zone
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Web as a tool for providing knowledge
resources, is that there are no limitations.

At the site mentioned above, you will get access
to tons of information that will keep you engaged
for hours, and help you understand how to get
more out of your Microsoft Office applications.

There is a lot that you can do on this Web
site: for instance, you can use the “Demos”
feature of the Web site to learn Office skills in a
jiffy. There are so many downloads for your
Office suite, such as Clip Arts (our favourite),
media, templates and more. In fact, there’s so

much available that you’re likely to run out of
hard disk space if you try to download them all! 

You can also suggest new Office online
content by sending feedback to the brains at
Microsoft, asking them to create more exciting
content for you. Another popular resource here
are the freely available update packages for all
versions of MS Office. If you are using an older
version of MS Office, you can also choose to
download a trial version of the latest release and
check out the new features.

A section called Work Essentials deals with
making MS Office work for professionals the
way they want it. There are other sections specif-
ically dedicated to provide information to varied
groups of professionals, from elementary school
teachers to real estate agents and travel and
tourism professionals. There is information for
everyone, and all you need to do is assimilate it
all to become an MS Office whiz.

Another very useful section is the Office
Assistance section. This section deals with the
utility part of Office, such as tips and tricks and
guides that will help you work better with MS
Office without any headaches. There is some-
thing for everyone in this section. For instance,
you can get the low-down on how to use water-
marks, or add music to your presentations, and
even stuff like creating flowcharts in Power-
Point. If there’s something you want to know
about Office, you will find it here!

Another interesting section is the “Office
Marketplace” where software from third-party
software developers are showcased. These soft-
ware cater to the wider range of needs by adding

Lesser-known Sites

We have mentioned some of the most
prominent Microsoft Web sites in the

article, but there are a few more portals
that might interest you as well.

Microsoft TechNet
(http://technet.microsoft.com/)
This site deals with core Microsoft
technologies, including product security,
and posts security bulletins at regular
intervals. This is the place where updates
and patches (or information about them)
for Windows make their first appearance.

MSDN Lab
(http://lab.msdn.microsoft.com/)
To put it in a nutshell, here’s what the
Web site has to say about itself: “The
MSDN Lab is a highly experimental place
where we can try something new, test out
beta applications, and most importantly,
gather feedback from the developer
community on potential new additions to
MSDN Online. Features which succeed will
hopefully migrate over to the ‘regular’
MSDN site. Less successful features will
be retired or revised.”

Microsoft Beta Testing
(https://beta.microsoft.com/)
Most people do not know about this 
Web site. It is meant for users 
that are interested in beta-testing
Microsoft products. The site is a secure
site (https), and you will need to
register with Microsoft to access it.
Whether your registration is accepted,
however, is solely at the discretion of
Microsoft.

Microsoft TechNet MSDN Labs Microsoft Beta Website

The Microsoft Office home page

Tips for using Microsoft Office better
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features or tools not already included in the MS
Office suite. These are generally available as
shareware or freeware downloads. 

Microsoft Downloads
Whether you want to update or patch your
Microsoft operating system and office suite, or
if you are a developer looking to get some
Microsoft tools, you will find them all at
Microsoft’s dedicated Downloads site.
Everything made by Microsoft, from DirectX to
Windows Media Player is available for down-
load at http://www.microsoft.com/downloads/

You can choose from various categories
including games, Office and home applications,
updates, drivers, and so on. We searched for, and
found, downloads for the latest version of
DirectX, SQL Server 2005 books, the Service Packs
for Windows 2000, and much more. 

So far we have only looked at user resources,
but there are also Microsoft resources for
coders. Programmers that use Microsoft’s
Development Tools can also benefit from
Microsoft’s online resources.

Microsoft Developer Network
The Microsoft Development Network (MSDN) is a
programmers Mecca, and every coder needs to
pay http://msdn.microsoft.com a visit if he or
she plans on a career as one. 

This site is not for the average user, and,
perhaps, should contain a sign that says, “Warn-
ing: geeky language ahead”. The page layout is
cluttered, as usual, as programmers have no time
or need for beautiful and well designed Web pages.

For the uninitiated, MSDN is the developer
network that programmers that use Microsoft
Development tools refer to for their program-
ming needs. MSDN is available as a subscription,
wherein you get exclusive information that adds

value to the products that you are already using
for development. As an MSDN member, you are
also privy to previews, betas and first-looks at the
latest versions of software.

MSDN now ships on DVDs, and contains
content that is exclusive to it’s members. Though
the MSDN Web site is exhaustive, there is a lot of
useful information available only on the DVD. 

In no way do we imply that the Web site
contains less critical information. For instance,
if you are new to programming, you can head to
the “Library” section to find content that will
help you get started with programming, using
illustrated examples.

You can visit the “Developer Community”
to get more information from other develop-
ers working with the same tools as you. You can
also watch Web casts and check for jobs at
Microsoft in the “Training, Career and Events”
section. In addition to all of this, there is a
Download section that offers developer tools
and resources such as code samples, SDK down-
loads and tools that integrate into other
Microsoft products.

There is a special section dedicated to MSDN
subscribers where they can download the latest
tools that are not available publicly—for instance,
the Windows Vista (formerly Longhorn) Beta 1 is
only available as a download to MSDN
subscribers. Developers and programmers should
head off there and get a copy right now!

Whether you are a first time PC user or a
seasoned programmer, there is a Microsoft Web
site that can help you do more with your PC. If
any of the sites mentioned in this article have
helped you in any way, do write in and share
your experience with us. 

bhaskar_banik@thinkdigit.com

Help for Microsoft Office users

Get some cool third-party tools for Microsoft Office

The Microsoft Download Center

MSDN: A programmer’s heaven
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epleting natural
resources have made
imperative the need for

conservation. An equally press-
ing need is that of finding new
sources of energy. With coal,
petrol, diesel, LNG and other
fuels becoming dearer every day,
every nation is striving to find an
oil well of its own.

These topics—petro-products,
LNG, and so on—are, therefore,
hot. A look at a Web site called
LNGjournal.com reveals that
there is also politics involved;
there are debates; there are inter-
national agreements. There is a
need amongst professionals in
the field to gather the latest
news and views, to gain insights
into what is going on in the
world as regards LNG, alternative
energy sources, and so on.

There are relatively few people
out there qualified and passionate
enough to make informed judg-
ments about what’s going on.
Kamlesh Trivedi is one of them.

Trivedi, basically a business
reporter, decided that since he had
the knowledge and the insights, he
could actually make a living off
what he knew. Thus began
LNGWorldwide.com, floated in
April 2004. It is one of the few dedi-
cated Web sites on LNG.

The Beginnings
Trivedi has been a business
reporter for more than 13 years
now. A graduate of St. Xavier’s
college (Ahmedabad), he
completed his masters in Econom-
ics from M S University of Baroda.
Trivedi’s first stint was with The
Financial Express, where he
dealt with corporate news
and finance. After moving
to The Economic Times in

mid-1995, he started covering the
energy sector.

“I realised that this sector had
tremendous potential. Baroda
houses the main office of the
Gujarat State Electricity Board,
and polymer production capacity
in and around Baroda is very high.
These factors increased my inter-
est in the subject,” recalls Trivedi.

His involvement with LNG
deepened when he joined Gulf
News as an energy correspondent
in early 2003. This gave him the
chance to be in the midst of the
action. He travelled extensively in
Oman, Iran, Kuwait, Qatar and
other Middle-Eastern countries.

An Online Cache Of LNG
A journalist took up the task of writing on all things LNG (Liquefied Natural Gas). He now has
a commercially successful Web site and global clientele to his credit
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com’s clients comprise five
Indian public sector units deal-
ing mostly in oil and energy, and
one American client. Talks are in
progress with two Indian private
sector firms. The Nuclear Ther-
mal Power Corporation (NTPC)
and Petronet LNG Ltd are part of
LNGWorldwide.com’s clientele.

An official from NTPC says,
“LNGWorldwide.com provides us
with exhaustive information
about recent developments in the
LNG space. The newsletter gives
detailed data on each country.
After receiving information from
them for a few months, we
decided to subscribe.

“Our fuel management group
makes the most use of the data we
get from this Web site. It gives us
a fair idea of the development
opportunities in local and inter-
national markets and the feasi-
bility of business expansion.” 

What’s In Store
The worldwide natural gas
market is growing fast. Trivedi
says, “The worldwide market for
natural gas is expected to
increase by 200 per cent by the
year 2010. There is a serious

shortage of reliable information
on the topic. With LNGWorld-
wide.com, we hope to bridge this
gap.” Trivedi also plans to start a
portal that deals with natural
gas in depth, not just LNG. 

“Currently, I am the only one
who writes the content. I need to
build a team to help me in this
endeavour. The problem is, there
are few people well versed with
the subject and who can also
write about it.”

Trivedi also hopes to tie up
with international news agencies
to help provide LNGWorldwide.
com with first-hand and privi-
leged information. Collaborating
with banks and financial institu-
tions to bring in funds is also on
the cards. So is getting investors
for the site to help him better
serve his clientele.

Like we said earlier, Kamlesh
Trivedi has capitalised on his
knowledge by taking it to the Web.
This goes to show that the Web is
not just a place to showcase one’s
talent—it’s also a place where if
you’ve got something that’s in
demand, you can make a viable
business out of it. 

preethi_chamikutty@thinkdigit.com

The contacts he established here
and the knowledge he gained laid
the foundation for the setting up
of LNGWorldwide.com.

Trivedi reflects, “I am passion-
ate about the subject. Moreover,
LNG holds a lot of promise for the
future as well.”

LNGWorldwide.com
LNGWorldwide.com is a dedicated
portal for the global LNG industry.
Apart from Trivedi, there are two
professionals from the Middle East
who have contributed substan-
tially towards the site. The site
offers weekly news round-ups,
trade summaries, interviews with
industry leaders, and information
on LNG producers, LNG consumers,
LNG marketers and other associ-
ated industries. There are also
comprehensive analytical reports
as well as summarised compila-
tions on LNG.

This information is privi-
leged, and is therefore available
only to subscribers, who pay an
annual subscription fee of $1,000
(Rs 43,500). Subscribers receive a
monthly newsletter.

“I started LNGWorldwide.com
once I had some time when I was
in between jobs. But now it is
something I love to do. It’s an
avenue for me to do what I want,
in the way I want, sans restric-
tions,” says Trivedi.

Growing Clientele
The four major oil companies in
the world are Shell, ChevronTex-
aco, ExxonMobil and Total. These
companies generally tie up with
other companies at the local level
in various countries.

Instances of such tie-ups
include Shell Hajira, Persian
LNG, and so on. Such are the
companies likely to be interested
in the information available at
Trivedi’s site.

Currently, LNGWorldwide.
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News, reviews, mods, links and
yes, games. Gamespot.com
offers this as the bare mini-

mum and any gaming aficionado can
find his daily ‘fix’ of gaming dope
right here. You could browse this site
for hours and still come back the next
day and discover something new.

Controls
True to the gamer’s choice, this site is
heavily infuenced with the colour
‘black’, and is peppered with bright
coloured fonts for a truly psychedelic
appearance. Other Web sites on
gaming such as Gamespy.com or
IGN.com come nowhere close to
Gamespot.com’s look-and-feel. 

Despite this, the site remains
clutter-free, thereby making surfing a
breeze. The navigation menu on the
left is extremely easy to access and
offers links such as ‘Join
Gamespot.com’, ‘Find Games’,
‘Gamespot Features’, ‘Game Hubs’
and more. 

Play!
Gamespot.com is a good source for
gamers to find information on new
games and even see previews of
upcoming games. Archives offer a
detailed look at older games—some
date back to a year. Games are
broadly categorised under ‘Action’,
‘Adventure’, ‘Simulation’ and so on. 

Daily fodder for the site (read
news) borders on ‘Breaking News’ in
most cases; otherwise, it’s the usual
‘top stories’. Gamespot.com is fairly
comprehensive in its coverage and
offers updates on PC news, Console

news and even Industry news.
Compared to the other gaming 
sites such as 3DGamers.com,
Gamespot.com’s  coverage of news
wins hands down. Score One!

What’s a game site without cheat
codes? Nothing. Thankfully,
Gamespot.com claims to offer up to
141,713 cheat codes to various
games—both, old and new. We
believe them (who’s counting them
all?). And yes, the usual downloads,
forums and updates are also scat-
tered across the site. 

Gamespot.com

But there’s a lot more to
Gamespot.com than news, cheat
codes and games. It also keeps up
with the latest developments and
reviews of the Xbox, PS2, Nintendo
DS and even PSP games. 

The site is replete with tips on
what works best with each console.
The tips have been effectively high-
lighted, and are easy to understand. 

Among the other popular attrac-
tions is a feature called ‘Button Mash-
ing’, where a general user is pitted
against the Gamespot.com team in a
game of the user’s choice. Another
feature, ‘On The Spot’ offers videos,
interviews and general discussions
about games. 

An interesting aspect is the ‘Beta
Test Center’—it offers readers an
opportunity to report bugs and
playability issues when a game is still
under production.

The site also has an active forum
that provides users with various
options to personalise their presence
on the forum. It helps them create
their profiles; they can have their
own blog in the ‘Journal’, keep a tab
on the games they have looked up in
the past, form groups of their own
and generally, chill out! 

The site is also your shopping
window for games. Finally, it’s all as
simple as this: find, read, understand
and if you like, you buy! They have it
all figured out! 

Mods And Expansion
Packs!
If there’s one thing users at
Gamespot.com must see, it would
undoubtedly be Gamespotting.
Trainspotting, you say? No…
Gamespotting. It’s a blog maintained

by the site’s editors
and lends insights
that are otherwise
‘edited’ in a review
or a news item. 

Now that makes
one wonder why not
put that up in the
review itself?
Anyway. Well,  game-
head, what are you
waiting for? You
know the URL…  

preethi_chamikutty@
thinkdigit.com

Hit CTRL+D if you are a hardcore gamer—your search for the definitive gaming site may have
just ended

Wanna know how a game plays on a console?

Compete with the Gamespot.com team here

The all encompassing home page of Gamespot.com Watch live videos of games ‘On The Spot’
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Your Digital Camera Does Not
Get Detected
Problem: Sometimes, in Windows XP or
other operating systems, your digital
camera does not get detected as a
device attached to the computer.

Solution: Here’s a brief list of what you
can do to troubleshoot this situation.

Under Windows XP, a digicam should
get detected quite easily, but with older
OSes, you should connect the device and
install the drivers and software exactly
in the order specified in the manual.
Uninstall the software and drivers and
try doing it again, paying attention to
the order of events.

Make sure your OS supports the
devices—some devices are incompatible
with certain OSes. For example, the
JDC15 digicam does not work with
Windows 95 or 2000.

First switch on the camera before
plugging it into the USB port on the PC.
Failing that, Windows may be unable to
properly recognise the device or drivers.
If the camera is not turned on before
plugging it in, the camera might be
detected as an Unknown Device.

Turn the camera off and then
on again.

Try setting the camera to ‘image
viewing mode’.

Check the USB cable connection.

Check that the USB port is working
fine. Attach something else to the port,
such as a mouse or a scanner.

Connect the camera to a different
computer and check.

Reinstall the WIA or TWAIN drivers

for the camera. If you don’t have them
on your computer, you can probably
download them off the manufacturer’s
Web site.

Finally, try this: if the camera can
record images to a removable memory
card, use a memory card reader to
transfer the files to the computer. If you
can’t transfer the images from a
memory card, the memory card may be
the cause of the problem. If you can
transfer the images from a memory
card, it may be the camera that is 
at fault.

Images Are Blurred
Problem: Images can turn out blurred
for a variety of reasons. These include
inaccurate focus, camera shake, or a
dirty lens.

Solution:
Inaccurate focus: This may happen if

you don’t hold the shutter release
button halfway down until the picture is
taken. Or, you may be focusing and then
changing your distance from the subject
without refocusing. Change these habits.
Use the ‘Focus Lock’ feature if your
camera has it, and then ensure that your

distance from the subject
does not change from the
time you lock focus until you
take the image.

If you’re using an auto-
focus system, you may have
trouble focusing when there
is not much colour difference
between the foreground and
background; in front of or
behind bars, such as a cage
or railing; on shiny and
opaque surfaces; and on
subjects photographed
through glass.

Camera shake: Shaky
hands are bad news when
you’re using a digital camera.
Practise holding the camera
steady in a relaxed but
controlled posture, and press
the shutter release with
steady, gentle pressure.

Your elbows must be held
firmly against your body, to
ensure that the hand holding
the camera is steady. However,
a posture that is too rigid may
also cause your body and the
camera to shake.

For exposures slower than
1/30th of a second, use a
tripod, or set the camera on a
sturdy surface. In addition,

use a cable release or remote
control to avoid shaking the

Digital Cameras
Facing trouble with your digicam? Whether it’s making the digicam work in sync with the PC
or fungus on the lens, read on for help

The correct way to hold a camera: arms tucked in, with one
hand supporting the camera while you click with the other
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camera during exposure. 

A dirty lens: Blow and brush off the
debris with an air brush. Then clean the
lens using a photographic microfibre
cloth or a photo cleaning solution and
photo lens wipes.

Lens Fungus
Problem: If you live in a humid region—
which is the case in most of India,
especially in the rainy season—moisture
trapped inside the camera provides a
good environment for fungus to grow,
causing cloudiness and vein-like
patterns to form in the lens.

Solution: Don’t leave your camera in a
camera bag when you’re not out
shooting. Store it in a cool, dry place.
Keep your camera and lens in an airtight
container with some bags of silica gel-
these will absorb moisture. Make sure to
change the bags regularly.

If you go out shooting in the cold,
wrap your camera in a plastic bag before
bringing it into a warm room to prevent
moisture from accumulating inside 
the camera.

If fungus has already formed, 
you’ll have to get your lens cleaned.
Leaving your lens in the sun won’t solve 

the problem. Send the
camera to 
the manufacturer or a
repair shop for a
professional cleaning.

You Deleted Your
Photos By Mistake!
Problem: This is self-
explanatory—you pressed
the ‘delete’ button on your
digicam by mistake, and
now all your photos seem
to have disappeared.

Solution: You may indeed
be able to recover your
photos. It’s not 100 per
cent guaranteed, but it
could be that the photos
just aren’t getting
detected, and are still
there on the memory card.

You can try and use
various software to
recover the pictures. But
remember not to format
the card or take any more
pictures before you
recover the images you
seem to have lost.

Software to recover
images from a memory
card include the
following:

Zero Assumption Digital Image
Recovery 1.2

MediaRecover 3.0
MediaSaver 3.0.7.1
Digital Photo Recovery 2.0.3

Your Batteries Don’t Last
Long Enough 
Problem: Of course, battery life varies
depending on the make and model of
your camera, but you know you have a
problem when even brand-new batteries
afford just a few shots.

Solution: Use the correct AA cells (if

your camera uses these). Alkaline AA
cells last much less than rechargeable
NiMH cells or disposable lithium cells. If
you find a specialty store which gives
you cells of different mAh ratings, look
for higher mAh ratings. As an indicator,
1850 mAh is good. Look for 1850 mAh 
or higher.

However, if your camera works on a
Li-ion cell and was installed with a
rechargeable one when you bought it,
and it’s still giving short battery life
even on a full charge, there’s something
wrong with either the cell or the camera.
Take them back to the store.

There Are Dark Specks On Your
Photos
Problem: You might notice that after you
changed your SLR’s lens, your photos have
brownish or blackish specks on them. This
could happen if dust settled on the sensor
when you changed the lens.

Solution: As always, there are two
solutions: give the camera for
professional cleaning, or clean the
sensor yourself. Of course, you need to
remember that if you’re cleaning it
yourself, you’ve got to be very, very
careful. This is because sensors are
covered by protective glass—and if you
end up scratching the glass, your
warranty will not help.

You can try and use cleaners made
specifically for cleaning sensors.
Companies such as Photographic
Solutions make them. Also, Kodak sells a
sensor-cleaning kit while providing
detailed instructions on how to clean
Kodak sensors.

If you’ve decided to clean the sensor
yourself, get the camera into sensor-
cleaning mode so the sensor is exposed.
You’ll need to check your manual for
how to do this with your model. Remove
the lens. Use a bulb blower to blow dust
off the sensor—and while you’re doing
this, make sure you hold the camera
such that the dust falls away and doesn’t
settle back on the sensor.

Carefully swab the surface of
the sensor’s protective glass.

Once you’re done, click
a picture of a white wall,
for example. If you haven’t done
the cleaning perfectly, some
dark specks will still show up.

VisibleDust
(www.visibledust.com) has
products to help you safely clean
your digicam’s sensor. L. L. Rue
(www.rue.com/cleaning.html)
has cleaning aids for all kinds of
photographic equipment, 
and they also feature a large
bulb blower. Check it out! 

ram_mohan@thinkdigit.com
MediaRecover has an easy interface that helps you
recover lost pictures from your memory card

Shaky hands here. Can you even make out the street lights?

Shaky hands can give a poor motion-like effect to your pics

Tech Nightmare
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Convergence, also, has play-
ed a role in reducing the
number of peripherals you had
to connect just to accomplish
simple tasks such as printing or
scanning documents. Enter the
Multi-Functional Device—earlier
the jack of all trades, and now
master of all too!

Communication
Whether it is businesses
exchanging e-mails across the
world, or the person sitting next
to you at work sending you a
joke about the boss in the form
of an IM message, it’s all
communication.

The largest library in the
universe, the Internet, is based
on communication; the lowest
common denominator of tech-
nology, e-mail, is also based on
communication.

Again, we know this...

The PC is powerful, and
combined with a worthy tool such
as a basic MFD, can do a lot more
than we allow it to. Most of us
never use our PCs to their full
potential. For example, we still
have fax machines in our offices,
which print a lot of junk faxes on
expensive fax paper. Why?

Fax
Though there may be hundreds
of similar or even better software
available today, WinFax was once
the most popular fax software. In
the time of modems, not too
long ago, WinFax saved us many
a pretty penny on fax paper and
even fax machines! 

Modems were then a must,
and 56.6k voice, data and fax
modems were the in thing. Since
you needed a phone line and
modem to connect to the Inter-
net anyway, spending a little

Robert Sovereign-Smith

he PC has come a long
way over the past decade
or so. What started out

as a glorified calculating
machine and word processor
has now taken over our lives. 

And in no place is this more
evident than at work. A lot of
SoHo setups will not be able to
function if you take away the
computers. So many business
opportunities have sprung up
just because of the PC!

But we know all this...
What we don’t realise is that

some uses of the PC have been
forgotten. Modems, for instance,
are no longer used by most busi-
nesses in cities, thanks to
increasing broadband penetra-
tion—indeed, Internet connec-
tions are mainly LAN-based now. 

T

COMMUNICATE
BETTER
A PC can do so much more for your office than just run accounting software—
combined with an MFD, it can take care of all your communication requirements!

Digital Tools l Smart SoHo

COMMUNICATE
Imaging Pradip Ingale
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Voice Communication
Most modems available for the
past five years have been voice,
data and fax capable. If you use a
headphone and microphone
combination headset, your
modem can eliminate the need
for phone extensions altogether. 

Though it sounds easier to
just give everyone a phone, you
will have to spend money on
buying an EPABX that has voice-
mail and other advanced
features built-in. Majority of the
people would rather invest in, or
have already bought, a very basic
EPABX system that only allows
you to transfer calls.

Using your PC, you can set up
a call centre-style phone and
voicemail system—and that too
for free!

There are plenty of fax and
voice-mail or answering mach-
ine software available for free for
Windows. The advantage of soft-
ware-based answering machines
is that each person can specify
individual actions for incoming
calls. Some software also allow
you to ignore calls from specific
numbers, and are even
customisable to the extent of
having different voice-mail
announcements for different
groups of numbers.

So, say you’ve stored phone
book entries in the software, and
have a caller ID. It may sound
stupid to use the standard “Leave
your name and number” message
for recognised users. Instead, you
can use a different message—such
as “Hi, I’m busy right now, but I
have your number and will call
you back ASAP!”

The options are numerous,
and the beauty of the system is
its customisability on a per-user
basis. So each user can record his
or her voice-mail message and
have individual-specific rules.

And of course, all this works out
a lot cheaper than buying an
advanced EPABX that costs over a
lakh (and is not as customisable).

Sure, there are some draw-
backs, such as having to keep the
system on in order to use the
phone extension, but most of us
have our computers booted up as
long as we’re in office anyway! 

Some may even prefer to put
existing modems to use in
conjunction with the standard
phone to get the best of both
worlds—when you receive a call,
use the phone; when you’re
away, the computer answers the
call using voice-mail!

Other Communication
Your PC is already equipped to use
other forms of communication,
such as e-mail and video confer-
encing. Services such as Skype
(www.skype.com) and efax
(www.efax.com) have made it easy
to make long-distance phone calls
and faxes respectively, for cheap,
using the Internet. 

If your business needs you to
frequently make calls or send
faxes abroad, you should seriously
consider using these services. Even
individuals can save a lot using
such services.

For SoHo businesses, costs are
always important, and each
penny saved is a penny earned.
Yet you have to keep up the
impression of being a profes-
sional company, no matter how
small your business is.

We hope some of the hints
provided here can help you do just
that, and we look forward to hear-
ing about your personal experi-
ences. Write in and let us know! 

robert_smith@thinkdigit.com

extra and buying WinFax, and
getting fax ‘send’ and ‘receive’
capability as well, just seemed
logical. In fact, since it was made
by Symantec, the makers of
Norton Antivirus, it gained the
trust of many people in India!

The beautiful part was that
you could preview faxes on your
computer screen and choose
which ones to print and which to
delete. Zero paper wastage, and
no important documents being
printed on that horrid fax paper. 

There are probably many
of you who have cursed the
fax paper’s short lifespan—
pull out a file of faxes after about
six months, and all you see is
blank paper! WinFax let you use
your little inkjet printer to
print faxes for storage—this was
probably its biggest selling point
back then.

Today, however, we have fax-
enabled MFDs. These MFDs print
faxes on normal paper, and are
even capable of storing up to a
couple of hundred faxes when
paper runs out. In addition, some
MFDs allow you to fax a docu-
ment right from within the docu-
ment’s software itself, so even
the prints of faxes to be sent are
not needed—this means more
paper saving!

Those SoHo offices that do
not want to buy an MFD, but still
want a fax alternative and the
savings it brings, can opt for soft-
ware such as WinFax. 

However, even though it does
the job perfectly, keep in mind
that the last release of WinFax
was in 2001, so you might want
to try other products as well. 

If you run Windows XP, you
can use its inbuilt fax capabil-
ity—all you need is a modem and
a printer. You can download a
detailed ‘how to’ at
http://snipurl.com/61p4.

MightyFax, available at www.rkssoftware.com, is a simple
and easy-to-use fax software alternative

WinFax Pro is a Symantec product, and
was once the most popular Fax
software for Voice/Fax/Data modems

Software such as CallCenter (www.v3fax.com) allow you to
add voice-mail and an answering machine to your basic
phone setup, so you never miss another call again, and also
have customised voice-mail messages for each employee
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Speed Up Firefox’s Initial
Load Time

On Windows XP, Firefox
could be slow to load

initially. You might be able to
speed this up a bit by using
XP’s inbuilt prefetcher.
Simply right-click the
shortcut icon you use to start
Firefox. Add the text
“/Prefetch:1” to the end of the
line in the ‘target’ field.
Then, the whole line should
look something like this:
“C:\Program Files\Mozilla
Firefox\firefox.exe” /Prefetch:1

The Config File
You can change many
more things about

Firefox than what is provided
in Tools > Options. Simply
type in “about:config” in the
address bar, and a whole
bunch of configuration
settings appear. Right-clicking
on a value’s name will allow
you to modify the value by
pressing ‘Modify’ and
entering the new value.
Some entries in the
configuration file are
intuitive; some are not.

Just look at the entire set
and you’ll be able to decide
for yourself what you feel like
changing. For example, scroll
down to “browser.download.
manager.closeWhenDone”,
and it’ll be pretty obvious to
you what that setting does.
Similarly, “browser.formfill.
enable” is another setting
whose purpose you can guess.

Tune Up Firefox
Go to http://www.
totalidea.com/

freestuff4.htm to download
FireTune, a free tune-up and
tweaking utility for Firefox.
From the page: “According to
your computer’s speed and
Internet connection speed,
FireTune will optimise several
internal settings of Firefox for
better performance. FireTune
does not modify the Firefox
executable... Everything can
be undone easily provided
you saved your original
profile configuration file.”

Control Where Links Open
You can control where
new links are opened

from other applications. For
example, say you’re browsing
a page using Firefox, and you
switch to your mail program.
There’s a new mail with a link
to a page your friend told you
to check out. When you click
it, it will open in either a new
window, a new tab or the
most recent tab or window. To
choose between these three,
go to Tools > Options >
Advanced > Tabbed
Browsing. Under ‘Open links
from other applications in:’,
choose between ‘a new
window’, ‘a new tab in the

most recent window’, and ‘the
most recent tab/window’.

Opening Firefox In
Safe Mode

If something goes
wrong with a new

extension or theme you
installed, you can start
Firefox in Safe Mode. In Safe
Mode, Firefox does not load
any extensions, and comes
up with the default theme.
This way you can uninstall
the offending extension or
theme and get things back
to normal.

To enter safe mode, go to
Start > Run, and type in the
following: “C:\Program
Files\MozillaFirefox\firefox
.exe” -safe-mode

Of course, if Firefox is
installed in a different
folder, enter the path to that
folder instead.

How To Not Save Form
Information

As you browse, Firefox
keeps a history of what

you enter in fields such as
search forms. If you don’t
want it to do this, go to Tools
> Options, and click the
‘Privacy’ icon on the left. Go to
‘Saved Form Information’ and
deselect the box that says
‘Save information I enter in
Web page forms and the
Search bar’.

Smart Keywords
Smart Keywords are an
easy way to search Web

sites right from the location
bar. Say you visit IMDb (The
Internet Movie Database)
often to look up things. You
go to imdb.com and click in
the search box and enter
whatever you’re searching for,
and click ‘Search’. There’s
a simpler way to do this
in Firefox.

With an IMDB Smart
Keyword, you can type “imdb
Star Wars” into Firefox’s
Location bar and hit [Enter],
and be taken right to
the result.

Go to whatever site you
want to add a Smart Keyword
for, then go to the search box.
Right-click in the search box
and click ‘Add a Keyword for
this Search...’ The ‘Add
Bookmark’ dialog will appear.
Give the bookmark a name,
e.g. ‘IMDB Search’, and create
a keyword, e.g. ‘imdb’. File
the bookmark wherever you
want. Click ‘OK’.

Now, enter “imdb Star
Wars” into the location bar
and press [Enter] and see
what happens!

You can repeat these steps
for any searches you use—
Amazon, your corporate
phonebook, an online
thesaurus—any site at all!

Add New Engines
Up in the top right
corner of Firefox, there’s

Firefox
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a handy search box that puts
search engines at your
fingertips. When you
download Firefox, some
searches such as Google,
Yahoo!, and eBay are included,
and you can easily add more.
There are hundreds of search
engines available. Some of the
most popular are A9,
AltaVista, AskJeeves,
IMDb, Merriam-Webster,
and Wikipedia.

To add a search engine,
click on the current icon in
the box, then click ‘Add
Engines...’. You’ll be taken to
Mozilla’s page for available
engine plug-ins. Simply follow
the directions on the page,
and your engine will get
added instantly for you to use.

Add Google Desktop
Search To The Engine Box

Go to www.amwmedia.
com/?nId=17. If you use

Google Desktop Search (GDS),
you’ll want the plug-in
available here. It allows you to
add GDS as one of the search
engines. Additionally, this
little plug-in will help you get
around the current 10 results
per page that GDS imposes.
Simply follow the directions
on the page to install GDS
into the search box.

Remove Engines From The
Engine Box

Go to “C:\Program
Files\Mozilla

Firefox\searchplugins” (or
wherever Firefox is installed).
Each engine you have installed
has two files—a .src file and
either a .png or a .gif file. All
you have to do is delete the
two files for the engine you
wish to remove—for example,
google.src and google.gif.
Close and restart Firefox for
the change to take effect.

The Google Toolbar For
Firefox

Google recently released
their Google Toolbar for

Firefox, and if you’re a fan of
Google and use its services for
almost everything, you may
want to install it. Not only
does the toolbar allow you to
search through Google’s
various search engines, it also
comes with auto-fill
functions, Froogle searches,
dictionary and stock

referencing, the page rank
feature, and more. The
toolbar even integrates with
Blogger, and offers some basic
translation features.

Get it at http://toolbar.
google.com/firefox/. 

Installation is simple,
and it works like any other
Firefox extension.

Live Bookmarks
Live Bookmarks in
Firefox let you view RSS

news and blog headlines in
the bookmarks toolbar or
bookmarks menu. With one
glance, you can quickly see
the latest headlines from
your favourite sites. You can
go directly to the articles that
interest you, which saves 
you time.

A site is enabled for Live
Bookmarks when you see an
orange RSS icon on the
bottom-right corner of the
browser. Clicking on the icon
and selecting an RSS feed will
bring up the ‘Add Bookmark’
dialog. Select ‘OK’ and you
will see Live Bookmarks with
the rest of your bookmarks.
You may find it especially
convenient to save Live
Bookmarks in your
Bookmarks Toolbar folder.

Add Live Bookmarks
Manually

Some sites don’t tell
Firefox that they

support Live Bookmarks, even
though they actually do. If
you know the URL of a site’s
RSS feed (the URL will end
with .rdf or .xml), you can
manually create a Live
Bookmark for the site. Go to
the Bookmarks menu and
select ‘Manage Bookmarks’.
Under the ‘File’ Menu, select
‘New Livemark’. Create a
name for the Livemark and
add the URL. New articles
from that site will appear as
Live Bookmarks in Firefox.

A Firefox Tab-Switching
Shortcut

Did you know there’s a
keyboard shortcut to

switch between tabs in Firefox?
Simply type in [Ctrl] + [#],
where [#] is the tab number (so
it’s 1 for the first tab, 2 for the
second, and so on). This only
works with up to nine tabs,
but that’s probably enough.

Scripting Errors
If you get errors on Web
pages, or it they’re

displayed in a weird way, it
could be a scripting error.
Opera uses Netscape features
by default; it doesn’t run
JScript but JavaScript instead.

You can force Opera to
behave like Internet Explorer
while viewing Web sites. Press
[F12] to get the Quick
Preferences pop-up and select
‘Identify as Internet Explorer’. 

The Autofill feature
Opera allows you to fill
up standard information

such as your name, address,
phone number, e-mail address,

etc. without having to type
these in every time. Open
Tools > Preferences, click on
the ‘Wand’ tab, and fill out all
the details. To enter the
information into a text box on
a Web page, right-click the
text box, go to ‘Insert
Personal’, and choose the text
you want to input.

Always Start Browsing
With The Same Set
Of Pages

If you always start
browsing with the same

two or three pages, there is a
way of always opening Opera
so that those pages open
automatically. Right-click the
Opera desktop shortcut and

select ‘Properties’. After the
text already there, which
simply tells the computer
where Opera can be found,
just add your pages, thus:
“http://www.thinkdigit.com”
“http://www.thinkdigit.com/
forum” “www.cnn.com”
“www.opera.com”—making
sure to leave a space between
each page address, and
making sure each page is
enclosed by double quotes,
not single quotes.

Clear The Cache With
A Single Click

To insert an item in the
right-click menu to

delete the contents of the
cache, find and open the
‘menu.ini’ file and search for

the following lines in the
[Browser File Menu] section: 
Submenu, 162000, Quick
Preferences Menu = Show
popup menu, “Quick
Preferences Menu”
Item, 50394 = Show
preferences, -1

Here, add the line:
Item, 54493 = Delete
private data

Save and close the
menu.ini file.

Enable Scrollbar Colours
To enable colours in the
scrollbars, add the

following lines to opera6.ini
in your profile folder:
[User Prefs]
Enable Scrollbar Colors=1

Opera
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With cell phones getting smarter,
it has never been easier to

customise them to match your
persona or mood. And the wallpaper
and screensaver you use—whether on a
PC or a cell phone—are a statement
about yourself. Here’s a little
workshop that tells you how to
customise your cell phone’s
screensaver or wallpaper.

What you need
You need a phone with a colour
screen, and it should allow you to set a
GIF file as a wallpaper or screensaver.
You can find out about this from the
manual. You also need a software with
basic photo editing capabilities, for
example IrfanView, which is what we
are using here. You can download it
from www.irfanview.com.

The other software you’ll need is
one that can string individual GIFs
together to create the animation. For
this, we will be using a freeware called
Windows GIF Animator, which can be
downloaded from www.idp.net/
freesoft/gif_anim.asp

Assimilating The Images
Take a stack of pictures you’d
like to include in the

animated GIF (henceforth AGIF) file.
Since most digital cameras take
pictures in the JPEG format, you’ll
need to convert them to GIF.

Converting The Images
Open IrfanView and go to File
> Batch Conversion. Here, in

the conversion window, navigate to
the folder where your images are, and
select the ones you’d like to use. Make
sure that at the bottom of the dialog,
‘Batch Conversion’ has been selected
as the job description.

Set an output directory, and set
the output format to GIF. Now just
click ‘Start’.

Cropping The Images
You’ll now need to resize the
images to fit your phone’s

screen. Find out the screen size from
the manufacturer’s Web site or from
the manual. But anyway, most phones

have a square screen with a resolution
of 128 x 128, and that’s what we’ll be
assuming here.

Open your converted images one
by one in IrfanView. Left-click each
picture, holding and dragging the
cursor to create a box. If you hover at
the edges, you’ll get the option of
resizing it. The objective is to get a
square cut-out from the image. Most
cameras do not take square photos, so
you’ll have to do this yourself. Take as
big a cut-out as you’d like, as long as
it’s square.

Once you’re satisfied with the
results, go to Edit > Crop Selection,
and your image will get cropped to the
desired size. Do this with all the
images and save them as GIFs.

If all your images are centred on
the same point, and you want to
create an animation, you can use
IrfanView to batch-crop all the
images. Go to File > Batch
Conversion/ Rename… and there,
check ‘Use advanced options’. Then
press ‘Set advanced options’. In the
‘Set for all images’ dialog that comes
up, under ‘CROP’, you can specify
what you want to do.

Of course, if you do not have a
square screen at all, you’ll need to
modify the selection area accordingly.

Resizing The
Images
Once you have
all the images
cropped to the
desired
dimensions,
you need to

scale them to fit
the phone.

Doing this is pretty easy with
IrfanView—simply open the Batch
Conversion window as explained
before, and select all the cropped
images for resizing.

Check ‘Use advanced options’, and
under ‘Set advanced options’, check
the box called ‘RESIZE’. Select ‘Set
both sides to’, and set the sizes to
whatever your screen resolution is—in
our case, 128 x 128 pixels.

Click ‘Preserve aspect ratio’, and
check ‘Use Resample function’ if you
are particular about image quality.
Click OK. We can now proceed with
creating the AGIF.

Creating The Animation
Open Microsoft GIF Animator
and click ‘Open’. Navigate to

your images folder, and add one of
them. Once you’ve added the first one,
simply keep clicking ‘Add’ until you’ve
added them all.

The Effects And Settings
You can give individual time
intervals to the images by

selecting the image and clicking the
image tab on the right. If you want to
apply the same effects to all images,
click the button on top, so you can
edit the properties just once with
them getting applied to your
animation throughout.

Under the ‘Animations’ tab, you
can also set the number of times you
want the animation to loop.

Once you’re satisfied, save the file.
Upload it to your phone using
Bluetooth, infrared or a data cable) and
set it as your wallpaper or screensaver.
Show it off to all your friends! 

varun_dubey@thinkdigit.com  

Creating An Animated GIF Screen Saver
For Your Cell Phone
With the increased usage of feature-rich cell phones, customisation has become
top priority. Here’s how you can distinguish your cell phone from all others

Batch convert images to save time

Select only what you want
using the Crop option Use the same settings for all images

Digital Tools l Tips & Tricks
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Bring Up The Main Menu
By Pressing A Key

To have the main menu
(File, Edit, View, and so

on) accessible through a
single key rather than at the
top of the browser: in
opera6.ini, under User Prefs,
type in:
Show Menu = 0
Then edit input.ini:
[Application]
F10 = Show popup menu,
“Browser Menu Bar”
This will bring up the menu
with [F10].

Make A URL Accessible
With Two Clicks

Say you want to add an
item to the right-click

menu that will open
www.thinkdigit.com/forum.
In menu.ini, under
[document popup menu],
type in:
Go to page,
“http://www.thinkdigit.com
/forum”

Easy Page Navigation
In the toolbar.ini file,
add the following lines

to the [Document Toolbar]
section:
Button2, “Top”=Go to start, ,
, , “View to””
Button3, “End”=”Go to end, ,
, , “View from””
This will give you an easy
way to scroll to the bottom
or top of a page.

Load Multiple URLs From
A Text File

If you right-click on the
Opera icon and go to

Properties, the ‘Target’ line
reads something like
“C:\Program Files\Opera8\
opera.exe”.
You need to change this by
adding whatever URLs you
want to open, so that it reads
something like
“C:\Program Files\
Opera7.20.3nnn\opera.exe”
http://www.opera.com
http://www.google.com

If you save this line as a
batch file (opera.bat), you’ve
set up a shortcut to the
desktop that just needs to be
double-clicked.

Mouse Gestures
Because of the sheer
number of mouse

gestures available in Opera,

they may take some time
getting used to, but will
greatly enhance your
browsing experience once
you’re used to them.

Here’s a sampler of what
you can do with the mouse
in Opera.

To go to the previous page:
hold right button and click
left button OR
Hold right button and move
the mouse left

To go to the next page:
hold left button and click
right button OR
Hold right button and move
the mouse right

Fast forward (Go to the end
of the list of pages visited):
Hold right button, move the
mouse right then up OR
Hold right button and [Shift],
move the mouse right

Rewind (Go back to the
first page visited): Hold right
button, move the mouse left
then down OR
Hold right button and [Shift],
move the mouse left

Go to home page: double-
click in an empty page

Reload page: hold right
button, move the mouse up
then down

Stop loading: hold right
button and move mouse up

Restore or maximise page:
hold right button, move the
mouse up then right

Minimise page: hold right
button, move the mouse
down then left

Close page: hold right
button, move the mouse
down then right OR Hold
right button, move the
mouse right-left-right

Open link in a new page:
move mouse pointer to link
and hold right button, then
move down

Open link in a new page in
the background: move mouse
pointer to link and hold
right button, move down
then up

Zoom in and out: hold
[Ctrl], roll mouse wheel up
or down

Restore default zoom: hold
[Ctrl], click mouse wheel

Move back and forth in
page history: hold [Shift], roll
mouse wheel up or down

Cycle through open pages:
hold right button, roll mouse
wheel up or down

Open a blank page: hold
right button, move the
mouse down

Dragging And Dropping
Dragging a link to the
bookmarks panel or a

toolbar saves it as a
bookmark.

Dragging a bookmark to
the workspace or Web page
area opens the bookmark.

Tabs can be rearranged
by dragging them on the
page bar.

Notes can be dragged
into e-mail messages for
automatic pasting.

Drag a download link to
the transfers panel to start
downloading.

Keyboard Shortcuts
Copy selected text to
the ‘Notes’ panel:

[Ctrl] + [Shift] + [C]
Copy text in clipboard to

the ‘Notes’ panel:
[Ctrl] + [Shift] + [V]

Save page address as new
bookmark: [Ctrl] + [T]

Save as new bookmark in
active bookmark folder:
[Ctrl] + [Shift] + [T]

Reload page:
[Ctrl] + [R] OR [F5]

Reload selected frame: [Alt]
+ [F5] OR [Ctrl] + [Shift] + [R]

Reload all open pages:
[Ctrl] + [F5] OR
[Ctrl] + [Alt] + [R]

Go to next page in history:
[X] OR [Ctrl] + [Right Arrow]
OR [Alt] + [Right Arrow]

Go to previous page in
history: [Z] OR [Backspace]
OR [Ctrl] + [Left Arrow] OR
[Alt] + [Left Arrow]

Rewind (Go to the first
page visited): [Shift] + [Z]

Fast Forward (Go to the
end of the history list):
[Space] OR [Shift] + [X] OR
[Shift] + [Backspace]

Load and display all
images: [I]

Toggle loading of images:
[Shift] + [I]

Full Screen: [F11]
Close active application

window: [Ctrl] + [Shift] + [W]
OR [Alt] + [F4]

Close all open pages:
[Ctrl] + [Alt] + [W]

Close all open pages except
the active one:
[Ctrl] + [Shift] + [Alt] + [W]

Undo closing of page:
[Ctrl] + [Alt] + [Z]

Switch to next page on
page bar: [1] OR [Ctrl] + [F6]

Switch to previous page on
page bar: [2] OR [Ctrl] + [Shift]
+ [F6]

Activate panels for
keyboard navigation: [F7]

Open the ‘Search’ panel:
[Ctrl] + [1]

Open ‘Bookmarks’ panel:
[Ctrl] + [2]

Open ‘Mail’ panel:
[Ctrl] + [3]

Open ‘Contacts’ panel:
[Ctrl] + [4]

Open ‘Chat’ panel:
[Ctrl] + [5]

Open ‘Notes’ panel:
[Ctrl] + [6]

Open ‘Transfers’ panel:
[Ctrl] + [7]

Open ‘History’ panel:
[Ctrl] + [8]

Open ‘Links’ panel:
[Ctrl] + [9]

Open ‘Windows’ panel:
[Ctrl] + [0]

Close Opera: [Ctrl] + [Q]
Hide Opera: [Ctrl] + [H]

Access Your Gmail In
Eudora

You may want to access
your Gmail mails in

Eudora, or send mails
through your Gmail account
from Eudora. To do this,
you’ll first need to enable
POP access in Gmail. Here’s
how: first, choose ‘Settings’
from the top Gmail
navigation bar. Select the
‘Forwarding and POP’ tab.
Make sure that either
‘Enable POP for all mail’ or
‘Enable POP only for mail

Eudora

Some Shortcuts
If you copy a Web address to
the clipboard, just press
[Ctrl] + [D], with the Opera
window in focus, to go to
the address.

You can press [Ctrl] +
[Tab] to cycle through your
open pages (tabs).

Close the active tab by
pressing [Ctrl] + [W].
Press [Shift] while clicking
to open a link or bookmark
in a new page.

If you press [Ctrl] +
[Shift] and click a link it will
open in a background tab.

Bet You Didn’t Know
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If you are trying to learn HTML, or
are new to building Web pages, we

have just the thing for you! In fact,
even if you find HTML easy enough to
do it in your sleep, you should still go
through this workshop—the software
we’re talking about here will let you
update your pages so quickly that
you’ll need to work while you’re
awake as well!

The options this software offers
are so many, a full book could be
dedicated to it. Here, we’ll walk you
through some of the features and
leave you to explore and play with the
software yourself.

What you need
The software you need is called
NoteTab Pro. It can be downloaded
from www.notetab.com. You can try
it free for 30 days, after which it costs
$19.95 (Rs 870).

Easy Interface
Once you start the software,
you will be presented with an

interface that looks like a cross
between Microsoft Word, Opera and
Explorer. You have formatting buttons
on the top, the various options (such
as HTML, CSS etc.) at the bottom, and
what’s more, you can open multiple
files in different tabs just like
Firefox—the best of all worlds!

Writing The Code
To create HTML, select ‘HTML’
from the drop-down menu on

the left, or from one of the tabs at
the bottom. The options and
commands in the left pane will
change accordingly.

To start creating a Web page, click
on ‘New Web Page’ on the left, and

you’ll be presented with a template
wizard that will let you select the
basic properties of the page—such as
the title, description, keywords, etc.
Once you’re done with that, you will
be presented with another window
that will allow you to set things such
as the background colour, text colour,
link colours and more. You can even
include a background image.

Creating Content
On closing the window, you
return to the code screen

where a part of the code is
highlighted as “Type Content Here”.
In that area, you can put whatever
you want to appear on the page, and

it will conform to the formatting
done in the previous windows.

There is even a spell-checker
coupled with a dictionary to ensure
you don’t have any misspelled words
going out to the world!

Other Options
If all you want is a basic Web
page, you are all set, since

your page is already set up. You can
view it in a browser by pressing [F8].

You may, however, want to include
tables, image place holders, anchors,
etc. For all these, you simply need to
click on the left pane, and a wizard
will open. This will guide you
through the process as before.

The wizards are pretty exhaustive,
and very rarely will you require any
further tweaking.

CSS
As your skills develop, you’ll
realise it is downright silly to

give every image or text line
individual formatting, especially if
most of them have to be similarly

formatted. The rescuer here would be
CSS (Cascading Style Sheets).

These are basically sheets that
have ‘classes’, where each class
represents a specific kind of
formatting—for example, font type,
font size, font colour, link colour,
etc.—and all you need to do is
include the style sheet referrer in the
HTML page and use the classes before
text. This, you will realise, will cut
down your page size by at least half
if not more!

You can have two kinds of style
sheets—embedded and external.

Building A Web Page Using NoteTab Pro
Learn about one of the easiest ways to build Web sites—both, for beginners
and experts alike...

NoteTab’s Default Screen

Type the page content in the highlighted area

Create your style sheet using the wizards in
the left pane

Set the text and link properties using
this window
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The external style sheet is
something you will create as a
separate file and then link it to your
Web page. An embedded style sheet
is, as the name goes, embedded in
the Web page, and this software will
let you create one with a wizard as
usual. It’s highly effective and
accurate; however, you do need to
have some degree of coding
knowledge for this.

Simply click on the CSS tab at the
bottom, and then on the left pane,
click on ‘New Webpage’, and then on
‘Embedded Style’.

If you already have a page open,
simply click on CSS, and then on
‘Embedded style’ to add it to your
page. To add various properties,
simply click on them on the left
and then follow the wizard yet
again—and you’ll be done in no
time flat.

Uploading Your Web pages
Once you’re finished with
the various settings, text

and the style sheet
implementations, it’s time to
upload your page for the world to
see it. NoteTab Pro will let you
upload the file from within the
program. You simply need to
configure the FTP settings.

Click the ‘FTP’ tab at the bottom,
and then on ‘Server Setup’.

Again, you will be presented
with a window asking you for the
various settings for your server.
Enter these settings and you’re on
your way to uploading your Web
pages—but this is where we hit upon
a snag in the software.

Note that you’re provided with
the server settings when you sign up
for Web space, or if you are hosting
it on a free server such as Geocities,
the settings would probably be in

the confirmatory email they send
you. In its free avatar, Geocities does
not support FTP.

When we clicked on ‘Upload’, we
were presented with a wizard as
before, but at the bottom where we
were supposed to enter the files to
be uploaded, we just got a blank text
box expecting us to type in each file
name! This is a serious shortcoming
in an otherwise brilliant piece 
of software.

Apart from the glitch in the
FTP aspect, this software will let
you do almost all kinds of HTML
coding including CSS, and is an
extremely powerful tool even if
you swear by Dreamweaver.

NoteTab Pro is lightning fast, and
produces excellent results with just
a few clicks.

If you want to learn while you
make Web pages, this is the software
that will let you do it!

Of course, there are tons of other
features—find them for yourselves
right away!

Adding Images
Adding images takes a single
click, which gets you to the

now familiar options menu where
you can specify the alignment,
borders, spacing as well as an
alternate text.

Frames
Although we do not
recommend the use of

frames in your Web site, due to
compatibility issues across
browsers. However, if you choose to
use frames, this software will help
you tremendously. You can create
frames at the click of a button, and
the options available are amazing.
You can create an iFrame (a frame
containing dynamic content) or

even specify what the browser
should display when it does not
support frames.

Creating Forms
If you would like to get
feedback or conduct a survey,

the best solution is to use a form.
This software excels in this

regard, and the drop down menus
take away the need for coding
knowledge—just pick and choose
whatever is required.

You can configure the Input type,
the default text in the box as well as
the name of the box (very important
in form submission)

It will also let you change the
input type from a box to a radio
button, or even a check box! All with
a couple of clicks, 

HTML Cleanup
What’s more, if you mess
up with the code, the

software can fix it automatically.
There is a single click option called
“Clean Up HTML” which cleans up
any un-ended or orphan, and
empty or redundant tags, which
ensures better compatibility
across browsers.

Apart from the glitch in the
FTP aspect, this software will
let you do almost all kinds of
HTML coding including CSS,
and is an extremely powerful
tool even if you swear by
Dreamweaver. NoteTab Pro is
lightning fast, and produces
excellent results with just a few
clicks. If you want to learn while
you make Web pages, this is the
software that will let you do it! 

varun_dubey@thinkdigit.com  
You upload using the inbuilt FTP program,
you need to enter the file names manually Create Frames using NoteTab Pro

Embedding images into a web page was never
so easy
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that arrives from now on’ is
checked. (Choose ‘Enable POP
for all mail’ if you want to
download mail previously
received at your Gmail
account, or select ‘Enable
POP only for mail that
arrives from now on’.) Select
the action you want applied
to mail after you have
downloaded it to your e-mail
client under ‘When messages
are accessed with POP’.
Finally, click ‘Save Changes’.

Now that you’re done
with the Gmail settings, it’s
time to configure Eudora to
send and receive mail
through Gmail. Select Tools
> Personalities from the
menu in Eudora. Right-click
in the ‘personalities’ window
and select ‘New...’ from the
context menu. Choose ‘Skip
directly to advanced account

setup’, then click ‘Finish’.
Type in “Gmail” under
‘Personality Name:’. Type
your name under ‘Real
Name:’. Type your Gmail
address under ‘E-mail
Address:’. Type your full
Gmail address again under
‘User Name:’. Type
“smtp.gmail.com” under
‘SMTP Server:’. Make sure
‘Required, Alternate Port’ is
selected under ‘Secure
Sockets when Sending’.

Go to the Incoming Mail
tab. Type “pop.gmail.com”
under ‘Server:’. Make sure

‘POP’ is selected under
‘Configuration:’. Make sure
‘Required, Alternate Port’ is
the ‘Secure Sockets when
Receiving’ choice. Click OK.

Add An Animation To
Your Signature

To add an animation to
your signature, you

first need to know how to
create a new signature in
Eudora. Here’s how: select
Tools > Signatures from the
Eudora menu. Right-click
anywhere inside the
signature window. Select
‘New...’ from the context
menu. Enter the name of the
new signature. Click ‘OK’.
Type in your signature text,
and select File > Save.

Now, to animate your
signature, you’ll need to use
an animated GIF. First, create

a new signature. Type your
signature text. Make sure you
use some HTML formatting
in it somewhere so Eudora
adds the necessary HTML
code. It’s enough to boldface
a few characters. (You can
remove the formatting later.)
Hit [Ctrl] + [S]. Find and open
your Eudora folder in
Windows Explorer. Go to the
Sigs directory. Double-click
the (signature_name).txt file,
where ‘signature_name’ is
whatever name you gave
your signature. Edit the file
to include <img src=”{path

to your animated gif}” />,
where you want to place the
image. (Make sure “{path to
your animated gif}” points
to the animated gif and
follows this format:
“file:///C:/Documents and
Settings/...”.

Save the text file. Try
the new signature. Don’t
be alarmed if the animation
disappears shortly after
showing up in the signature.
It will display for
the recipient.

Do Complex Searches
Eudora provides a
whole lot of search

criteria for mail. If you
explore the first drop-down
menu in the ‘Find Messages’
dialog, you will see criteria
from ‘Age’ to ‘Priority’ and
from ‘Attachment Name’ to
‘Personality’. For more
complex searches, you can
try and combine two or
more criteria by clicking on
the ‘More’ button, and
selecting either ‘Match All’
or ‘Match Any’. 

Using this, you can
construct searches
combining up to five criteria.

Clear The Ads Cache
Sometimes, Eudora for
Windows in sponsored

mode may complain that it
isn’t getting ads. To correct
this, you can try clearing
Eudora’s ad cache.

Eudora keeps the ads in a
directory called ‘Ads’ in the
‘Eudora’ folder. First, close
Eudora. Then go to your
‘Eudora’ folder. Open the
‘EudPriv’ folder there, and
then the ‘Ads’ folder. Delete
all files in the ‘Ads’ folder.
Finally, restart Eudora—
the problem should
have vanished.

Customise Eudora
Message Labels

Eudora has a great
feature called Message

Labels that lets you quickly
assign a colour and a label to
messages. By default, these
labels are called ‘Label 1’
through to ‘Label 7’.

You’ll probably associate
more with something like
“to do” than with “Label 1”,
and you can change the
Eudora labels to suit your

needs. To customise the
message labels in Eudora,
select Tools > Options... from
the menu. Go to the ‘Labels’
category. Type in the desired
name of the label in the
entry field. Then click on the
coloured box to open a
colour selection dialog
where you can assign any
colour to your label.

Empty Trash Upon Exit
To have Eudora empty
the trash when you exit

the application, go to Tools >
Options, then to the
‘Miscellaneous’ category.
Make sure ‘Empty Trash
when exiting’ is checked,
and click ‘OK’. Keep in mind
that all messages in the
trash will be deleted and
purged—and therefore,
permanently lost—whenever
you exit Eudora!

Identify Your
Eudora Folder

You probably will need
to know, at some point

or other, where Eudora
stores your mails. Here’s how
to find the folder: on
Windows 2000 and XP, go to
Start > Run. Type in
“%appdata%\Qualcomm\Eu
dora” (without the quotes).
Hit [Enter] and you’ll be
taken to your Eudora folder.

If that doesn’t work,
search for ‘eudora.ini’ on
your computer. If you get
only one result, the folder
containing ‘eudora.ini’ is
your Eudora folder. If there
are multiple folders
containing ‘eudora.ini’,
you’ll have to open them all
to identify ‘your’ Eudora
folder. Look for .mbx files
and .fol folders that match
your setup of mailboxes
in Eudora.

Insert Recipients Quickly
If you have added the
people (or lists) you

send e-mails to most often to
the Recipient List in Eudora,
you can use one of the fastest
ways to address a message.
Using the mouse, you can
add recipients to mails,
forwards and replies easily
and quickly from the Eudora
Recipient List. To insert
recipients quickly and
comfortably using the mouse
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in Eudora, start with a new
message, forward, or reply.
Click in the To:, Cc: or Bcc:
field to put the cursor in it.
Click with the right mouse
button. Select Insert
Recipient > [recipient]
from the context menu
that comes up.

Make A Filter From
A Message

Filters that
automatically sort

incoming mail are very
useful, and they’re best set
up from existing messages in
Eudora. To create an
incoming mail filter from an
existing message in Eudora,
first highlight the message
in the mailbox. Select
Special > Make Filter from
the menu. Enter details as
you see fit. You can filter on
the sender (it’s best to look
for the e-mail address only),
any recipient or (part of)
the subject.

By default, Eudora
suggests you create a new
mailbox named after the
sender that the filter will
move all mail to in the
future, but you can also
have it transfer messages to
any existing mailbox (to
select it, click the ‘In’
button), or delete them
automatically. Finally, click
‘Create Filter’.

Adding A Background
Image

A white background all
the time for your e-

mails may become boring. To
add a background image to a
message in Thunderbird,
first create a new message.
Select Options > Format >
Auto-Detect from the
message’s menu. Click in the
message body. Select Format
> Page Colors and
Background... from the
menu. Click ‘Choose File...’
under ‘Background Image:’.
Select the desired file and
click Open. Click OK.

Add OpenPGP
E-mail Security

Plaintext e-mails are
like postcards.

Everybody can read what
you send and receive.

Cryptography is the
solution, and ensures that
only the intended
recipient can decipher your
message. Thunderbird comes
with great inbuilt support
for S/MIME. But OpenPGP
is the rivalling standard,
and you can add support for
it easily.

There’s something called
Enigmail out there, which
works with Mozilla
Thunderbird, Netscape and
Mozilla, and supports both
PGP and GnuPG as its
encryption backend—

providing comfortable
message security. Enigmail is
easy to use, and works
transparently and with per-
account settings. It doesn’t
interfere with, but
complements Mozilla’s
S/MIME support.

The latest version is
0.92.0, which works with
Thunderbird 1.0.x. Visit
http://enigmail.mozdev.org/d
ownload.html to download
and install it.

Compose Mail From The
Address Book

To compose a message
from the Address Book

in Thunderbird, select
Window > Address Book
from the menu. Highlight
the entry you want to
compose a message to, and
simply press [Ctrl] + [M].

Create A Filter From An
Existing Message

Filters that move all mail
from a certain sender to

a special folder are extremely
useful—to have the really
important and the not-so-
important e-mails sorted out
right away and automatically—
and in Thunderbird, they are
extremely easy to create, too.
To create a filter from an
existing message, open the
message either in the preview
pane or in its own window.
Click on the sender’s name or
e-mail address. (In either case

the thing to click is the
highlighted text following
‘From:’.) Select ‘Create Filter
from Message...’ from the
menu. Select your desired
action under ‘Perform this
action:’. Click OK.

As an alternative to using
the sender’s context menu,
you can select Message >
Create Filter from Message...
in the Thunderbird menu.

Create A Mailing List
Using Cc: or Bcc: is
usually OK, but using a

mailing list is easier and more
elegant. Thunderbird includes
support for simple mailing
lists. To set up a mailing list in
Thunderbird, select Window >
Address Book. Click on ‘New
List’. Specify which address
book the list should be added
to. Give the mailing list a

Name, Description and
Nickname. Start adding
addresses by typing them in
the list one at a time. Close the
dialog and click OK.

Export Contacts From
The Thunderbird
Address Book

Thunderbird makes it
easy to export your

address book to a format that
most, if not all, other e-mail
programs can understand. To
export contacts from the
Thunderbird Address Book,
select Window > Address
Book. Highlight the desired
address book in the Address
Books list. (If you are not sure
which to select, choose
Personal Address Book.)
Select Tools > Export... from
the menu. Make sure
‘Comma Separated (*.csv)’ is
set under ‘Format:’. Choose a
location and filename, and
click ‘Save’.

Train The Spam Filter
Thunderbird, as well as
Netscape and Mozilla,

have great spam filters. The
Bayesian spam filter in
Thunderbird identifies spam
by calculating for each
incoming message how
likely it is junk. These
calculations are based on
how you have classified
previous messages.

This means Thunderbird
can make a very good guess
on what your spam and your
good mail looks like. It also
means that you have to train
the spam filter a bit so it can
get an idea what you
perceive to be spam.

To train the spam filter
in Thunderbird, open a
message you want to classify
as junk and click the ‘Junk’
toolbar button. Alternatively,
click in the ‘Junk Status’
column in the message list.
Either action will toggle the
junk status of the message.
You can use it to mark junk
not yet recognized by
Thunderbird, but you can
(and should!) also use it to
reclassify mail that has been
wrongly labelled spam.

Once you find the spam
filter classifies mail
satisfactorily, you can have it
move spam to a special
folder automatically. 

Thunderbird
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Too Much RAM?
I have a P IV computer that I bought in 2002. My
problem is that all of a sudden, my PC displays

a blue screen and it restarts by itself. I don’t know
what to do. Recently, I installed a 128 SDRAM module
on top of the existing 128 MB SDRAM module. Is the
problem due to the RAM?

Tenzin Sherab, Manali

There is a good chance that the new RAM
module you installed is faulty, or incompat-

ible with the motherboard or the older RAM
module, or both. You’ll need to get the new RAM
module replaced. Take your old RAM
module to the vendor from whom you
bought it and ask him to replace the new
RAM with one similar to the old RAM. 

I Can Watch But Can’t Catch!
I have an Intel Celeron 1.2 GHz, 256 MB
RAM, a 60 GB hard drive and a Frontech

TV-Tuner card. The TV playback of the card is
smooth enough. But while recording, many
frames are lost in the DVD quality. As a
result, the quality of recording is poor. How
can I ensure best quality?

Mahesh Bandekar, via e-mail

The system configuration you
mention is more than enough to view TV

using a TV-Tuner card. But it is not enough to
record live TV in DVD quality. You can record in
MPEG-1 file format (VCD quality) without drop-
ping a frame, but if you try to record a MPEG-2
file format (DVD quality), you will drop a lot of
frames and the resulting captured file will be of
bad quality. 

If you wish to record in MPEG-2 format, you
should consider upgrading your hardware to at
least a 2 GHz processor from Intel or a 2000+
processor from AMD. To capture in MPEG-2 with
really good quality, you will require a TV-Tuner
card with hardware MPEG capture capability,
such as the ones from Hauppauge.

Power Trouble?
My PC’s configuration is as follows: an AMD
Athlon 64 3000+, an Asus K8N4E Deluxe

nForce 4 chipset-based motherboard, XFX GeForce
PCX 5300 PCIx16, a Tricom 450 watt, iBox i612
Standard ATX, a Seagate 80 GB 7200 rpm SATA hard
drive and Windows XP Professional SP2. 

The problem arises when I start playing games
like Call of Duty or Prince of Persia—Warrior Within.
It runs fine initially, but after playing for 10 to 15
minutes, the PC hangs and restarts. 

I have checked the CPU and motherboard
temperatures—they were stable at 48 and 46
degrees Celsius respectively. All overclocking
options are disabled and there is no overclocking. Is
there a problem with my power supply? I’d asked my
vendor for a genuine 400 W power supply. He
recommended the Tricom 450 W, and I purchased it.

Devadatta, Bhubaneswar

Install DirectX 9.0c on your PC. Install the
latest versions of nForce4 chipset, nVidia

graphics and AC’97 audio drivers for your moth-
erboard. Install the latest hotfixes for Windows
XP SP2. If the problem persists, your RAM is the
probable cause. This is more likely if there is a
slight mismatch in the RAM modules in the dual-
channel configuration. 

To figure out if this is the case, remove one of
the RAM modules and try playing the game to
see if it works. If it doesn’t crash, the problem is
with the mismatched memory modules. If the
problem persists, there could be some heating
issues with your processor. You can’t always
depend on the motherboard’s temperature

sensor to report the correct temperature at
all times.

More For Less?
Using my Windows 2000 bootable CD, I
can install Windows 2000 Professional,

Windows 2000 Server and Windows 2000
Advanced Server. When I checked the size of
the disk by right-clicking the CD drive icon, it
was around 450 MB. But when I tried to copy
it to my hard disk, it took around 1.5 GB. 

I’ve also come across some 770 MB VCDs,
although the normal disk capacity is 700 MB.
How we can one write more data on a CD than
its pre-defined capacity?

Prasad V Nair, Trivandrum

Some data CDs are created in such a way
that although the total size of the data on

each may far exceed the normal capacity of a CD
(which is 700 MB, and may sometimes even cross
1 GB), the CD properties still show the CD’s size
to be well within the limits. 

This is achieved by a special method of CD
image creation wherein identical files appearing
multiple times in the CD compilation are stored
as a single file with different entries in the file
allocation table of the CD. This way, multiple
identical files that are seen to occupy multiple
times the size of the file actually occupy only the
space of a single file. There are various tools
available to create such images, including
UltraISO at www.ezbsystems.com/ultraiso.

A Useful Dump
When memory dumping happens, ‘.dmp’ files
are created. Can you tell me how to open

these files to know the reason of the dump?
Adesh Kumar, via e-mail

Your Questions, Our Answers
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Memory dump file creation is a very useful
diagnostic tool in Windows systems based

on NT. A memory dump is an output file gener-
ated by the OS during a crash, and is useful in
determining the cause of the crash. It is saved as
a file with the .dmp extension in the ‘System32’
directory inside the ‘Windows’ directory. 

To set up this option, open ‘System’ in
‘Control Panel’, navigate to the ‘Advanced’ tab,
and click ‘Settings’ under ‘Startup and Recovery’. 

The dump file can be analysed using a tool
from Microsoft known as dumpchk.exe. You can
download it from http://snipurl.com/gzel.
Different versions of the tool are available for
different versions of Windows. Detailed informa-
tion about using dumpchk.exe can be found at
http://snipurl.com/gzf8. 

BIOS Upgrade Needed
I have an Intel P III 450 MHz (Katmai)
processor, Intel (i440BX/ZX-SMC60X rev. C1,

Intel 82371 (PIIX4) rev. C1) Chipset, Inno3D
GeForce4 MX 64 MB, 128 MB of RAM, a
DVD/CD-RW, Windows 98 SE, and a 20 GB
hard disk. I have the following questions:
1. Can I use a P III 1 GHz Processor with this
chipset? Is there some other fast processor
that I can use with this chipset? 
2. How can I upgrade my BIOS? I have the
Award 4.51 P-03/01/99 BIOS. I am unable to
install Windows XP. Is this a BIOS problem?
Does this BIOS support only Windows 95/98?
3. While burning CDs, disk finalisation fails,
and the disk becomes unusable. Why is it so?
I can play games like Call of Duty, NFS Hot
Pursuit 2 and GTA Vice-City on my PC, and
they run very well.

Zaif Khan, Delhi

Unfortunately, you will not be able to use a
1 GHz P III on your board—the board simply

does not support that processor. You can upgrade
your BIOS by downloading the latest BIOS and
BIOS flashing utility from your motherboard
manufacturer’s Web site. 

The Award 4.51 BIOS has certain limitations.
When a hard drive larger than 33.8 GB is
attached, the system hangs during Power-On Self
Test. But you should be able to install Windows
XP even with this BIOS.

CD burning can fail during finalisation for a
variety of reasons—due to faulty media or a
faulty writer. Try using different media. Use a
cleaning CD to clean the lens of your CD-Writer—
dust may have accumulated over it. Try burning
at lower speeds.

Missing Music
My system configuration is a P IV, an Intel 845
motherboard, and 256 MB of DDR RAM running

Windows XP. Whenever I try to open Windows Media
Player, I get the following error: 
“winplayer.exe - ENTRY POINT NOT FOUND
The procedure entry point ASFSend Time To Time
could not be located in the dynamic link library
WMASF.DLL”

It’s only recently that I’ve started experiencing

this problem. I’ve tried to restore the system to an
earlier date, but the problem persists. What is
the solution? 

Prof Sanjay S Patil, Ratnagiri

You need to reinstall Windows Media
Player. Go to Control Panel > Folder

Options > View and set it to ‘Show hidden
files and folders’. Uncheck ‘Hide protected
operating system files [recommended]’ and
‘Hide extensions for known file types’. Now,
open the Windows Explorer and go to  the
‘C:\Windows\Inf’ folder, find the file
‘wmp.inf’, right-click it and choose ‘Install’.

You will need to either insert your
Windows XP CD or know where the i386
folder is located on your hard drive. You may
also need to know where the
‘ServicePackFiles’ folder is (it’s usually under
the Windows directory) if you’ve installed a
service pack. If your Windows directory is
‘C:\Windows’, then the service pack files are
in ‘C:\Windows\ServicePackFiles’.

Icons For CDs
How do I assign an icon to the CD-R/RW
while writing it, so that when I put it into

the drive the icon appears at the place of the
CD drive in ‘My Computer’?

Ajay Bhushan, via e-mail

The icon displayed in ‘My Computer’
when some CDs are inserted into the

CD drive is due to the Autorun feature of
the CD. The root of an Autorun CD
contains a file ‘autorun.inf’, which is an
instruction file associated with the func-
tion. This file has a syntax, and a simple
autorun.inf file looks like

[autorun]
open=autorun.exe
icon=autorun.ico

Here, ‘autorun.exe’ is the executable file
that is launched when the CD is inserted, and
‘autorun.ico’ is the icon file that gives the CD its
icon. Sometimes, an executable file or a DLL that
might contain an icon is also used instead of an
icon file. You may also try a freeware Autorun
file editor such as the one from
http://autorun.moonvalley.com if you want to
play around with Autorun files.

I Lost My Password!
I use MS Office 2000 on my computer. I
created an MS Word file and saved it with

password protection. I’ve forgotten the password.
How can I open the file?

Vikram Dan, Barmer, Rajasthan

To recover the password of an MS Word file,
download software such as the Word

Password Recovery from Interlore
(http://snipurl.com/gzf0) or the Passware Word
Key (http://snipurl.com/gzey). 

A fast processor enables quick recovery of
the password. Short passwords are easy to
recover, but longer passwords may take days
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Overclock your graphics card

Varun Dubey

So you got yourself a spanking new
graphics card and were excited
about playing the latest games at

the highest resolutions—only to find it
faltered while running a low-end con-
figuration of Doom 3? If that made you
give up on your card, you might as well
risk overclocking it to see if you can get
that last bit of speed out of it.

What You Need
In this workshop, we tell you how to go
about overclocking your nVidia card
using a simple utility called nVHard-
Page and enabling some hidden menus
in the default driver’s menu for the
card. You can download nVHardPage
from www.guru3d.com/nvhardpage/

Running The Software
The software does not require
any installation. Simply navi-

gate to the folder where you unzipped
the files, and find a file called ‘nVHard-
PageSE’. Running the file will present
you with a tweaking menu.

The default screen shows the system
configuration including those of the
graphics card, the CPU and the OS.

The Software Interface
At the top, you’ll notice icons
for nVidia (card), DirectX and

OpenGL, and an icon comprising two
speedometers, which stands for the
inbuilt overclocking utility. This utili-
ty has two sliders, which reflect the
core clock speeds of the card and the
accompanying video RAM speeds.
They need to be adjusted together—
your card should not run faster than
the video RAM. Of course, both these
speeds have thresholds you need to
adhere to.

The Control Panel 
We won’t be messing around
with the card from within this

software, but will do it from within the
nVidia drivers, as they give us certain
options that the software doesn’t—
namely, the automatic overclocker! Note
that you can use nVHardPage to over-
clock your card if you want to, but we
don’t recommend that you do. nVHard-
Page gives you too much leeway—you
could easily damage your card by mov-
ing the slider too far to the right! Why
we used nVHardPage at all is because
running it makes the overclocking
options in the nVidia drivers available.

Now, to un-hide the frequency con-
troller slider for the driver interface,
click on the nVidia icon at the top and
then click on the control panel set-

tings. Here you’ll find a list of options
that signify the settings you can tweak
from within the nVidia driver interface.
The unchecked boxes signify the hidden
tweaks. Now here, tick the ‘Enable Cool-
bits’ box. This will ensure that you get a
speed slider when you open the display
properties next time.

There are loads of other options
here, such as AGP settings, which lets
you choose the AGP acceleration, and a
troubleshooting page—along with a
page for configuring Direct 3D render-
ing, where you choose how many
frames the card renders in advance. This
can be tricky, because if you play a FPS
you never know what kind of frames are
required next—so if you render them in
advance, it could prove to be a bottle-
neck.

The Overclocking Menu
Now since we’ve enabled the
overclocking feature in the driv-

ers, let’s try and overclock the card!
To go to the nVidia settings page,

right click on the desktop. Choose Prop-
erties > Settings > Advanced, and then
click the tab that has your graphics
card’s name.

A menu opens up on the left with a
multitude of options and settings.
Click on the option marked ‘Clock Fre-
quency Settings’. On the right, select
the radio button labelled ‘Manual Over-
clocking’. Selecting it will present you
with a disclaimer. Read it and hit the ‘I
accept’ button. You will be presented
with two sliders, one for ‘Core Clock Fre-
quency’ and the other for ‘Memory
Clock Frequency’.

Over-
clock-
ing

The Card
You could, of
course, go
ahead and over-
clock the card
by simply slid-
ing the slider as
far to the right
as you think is
safe, but if you
take the slider
too far to the right, you could render
your card forever useless.

There is an easy way to test the
potential limit of your card. In the drop-
down menu saying ‘2D Performance’,
select ‘3D’. A button labelled ‘Detect
optimal Frequencies’ gets enabled.
Clicking it will instruct the drivers to
take all system parameters into consid-
eration and give you the optimum fre-
quencies for both the GPU core and the
memory frequency. 

There is, however, no guarantee that
the card will run all games at these set-
tings. Once the card gives you these set-
tings, you should test the system
stability by running different games.

If all goes well, try increasing the fre-
quency a little, and test again. Continue
this process until you get the maximum
value at which your system stays stable.
This is the optimum overclocked speed
of your card, and this can be above or
below the auto-detected settings.

If you have an ATi card, you can
download some utilities from
www.voodoofiles.com/9742

These software work similar to the
one we’ve talked about, and you should-
n’t have too much trouble overclocking
your ATi card. 

If you’re giving up on your graphics card, you might as well try and overclock it!

Move the slider to get optimum performance
out of the card

Enable various settings using the control panel

Set the core and memory
clock frequencies here



106 DIGIT SEPTEMBER 2005

to recover even with a fast processor. The
software uses the brute-force technique
of password breaking, and how fast it
can find the password is dependent on
the number-crunching capability of
the processor. 

Now You C!
My PC runs two OSes, Windows 98 on the
C drive and Windows XP on the D drive. A

few days ago, I installed the Windows version
of the C language. Recently, I uninstalled it
and started getting an error message at
bootup in the Windows 98 OS:
“There is an error in your CONFIG.SYS file on
Line 2
The following file is missing or
corrupted:D:\C700\BIN\SMARTDRV.EXE
There is an error in your CONFIG.SYS file on Line 8
Incorrect DOS version
The following file is missing or
corrupted:COMMAND.COM
C:\>D:\C700\BIN\SMARTDRV.EXE
Bad command or file name
C:\>PATH= D:\C700\BIN;D:\WINDOWS\System32;
D:\WINDOWS; D:\WINDOWS\System32\Wbem
C:\>SET LIB= D:\C700\LIB;D:\C700\MFC\LIB
C:\>SET INCLUDE= D:\C700\INCLUDE;
D:\C700\MFC\INCLUDE
C:\>SET HELPFILES= D:\C700\HELP\*.HLP
C:\>SET INIT= D:\C700\INIT”
Why is this happening?

Ravi Ranjan, via e-mail

The problem with your system is that one
of the startup files for Windows 98,

config.sys, contains invalid commands that
were added to it when you installed C for

Windows. Now when you uninstalled C,
the changes to config.sys have not been
undone, and since those commands are
no longer valid, you get the error. 

In order to correct this problem,
open config.sys in a text editor such as
Notepad. The config.sys file might be
hidden and read-only, and you might
have to reset its attributes. To do this, go
to the Windows command prompt and
type in the following commands:
CD\
ATTRIB -S -H -R CONFIG.SYS

You’ll now be able to edit config.sys.
Go to line number 2, and type in ‘REM’
and a space at the start of the line.
Similarly, go to line number 8, type

‘REM’ and a space at the start. After adding
‘REM’, save the file and restart your computer.
Everything should work fine now. ‘REM’ is
short for ‘Remark Comments’, and stops lines
from getting executed. Similarly, to un-
comment any line, just delete the word ‘REM’
from the start of the line.

Registry Backup In Win98
I have a Pentium III 500 MHz processor, an Intel
BX motherboard, 128 MB of RAM and a 20 GB

hard disk. I have Windows 98 installed. How do I
back up my registry?

Rajesh Bhatt, Mumbai

There is a utility in Windows 98 to check,
backup and restore the registry, known as

SCANREGW. Go to Start > Run. Enter “SCAN-
REGW” and hit [Enter]. You’ll be asked if you
want to back up the registry. Click ‘Yes’, and your
registry will be backed up. 

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we will answer them
here! Since we get more
mails per day than we
can handle, it may take
some time for your 
query to be answered.
Rest assured, we are
listening!

Get Help Now!

Too Hot To Handle!
I have a Pentium IV with Intel 865GBF motherboard, 1 GB
RAM, an ATi Radeon 256 MB graphics card running Windows

XP with SP2. I have a peculiar problem with
processor overheating. I experienced this first

when playing SimCity 4. Within five
minutes of launching the game, I got a
warning message about overheating of
the heat processor. But as soon as I quit
SimCity 4, the system normalised. 

Is it a problem with my processor?
Other than this, my computer doesn’t

overheat even if it runs for a full day. On the boot
before the OS selection, I am getting a particular
message saying processor in dual channel mode,
and so on, and press F4 to resume. This thing
popped up recently. What could the problem be?

Mika, Via e-mail

Even if your PC is switched on the whole
day, and if it’s not under stress, the

processor will not overheat. But when you play 3-D games
that stress the processor, it tends to heat up. Intel Prescott
processors are known to heat up and your processor seems
to be one of those. Rest assured, this is normal. 

The reason for overheating could be due to the CPU fan
not working properly or the CPU and heat sink not making

proper contact thereby hindering maximum heat dissipa-
tion. Moreover, you need to check if your cabinet is properly
ventilated as an improperly ventilated cabinet can also

contribute to overheating. 
In order to remedy the prob-

lem, check whether the CPU
fan is rotating and not being

blocked. It is advisable to
remove the heat sink fan unit

and the processor, clean it, apply
a fresh, thin and uniform coat of

heat sink compound on the
surfaces of the processor and the
heat sink that come in contact with
each other and then re-assemble
them. This should eliminate the
cause of the overheating. 

Based on the information
which you have provided, we
think the message that is
displayed during system boot is

“Memory in Dual Channel Mode” and
not “Processor in Dual Channel Mode”. However, this is a
normal occurence for 865 chipset-based motherboards with
two memory modules. The ‘Press F4 to resume’ must refer to
the temperature shutdown of the motherboard and not due
to the dual channel memory setting.

Question 

of the

Month
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Recently, after a three-year stay in the US, my
best friend Samir returned to India. We
soon caught up at our usual hangout and

after the initial niceties, the topic immediately
turned to our common passion—technology! 

A techie and an avid gamer, Samir has an 02
XDA IIs, a Rio Karma MP3 player and the
slimmest digital camera I have ever seen—the
Sony DSC T7! Over the course of our conversa-
tion, he amazed me with stories of the US includ-
ing his experiences with LAN gaming and the
like. Well, what do you expect when two techies
get together?

Now that he was back, things weren’t exactly
to his liking. I suggested he rent some DVDs or
watch TV to pass the time but this just opened up
a can of worms! Samir’s home (like most Indian
homes) had fallen prey to the saas-bahu sagas and
the poor guy had no say in the matter. 

Time for Agent 001 to swing into action!
Having dealt with this problem myself, I knew
the anatomy of the problem and the solution
too! A TV-Tuner card is the best device to counter
this problem and have your way! Accordingly, I
suggested this to him and before I know it, I was
in the thick of things and found myself searching
for an ideal TV-Tuner device for his computer. 

My first stop was at a decent enough shop in
Vashi Plaza (Navi Mumbai). On inquiring about a
TV-Tuner card, I was asked for
two options—external and
internal. What’s the differ-
ence? In an internal card, one
needs to install it in the CPU
and then load the drivers—it’s a
lot of work! 

With an external one, all one
has to do is hook it up to a stan-
dard monitor and you’re done.

Also, in an external box,
since you are not required to
switch ‘On’ the PC, it saves a
lot of power, which is not an
option with the ‘internal’ TV
tuner card. But what about
capturing Live TV pro-
grammes to view them later? 

If you are interested in
capturing live shows,
you would be better off
with an internal TV-Tuner
card, I was told. There are
some external boxes that hook up to
your PC via the USB port, but then the connec-
tion becomes the bottleneck. It’s advisable to go
for an internal card if capturing is your game. 

As for brands, the only two options I was
presented with were Frontech and Intex. The

external solutions from these brands are
priced between Rs 1.2 K and Rs 1.5 K and offer
maximum bang for your buck. Unfortunately,
they lack the quality finish associated with
good products. 

To hunt for better options, I decided to
make the journey to the Holy Grail—
Lamington Road (LR). Unfortunately, the July
26 rains that inundated the whole of Mumbai
did not spare LR either. Nonetheless, business
was as usual. My decision to make the journey
here was vindicated at the first stop itself
where I was presented with a range of options
to choose from. The prices started at Rs 1.2 K
and went up to Rs 6 K. 

Entry-level internal TV-tuner cards with
basic ‘capturing’ capabilities from Frontech,
Intex, Mercury, X-Teq started at Rs 1.2 K. If you
are on a hunt for the cheapest solution and
can compromise on the capturing front, don’t
look any further. 

Pinnacle, Compro, AverMedia and Pixelview
are the middle range options and offer internal
TV-Tuner cards between Rs 2.2 K and Rs 3.5 K.
Within this category, AverMedia and Pixelview
are slightly cheaper options with respectable
picture quality. Both, Pinnacle and Compro,
have Gold or Pro versions of their cards and
offer extra features including FM Tuner, Stereo
sound and more. These versions, though, would
set you back by around Rs 3.5 K. 

Although you can also use these TV
tuner cards for capturing content, you

need to remember that these cards
don’t have the required decoding
hardware and hence, good quality

capture is not possible. 
Cards such as Hauppauge have

an onboard hardware MPEG-2
decoder that makes good capturing
possible. Despite my best efforts, I

couldn’t locate a dealer for these
cards. Time to phone relatives
abroad! Compro also has another
solution wherein the tuner is inte-
grated with the Graphics card.

Cost: a good Rs 6 K.       
Finally, for Samir, I bought

Pinnacle’s PCTV that cost Rs 2,350—
an ideal option for viewing and cap-
turing content provided you have a
good computer. 

Agent 001

If you would like
to capture live TV
shows, you would
be better off with
an internal 
TV-Tuner card

It’s A PC… It’s A TV
Once you add a TV-Tuner card to the computer, you could turn it into a TV or a PC at the
touch of a button

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Pradip Ingale
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Looking For A Notebook 
I am interested in buying a notebook computer.
Which one do you think is better? Acer Aspire

5000 with AMD Athlon Turion 64-bit processor or
Acer Travelmate 4151LCi with a Centrino processor?
Would there be any backward integration problems
with the 64-bit processor? 

Dr Vasant Patel 

As far as AMD Turion is concerned, we
haven’t tested a solution based on this

new platform and I will reserve my comments
on the performance of the new chip from AMD.
However, from what I have heard about it, it is
good. I don’t think there will be any backward
compatibility issues either. 

The Acer Travelmate 4151LCi is based on a
tried-and-tested Centrino platform and I don’t
see any problems if you would like to purchase it.
However, you should consider laptops from other
brands such as HP-Compaq, Dell and Lenovo
(IBM) as well.  

Music On The Move
I am interested in buying a HDD MP3 player. I
have around 20+ GB of classic rock and would

like to carry it around and also be able to play it on
my car tape deck. One more feature I am looking for
is the ability to record lectures on the fly. Ease-of-use
and battery life are important to me. I have narrowed
down my choices to the iRiver and Creative because
I am not so sure about the Apple iPod.

Dr A K George

Among the various HDD MP3 players,
iPod from Apple is considered to be the

best. It looks great, is extremely simple to use
and offers superb battery life. However, it does
not offer any additional features such as FM
reception or voice recording. 

Creative’s Zen is another good MP3 player,
which, according to me, fits the bill as it also
allows voice recording although via an
optional remote. 

As far as the iRiver is concerned, they have
recently launched their outlets in India and
might not have a national presence as of now.
Due to this, their service network also might not
be up to scratch. 

As for your buying decision, I suggest you go
for the Creative Zen. However, if you are ready to
sacrifice the voice recording feature, nothing
beats the iPod. For playing MP3s in your car, a
converter is also available with most shops sell-
ing car stereos. For Creative, contact your local
dealer. Apple India can reached at 080-25550575.

Motherboard Musings
I am planning to buy a computer with AMD 64
3200+, 1 GB RAM, 6600GT nVidia graphics

card, but I am unable to decide on a motherboard. 
What I would like, though, should have a PCI-e

slot for the graphics card. Moreover, it should
support 939-pin AMD processors and preferably, be
based around the nVidia chipset. I have allocated
approximately Rs 8 K for the board. Also, could you

suggest me a good cabinet in the Rs 3-4 K range,
ideally from Antec?

Abhishek Dwivedi

For motherboards based on nVidia
nForce4 chipsets, I would suggest you to

go for the MSI K8N Neo4. It has all the features
you have asked for and hopefully, should fit in
your budget too. As far as the cabinet is
concerned, I don’t think you will get an Antec
cabinet for Rs 3-4 K with the power supply. 

I would suggest you buy a Mercury cabinet
with good ventilation and then add an Antec
power supply to it. A standard mercury cabi-
net should set you back by Rs 500-700 and the
Smart Power 350W PS from Antec will cost you
around Rs 3.6 K.

MFD Matters
I am planning to buy a multifunctional device
for my small office with a budget of around 

Rs 7K. Please suggest one that is capable of photo
quality printing, has standalone copy function and
preferably runs on low ink.

Ajil Mathews

From our experience, we can say that
Epson MFDs are good at extending the

life of the ink cartridge, but don’t give you exem-
plary printing quality. Lexmark has some great
looking devices, give good print quality but are
ink guzzlers. HP offers the best all-round
performance, though, with good prints and
acceptable ink drain. 

Nevertheless, among all these, Canon is the
best when it comes to print quality, speed and
cartridge life. Before you buy an MFD, look for
the brand with easy availability of ink cartridges
and a proper service network.

3G Or Not To 3G?
I need to buy a mobile phone but I am confused
between the Nokia 6630 and 6681. Both phones

are just awesome and offer almost the same feature
set; only difference being the 6681 one doesn’t
support 3G. Should I go for 3G phone? In India, as far
as I know, there are hardly any companies offering
true 3G capabilities and it will take a long time for 3G
to be fully functional. I am not planning on changing
the phone frequently. 

Ashish Anand 

As far as 3G is concerned, I think we are
unanimous about it: it’s a long way

before Indian cell companies offer something
that is ‘more go than show’. Therefore, invest-
ing in a cell phone supporting 3G might not be
the smartest thing to do. 

But, since you have mentioned that you
won’t be changing the phone frequently, I
suggest you buy the 6630 with 3G support,
which might come handy whenever cell
companies in India offer 3G. Also, the price
difference between the two models is not much
and having that extra headroom might be a
boon in disguise in the long run. 

Creative’s Zen 
is a good MP3 
player, which 
fits the bill as 
it allows voice
recording
although via an
optional remote

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details and get
your queries answered.
Please mention your PC’s
detailed configuration 
to ensure consideration
for this section

Ask Away

Ask Agent 001



Head For The Phones

The Bose Triport Music System con-
sists of a CD/MP3 disc player and a

Triport headphone. The player looks
like any other Discman, but appear-
ances can be deceptive! 

Since it plays MP3 discs, a folder browser
button lets you browse through folders. Another button is
‘Browse’ that lets you check the other tracks on the disc
while you are listening to one.

The volume controls are placed on the top . Other but-
tons include the regular Play/Pause, Previous and Forward
and Stop buttons. A unique MyMix button lets you create
custom playlists from any MP3 disc that you are currently
listening to, but once you switch off the player, the list 
is lost. 

The headphone weighs only 5 ounces and looks flimsy,
but it is just the lull before the storm. Once you wrap it
around your ears, you will be surprised by the amount of
reduction in the ambient noise. Remember, these are 
not noise-canceling headphones, but they perform a near-
similar job. Nevertheless, the real pleasure starts when
you hit play! The headphone can be summed up in one
word—fantastic! 

Some of the artists whose music we played on it were
Nirvana, Pink Floyd, Madonna, Pearl Jam, Metallica,
Alannah Myles, Chicane, Bryan Adams, Aerosmith, Lata
Mangeshkar, Kishore Kumar, Mohd. Rafi, Beethoven, Claude
Debussy… not necessarily in that order. Everything sounded
amazing! You could hear notes that you previously did not

know existed. The music is perfectly balanced
with no extra stress on the instruments than

on the vocals—everything is crystal-clear.
Nonetheless, there are some down-
sides: in some songs, we noticed

that the treble went intermit-
tently high. This can be attrib-
uted to the quality of the
Audio CD, too, but the sound
jarrs at high treble and volume

settings. Another factor is that
each note is faithfully repro-

duced, so for people who listen to low bit rate MP3 files,
they will notice a flanging effect that is not apparent on
low-end stereo systems or headphones. 

So, is this combination the best that we have seen? In
a manner of speaking, it is. It is the headphone more 
than the player that steals the show. However, there are
much cheaper brands available today which do the job
just as well.

The Anti-Skip function is one of the best we have seen.
Finally, everything boils down to one all-pervading truth:
this is a Bose. So, if you like to flaunt it, you have to get it!

Company Bose Corporation India Ltd.

Price Rs.11,900

Phone 1600112673

E-mail customersupport@boseindia.com

Web site www.boseindia.com/

Rating

The Incredible Bulk

This Mobile Freedom Headset from Logitech is
compliant with Bluetooth v1.2. The

headset works with compatible
mobile phones and PCs. 

Weighing less than 30
gm, the headset is bulky.
It has a range of 10
meters and is powered
by a 140mAH
rechargeable Lithium-
ion battery.  

The controls on the headset
include a ‘call answer button and a
volume up/down button. The call answer button works as the
power-up key as well and enables pairing up with other devices. 

The rotating over-ear clip is not very comfortable to wear.
Call clarity is exceptional, with a decent range.

Company Logitech Electronic India Pvt Ltd

Price Rs 3,995

Phone 022-26571160

E-mail response@logitech.com

Web site : www.logitech.com

Rating
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Samsung Note PC Q30

Samsung’s Q30 is a sleek form factor notebook that
weighs just 1.1 kg. This Centrino notebook has an

Intel Pentium M-A 1200 GHz processor, 512 MB RAM
and a 40 GB hard drive. It bundles an external

FireWire DVD-RAM ReWriter.
The 12.1-inch wide colour TFT screen

supports 1280 x 768 pixels resolution.
The connectivity options are Wi-Fi
802.11 B/G, 10/100 Mbps LAN as well as
a 56 Kbps modem. It also features a
card reader and has 2 USB 2.0 ports

and a FireWire port.
It was below average in the

Business WinStone 2004, scoring
just 14.3. The battery lasted for a

good 3 hours and 57 minutes.
It comes with Windows XP Professional

and recovery CDs. The price of Rs 1,40,000 is too high.

Company Samsung India Electronics India Ltd.

Price Rs 1,39,990

Phone : 011-51511234

E-mail raman.singh@samsung.com

Web site www.samsungindia.com

Rating

1 2 3 4 5

1 2 3 4 5

Logitech Mobile Freedom Headset

1 2 3 4 5



111SEPTEMBER 2005 DIGIT

Digital Tools l New and Notable

Creative Zen Portable Media Player

The Zen Portable Media Player from Creative is one of
the early devices running on Microsoft’s Portable Media

Center software. Straight out of the box, the player is
simply stunning, albeit a bit bulky, with a shiny black
coating and a nice big 3.8-inch LCD screen. It fits into your
hand and lets you play music, movies and photographs
with ease. 

In terms of the
specs, it is powered
by an Intel Scale
400MHz processor,
64 MB RAM and a 20
GB hard disk drive.
The Zen’s interface 
is extremely
responsive. And all
this despite the glitzy
fade-in and smooth
sliding effects within
the Windows OS.

The controls are fairly simple and gameboy-ish. 
Despite all these amazing features, the player does not

identify as a removable drive, and drivers are needed to
transfer music. It works on Windows Media Digital Rights
Management 10, which prevents a movie file from loading
into the player if not authorised by a Web server, which it
connects to every time you sync it.

It plays only the WMV format, but does it well. If you
have movies in other formats, WMP10 will first convert
them and then upload them—a colossal waste of your time.
The device plays music (MP3 and WMV formats), displays
photographs and plays videos with élan. The interface is
slick and extremely easy to navigate and makes scrolling
through huge lists easy. If you can live with a slightly bulky
(but well built) device, we would absolutely recommend
this device.

Company Creative Technology Ltd. 

Price Rs 28,299

Phone 0 - 9820357718

Web site www.creative.com

Rating

For Professional Laps

The Latitude D410 measures 1.25 x 11.0 x 9.4 inches and
weighs just over 1.7 kg.
Powered by an Intel Pentium M Processor 760 (2.00GHz,

2MB L2 Cache) installed on an Intel 915GM chipset, the
notebook offers the latest mobile offerings from Intel—
including PCI-Express, DDR2 support and 533 MHz FSB. 

The 12.1-inch screen supports 
1024 x 768 resolution. 

Other specs include 512 MB system
memory, 40 GB 5400 RPM hard drive,
and Intel Graphics Media Accelerator
900. Connectivity options include
Intel Pro 2200 802.11b/g Wi-Fi, 56K
modem and Gigabit LAN. Available

ports include Docking
connector, 3 USB, VGA,
headphone/speaker out,

infrared port, RJ-11, and RJ-
45. A PC card slot is provided, though

FireWire and media card reader are not available.
Because of its reinforced magnesium alloy frame, the

D410 is extremely sturdy, and comes with Dell’s StrikeZone
shock absorber system to protect the hard drive. 

Both touchpad and pointing stick options are present.
The notebook logged a whopping 23.9 in the Business
Winstone Test and 3413 in PCMark04, making it one of the
best performing notebooks we have ever tested. The included
six-cell battery lasted a decent 2 hrs 39 minutes.

The D410 bundles an external combo-drive, Windows XP
Professional with SP2, a nine-cell extended battery, leather
carry bag and a 3-year on-site warranty. 

Overall, the Latitude D410 will not disappoint frequent
travellers who want great performance.

Company Dell Computer India

Price Rs 94,757

Phone 080-25357309

E-mail anil_srinivas@dell.com

Web site : www.dell.com/ap

Rating

Dell Latitude D410

Anti-piracy MP3 Player

The iRiver N10 is a sleek MP3 player with a memory
capacity of 256 MB. It comes with a standard USB cable

and earphones. The style is abstract and will appeal to
people who want to flaunt their MP3 players. 

The display is OLED which is very functional and
actually helps in conserving battery life. The iRiver N10 can
play Windows Media Audio and MP3 files. 

Coming to performance, the player has very good sound
quality. Its software lets you tweak just about anything you
want, however, the controls are rather cumbersome to use.
You can use the preset equalisers for listening to music or
customise them as you wish. 

Battery life is pretty good; with the player running non-
stop for approximately 10.5 hours. 

The player is plug-and-play and is recognised as a USB
device when connected to a computer. You will, however,
need to install the proprietary iRiver software before using
the player. Using this bundled software, you can also store
data in the player. 

Another feature (or mis-feature) is that once you copy a
song on to the player, you cannot copy it back to the

computer. According to iRiver, it is 
a step to prevent illegal transfer 
of music from one system 
to another. 

The sound recording
quality is good and
recorded files are in
.REC format, which
can be converted to
MP3 using the iRiver
Music Manager software.

The player is feature-
packed and boasts good
performance but the price of Rs 8,499
is a big letdown.

Company Salora International Ltd

Price Rs 8,499

Phone 011-51614322

Web site : www.iriverindia.com

Rating

1 2 3 4 5 1 2 3 4 5

1 2 3 4 5

iRiver N10 256MB MP3 player



112 DIGIT SEPTEMBER 2005

Digital Tools l New and Notable

XDA Again

The XDA IIi boasts significant enhancements over the older XDA II.
Featuring the same design, the XDA IIi is a PDA phone with

Windows Mobile 2003 Second Edition for Pocket PC Phone Edition.
Its enhancements include added Wi-Fi (802.11b) support, a faster

processor (Intel PXA 272 running at 520 MHz as compared to the 400
MHz CPU in the XDA II), double the ROM at 128MB, and a 1.3
megapixel camera. Other specifications of the XDA IIi include tri-
band GPRS, a 3.5-inch 240 x 320 touchscreen supporting 65K colours,
128 MB SDRAM, SDIO slot, Infrared and Bluetooth v1.2.

Pre-installed applications include Pocket Excel, Word, Internet
Explorer, MSN Messenger, Windows Media Player 10, Java MIDlet
Manager (J2ME), Photo Contacts, PowerPoint and PDF viewer, and
much more... The device connects to a PC using the bundled USB

cable and Microsoft ActiveSync 3.8 included on the CD.
The 520 MHz CPU is zippy and handles most

applications, multimedia and games with ease, even
while multitasking. Phone clarity on the XDA
IIi is excellent, and the 1.3-megapixel camera
produces decent results—provided lighting
conditions are good. 

To sum up, the XDA IIi is a worthy buy for
corporate users who want to stay connected on
the move. However, others can opt for an entry-
level notebook at a similar price!

Company Creative E-Biz.com 

Price Rs 45,888

Phone 022-5631 4845

E-mail cr_mum@yahoo.com

Web site www.seeo2.com

Rating
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Jabra BT 800

Jabra has finally made its way to Indian shores. The
BT800 Bluetooth headset, Jabra’s flagship model, is

packed with impressive features. 
The BT800 looks chunky, but at 22 gms, is quite

light. The skinny ear loop does a good job of holding
the BT800 comfortably in place. 

It has an integrated, one-line, backlit LCD display
that lets you see the caller ID. This feature
comes handy since you can identify the
caller without pulling the phone out of
your pocket or bag. When we tested
the headset with a Motorola A780,
we were able to see the caller’s
number, but not the name from the
phonebook. Test the device with
your phone to make sure
all advanced features
work before buying it. 

Jabra provided a
power adapter and a
USB connector to charge
the BT800. It supports voice
dialling from the cell phone address book, has five
polyphonic ring tones and even a mild vibrate mode. 

During testing, the BT800 performed well; the
onboard DSP was able to cut through most of the
background noise. 

Sensibly priced at Rs 6,500, this product should
be on your buying list. 

Company Faxtel Systems (India) 

Price Rs 6,500

Phone 022-6113055/6115524

E-mail faxtel@bom4.vsnl.net.in

Web site www.jabra.com

Rating

1 Poor: Has serious drawbacks and needs improvement before it can be used for its target application. 2 Mediocre: Does not live up to expectations, needs improvement 
in many areas. 3 Average: Reasonably competent, but nothing spectacular about the product. 4 Good: A good buy, better than most products in its category. 
5 Excellent: A brilliant combination of price, performance and features—far beyond expectations.

O2 XDA IIi

Video On The Go

This 20GB device is only slightly bigger than your regular
iPod but does much more! For starters, it plays video

(MPEG-4 and AVI in DivX format), audio (MP3, WAV, WMA)
and JPEG and BMP images.

To be fair, the 3.5-inch screen is not spectacularly big like
its sibling, the Archos AV700’s, but the
clarity is excellent. 

It has a four-way navigation key and
a centre-click button. A sixth button is
used for going back in the menu
structure. Unlike iPods, where you need
iTunes, the AV400 is recognised as a
removable drive in Windows XP and
you can copy files using Windows
Explorer. When you unplug it, a scan is
automatically performed and each file
is classified under Artist, Genre,
Album, Title and so on. Updating 1 GB
of new music took less than 3 seconds. We were floored!

The interface is brilliant, fast and vivid. The player has an
inbuilt CF reader and an additional 4-in-1 adapter can be
bought to let you insert any kind of memory card directly
into the device. It has a book-marking feature—click ‘Resume’

to continue from where you left off in a movie or song.
It comes bundled with Virtual dub and a front-end

proprietary software, which ensures that all encoding
settings are just right for the movie to play. In our tests
though, even unoptimised movies played without framing.
The included headphones are strictly decent.

Archos also bundles a hub which allows you to record
and playback movies or images to a
TV. The recording is limited to just 
2 GB per file. It can also be used as 
a Dictaphone.

You can rename files and
create/delete folders and playlists
directly from within the player. The
battery life is just about adequate for
3 hours of video and 11 hours 
for music.

The product is amazing but we
would’ve liked a bigger hard disk for
more movie storage.

Available from The Gadget Boy (Inorbit Mall, Malad, Mumbai

Price Rs 29,999

Phone 022-56880270 Web site www.archos.com

Rating

1 2 3 4 5

1 2 3 4 5

Archos AV 400

1 2 3 4 5

Please write to products@thinkdigit.com. The Digit Test Centre will be delighted
to respond to your queries.

Looking for more information on any of the products featured here?
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We recently got our Beta 1 release of Windows Vista.
Pleased as punch, we promptly proceeded to check
out what lay inside the DVD. Yes, the new version

of Windows ships only on DVD!

Installing It
The installation doesn’t go the usual interrogatory way: it’s
simple and asks only for the product key, install type,
computer’s name and the partition you want to install it
on. Here, you can create/modify/delete partitions if you
want. The installation screens are extremely user-friendly.

System Requirements
Microsoft had warned us that system requirements were
pretty heavy. Apparently, Vista requires a minimum of 512
MB of RAM. Also, if you want all the slick graphics, you need
a dedicated graphics card with DirectX9 support. If you don’t
have one, your Vista desktop won’t look as cool as it can.

The Desktop
The first thing that strikes you about the desktop is its
amazing look and feel. Those who’ve used a Mac would
readily say there’s now more of the Mac in Windows.

Straight up, it doesn’t seem anything revolutionary—
most of the icons are from XP, but they’re high-res.

There’s a small button on the bottom right—the
Windows Indexing Service, finally getting the front seat.
MS has integrated MSN Search into the OS.

GDI vs DirectX
GDI (Graphics Device Interface) is the standard that
Windows uses for creating graphical objects and putting
them on displays and printers. Now, the reason why it’s
DirectX that is used for high-end gaming is because it lets
programmers use a lot more of the features that the hard-
ware supports. If you have a DirectX9-compliant card, Vista
will use the DirectX API as far as possible, rather than the
GDI API. It’ll look pretty much like XP if you don’t.

Using Vista
The way the startup menu works has
changed. Firstly, there’s a small search
box in case you have too many pro-
grams and don’t want to scroll. It finds
as you type. When you click the ‘All
Programs’ option, there’s no new pane
that slides out; instead, the pane on
the left switches to the entire listof pro-
grams, and clicking on a folder opens
it up à la Explorer.

Other changes include the lack of
the ‘My’ prefix for any of the links—so
‘My Computer’ is now just ‘Computer’,
and so on. Also, the Log Off and

Shutdown buttons have been improved. 
Here are some more features:

Virtual Folders
Virtual folders are basically specially-formatted XML files that
act as regular folders. These folders contain search results. You
can create virtual folders of your own searches. That is, if you
have properly tagged music, video, documents, etc.—in other
words, if the folders you’re searching in contain the necessary
metadata—you can save the search as a virtual folder.

Internet Explorer 7
IE7 installs by default. It’s got tabbed browsing (finally!), an
RSS reader and the ‘Shrink to Fit’ printing feature.

Live Icons
If you have an Images folder, the folder will show

up with images lined up like pages. The same
applies for documents, music and video folders.

Security
A recent outcry about the first virus for Vista that exploited a
security hole in the command shell (MSH, probably for
Microsoft Shell) bundled with it has been largely unthreat-
ening, as Vista Beta 1 does not ship with it—nor is there any
confirmation that the final release will have it.

Finally…
At this juncture, Vista looks cool, more like a Mac, but only
more user-friendly! There are still some hiccups to
smoothen out, and compared to Windows XP, the changes
visible are more in the GUI than anywhere else. We suggest
you wait and watch this space for the next update. 

Bhaskar Banik (bhaskar_banik@thinkdigit.com)
Varun Dubey (varun_dubey@thinkdigit.com)

Live icons in Windows Vista

Virtual Folders in Windows Vista

Vista’s Start Menu
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Graphics Cards (Low End)
Gainward GeForce 6200 256
MB

Good performance, Shader
Model 3.0 support, good
value for money
None

Contact Mediatech India
Phone 022-26361111
E-mail digit@mediatechindia.com
Price Rs 3,950

Graphics Cards (Mid Range)
XFX GeForce 6600GT 256 MB

Great performance,
good features
High price

Contact Rashi Peripherals
Phone 022-28221013
E-mail navinderc@
rptechindia.com
Price Rs 15,000

CRT Monitors (17-inch)
Acer AC715

High resolution of 1600 x
1200 @ 75 Hz, good repro-
duction of finer details

None

Contact Acer India Pvt.Ltd.
Phone 080-5219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 6,995

CRT Monitors (19-inch)
Samsung SyncMaster 997DF

Good colour reproduction, 
compact
None
Contact Samsung Electronics

India
Phone 011-51511234 
E-mail marketing@
samsungindia.com
Price Rs 13,999

Cell Phones 
Sony-Ericsson K700i 

Extensive feature set;
includes camera, MP3, FM
radio, etc., fast processor
None

Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@
sonyericsson.com
Price Rs 10,500

Internal TV Tuner Cards
Compro VideoMate PVR/FM

Exceptionally clear TV
reception quality, low price,
FM radio, good PVR
software
None

Contact Mediatech India
Phone 022-26361111
E-mail
sales@mediatechindia.com
Price Rs 1,850

LCD Monitors (15-inch)
Acer AL1512

Very competitively priced,     
good contrast ratio
No vertical swivel

Contact Acer India Pvt. Ltd
Phone 080- 5219520-23
E-mail rajesh_aiyar@acer.co.in
Price Rs Rs 9,500

LCD Monitors (17-inch)
Acer AL714sm

Light, good greyscale 
reproduction
None

Contact Acer India Pvt Ltd
Phone : 080-5219520 / 23
E-mail rajesh_aiyar@acer.co.in
Price Rs 14,999

PDA Phones
O2 XDA II Mini 

Small, thin and pocketable
One-handed operation not 
possible  

Contact Creative e-biz
Phone 022-23828100
E-mail creative@goldkist.net 
Price Rs 32,000

Projectors
Acer PD11

High 1600-lumen brightness
support, large 330-inch 
diagonal image size capabil-
ity, Picture-in-Picture mode
None

Contact Acer India Pvt Ltd 
Phone 080-25219520
E-mail rajesh_aiyar@acer.co.in
Price Rs 62,999

Graphics cards (High End) 
XFX GeForce 7800 GTX
256 MB

Extreme performance, great
price, exotic features 
None
Contact Rashi Peripherals
Phone 022-28221013
E-mail navinderc@ 
rptechindia.com
Price Rs 35,000

Portable Hard Drives
WD-Media Centre 250GB

Very low cost per MB, 
memory card reader slots

None

Contact Western Digital
Phone 022-25851085
E-mail ajay.kapure@wdc.com
Price Rs 13,999

Linux 
Xandros Desktop OS 3

Simple to use
Paid

Contact G.T. Enterprise
Phone 080-2669 5890/91/92/ 
93/94 
E-mail gtcdrom@vsnl.com 

SuSe 9.3 Linux Professional
Up-to-date software bundling
None

Contact G.T. Enterprise
Phone 080-2669 5890/91/

92/93/94 
E-mail gtcdrom@vsnl.com 

Motherboards
Mercury PI915GVM

Supports PCIE, DDR/DDR II
RAM, 6-channel audio

Only 2 PCI slots. No SATA.

Contact Kobian ECS India Pvt ltd
Phone 022-23020767 / 774
E-mail mumbai@kobian.com
Price Rs 4,850

MSI RS480M2-IL
+ PCIE based, 6 channel
audio, supports 4 GB RAM,
socket 939, Firewire port
No Gigabit

Contact Tirupati Enterprises 
Phone 033-22251192 
E-mail mail@tirupati.net
Price Rs 5,200

The best products tested so far in different 
hardware and software categoriesThe A-List
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Digital cameras (Mid
Range)
HP PhotoSmart 945

8X optical zoom, big lens
results in some great photo-
graphs

Not quite pocketable

Contact J.J Mehta and sons
Phone 022-24326865
E-mail sales@jjmehta.com
Price Rs Rs.16,500

Digital cameras (High
End)
Sony CyberShot DSC-P200

Compact, 7 Mega Pixel
performance oriented camera

None

Contact Sony India Pvt. Ltd
Phone : 011-55006600
E-mail mktginfo@ap.sony.com
Price Rs.20,990

Office Inkjet MFDs
Lexmark X7170

Full featured MFD, fast 
printing and copying speeds.
decent quality photo prints
No memory card reader; B&W
LCD screen 

Contact Lexmark India Ltd
Phone 022-26057755
Website www.lexmark.com
Price Rs 14,999

5.1 Speakers
Artis X10 Mini

Compact, sturdy, clear 
sound
Slightly weak bass 

Contact Kunhar 
Peripherals Pvt Ltd
Phone 022-56345758
E-mail salesbom@kunhar.com  
Price Rs 13,500

Digital cameras (Entry level)
Canon PowerShot A400

Class leading performance and
decent feature set 

A bit expensive in its class
Contact Macro Foto
Phone 022-22618639
email macrofotoone@yahoo.com
Price Rs.8,995 

Digital cameras (Mid Range)
Sony Cyber-Shot DSC-W5

Reproduces some great photo-
graphs, good features to close
the list

Relatively expensive in its class 

Contact Sony India Pvt. Ltd.
Phone 011-55006600 
E-mail mktginfo@ap.sony.com
Price Rs.18,990 

Home Inkjet Printers
Pixma iP1000

Economical; decent photo
printing. 
No output tray; no PictBridge  

Contact Canon India Ltd
Phone 0124-5160000
E-mail www.canon.co.in
Price Rs 3,195

Office/ Photo Inkjet
Printers
Canon Pixma iP 3000

Fast, excellent photo and 
text printing
No LCD 

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 7,495

Colour Laser Printer
Epson AcuLaser C1100

Duplex printing, network 
ready, excellent performance
High Cost per page

Contact Epson India Ltd
Phone 080-3051 5000
E-mail aculaser@eid.epson.co.in
Price Rs 36,500

Mono Laser MFDs
Canon MF 3110

High speed, low price
No fax

Contact Canon India Ltd. 
Phone 0124-5160000
Web site www.canon.co.in  
Price Rs 19,995

MSI MegaBook M510C
Terrific performance, typical
feature set, high screen
resolution
Average wireless LAN 
performance 

Contact Maxtone Electronics
Phone 022-23011434
E-mail maxtone@vsnl.com
Price Rs 68,000

Fujitsu S2020 
Hot-swappable combo drive,
good graphics performance  
Average screen readability in
sunlight

Contact Fujisan Technologies Pvt Ltd
Phone 022-56368718
E-mail gathani.paresh@

fujisan.co.in
Price Rs 78,000
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Mono Laser Printers
Canon LBP 2900

Great Performance, price
Lacks Duplex printing and

network capabilities.

Contact Canon India Ltd. 
Phone 0124-5160000 
Web site www.canon.co.in  
Price Rs 9,995

Brother HL 6050D
Excellent performance, 
duplex printing,economical 
printing
Not Network Ready

Contact Brother International. 
Phone 022-25797470
Web site www.brother.co.in  
Price Rs 35,100

Brother MFC-8440
Good print and scan 
quality, Sheetfed & CIS
scanner
Low scan speed 

Contact Brother International. 
Phone 022-25797470
Web site www.brother.co.in  
Price Rs 35,000

Photo Inkjet MFDs
HP PSC 2608

Inexpensive, excellent and
fast text and photo printing
None

Contact Hewlett Packard 
India Ltd
Phone 0124-2566111 
Website www.hp.com
Price Rs 14,999



Creation of Light in OLED

A Typical  Light Emitting
Diode (LED)
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Construction of an OLED
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1. Applied Voltage makes the current
flow from the cathode towards the
anode thorugh organic layers. This
leads to removal of electrons from
conductive layer and introduces
electrons in the emissive layer. 

2. Removal of electrons from the
conductive layer creates
positively charged atoms called
Holes which need one electron to
form a stable atom. 

3. The electrons from the emissive layer
jumps to combine with the holes and
in due process releases energy in the
form of a light photon.  

1

2

3

Passive Matrix OLED

Types of OLED
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How OLED Works

Applications of OLED

Digital Tools l Visual Explanation
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Layers

TFT Matrix

Anode

Emitted Light

Transparent
Substrate

Small OLED screens made
its way on the Samsung
E700 cell phone

Kodak LS 633—the first camera
to use OLED Screen

Samsung’s 21” screen
based on OLED. Expect

more such screens in the
near future
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Top Emitting OLED
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How Technology Can Help Your Organisation
Business
Digital

smart Business

Smart Access Control122

Robert Sovereign-Smith

ith the increase in Internet penetration
in India, more and more businesses are
using e-mail to communicate with their

customers, and even their own employees and
branch offices.

Whether it’s complaints, feedback, placing
orders with distributors, or even communicating
amongst employees, e-mail has become the de
facto form of communication today. Honestly, we
don’t even think much about it anymore—unless
you are the systems administrator, or the one
paying the bills! 

The Dilemma  
Unfortunately, many smaller companies are still
relying on their VSNL/BSNL, Rediffmail and
GMail accounts to communicate with clients
and colleagues. Some firms have their own
domains, and have even set up Web sites, but are
still using popular free e-mail services to conduct
their business.

Today, when prices for all things online have
fallen drastically, there’s no excuse for not having
a “yourname@yourdomain.com” e-mail id.

For instance, doesn’t it look very unprofes-
sional when you visit a Web site, check out the
products on offer, decide you like them, and
then have to write to some free 
e-mail address in order to get
more information? 

Most businesses
today rely
heavily on 
e-mail—reason
enough for 
e-mail
correspondence
to be handled
exclusively by
professionals

Playing Mailman
W

Imaging Vikram Kathare, Pradip Ingale 

124 Is Paperless The
Way To Be?



free. Moreover, you will always run the risk of
infection by spam and e-mail worms.

Of course, your business also needs to have
a fat always-on broadband pipe with minimal
downtimes. For instance, if your e-mail server
goes offline for a few days due to problems
with your ISPs, all your mails will begin to
bounce back to their senders—something you
definitely want to avoid when it comes to busi-
ness e-mails! 

While setting up an e-mail server may be a
good option for businesses with over 300
employees, it’s generally considered too much
trouble and a significant amount of expendi-
ture for smaller companies. 

Here at Digit, we run our own e-mail server,
primarily because our e-mail traffic is meas-
ured in terms of gigabytes per day for over 500
e-mail users, and also because we don’t have
trouble finding qualified personnel. However,
smaller companies might not be able to meet
this kind of expenditure.
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It would be like logging on to
www.thinkdigit.com or reading a few articles
in Digit, and then having to write to digit-
magazine.editor@gmail.com or to thinkdig-
itwebsite@rediffmail.com to send in your
feedback or contact our staff!

OK! Agreed, it’s ridiculous for free e-mail
addresses to appear in a business environment,
especially to customers. So what can you do
about it? You have two options available: set up
an e-mail server at your office, or get your-
name@yourdomain.com hosting from one of
the many online options.

E-mail Servers
Though this seems like a logical step to take, it
is something that requires manpower and
investment. It’s not really advisable to set up an
e-mail server on a regular machine for small
companies, especially if e-mail is critical to the
functioning of the company.

Also, this solution requires dedicated man-
power that checks and maintains the e-mail
server on a regular basis. Since most stable and
free e-mail solutions are open source and built
for Linux, you will need to find staff that is well
versed with Linux. 

However, the salaries you will have to shell
out for one or two such people will easily cross
Rs 1 lakh per annum. Smaller firms might not
be able to afford this. 

Now comes the hardware part: a typical
server, is at worst, a dedicated desktop running
Linux and a mail server such as Qmail, along
with anti-virus software. 

Though there are plenty of Windows-based
mail servers, hardly any of the good ones are

Service Name Rediff Business Indiatimes Meramail  Godaddy.com
E-mail Business E-mail Premium Plan

Number of E-mail IDs 5 6 100

Space 1 GB 1200 MB Email/1GB 2 GB

Briefcase

POP3 Yes Yes Yes

Web mail Yes Yes Yes

Domain Registered in Registered to Domain charges

your name Indiatimes Rs 400 Extra

Terms & Conditions http://hosting.rediff.com/ http://meramail.indiatimes http://www.godaddy

URL hosting/scripts/terms.phtml .com/meramail/help/ .com/gdshop/

MeraMailTerms.jsp agreements.asp?

Price per year Rs 1,695 Rs 1,499 Rs 1,320 + 400

50 or more IDs Rs 10,200 for 49 IDs Rs 10,299 for 50 IDs Rs 1,320 for 100

Comparison Chart

Essentially, if you
are buying a new
domain, all you
need to do is buy
hosting and the
business e-mail
is provided at no
extra cost

Home AD
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Hosted E-mail
This option is much better for the majority of
smaller companies, as the hardware and soft-
ware are all taken care of by the hosting
provider. A company knows exactly how much
it has to pay every month or every year when
opting for this solution. The security is also
taken care of by the hosting provider, as are all
the licensing issues for software.

Setting up e-mail access for employees is
then only a matter of configuring Outlook for
POP3 access and creating user accounts via the
hosting provider’s Web interface. Here again,
you can choose from a range of options. 

For instance, you can either choose to go
with an Indian e-mail hosting provider or opt
for a cheaper US one. There is also a lot of legal
jargon to sift through when you make your deci-
sion, and you should always remember to read
the fine print in the terms and conditions.

Depending on the size of your business, and
the number of employees, you can make the
right choice for your e-mail solution. Now, let’s
look at providing a solution for companies that
have between 25 and 100 employees. 

Services
Mention the term ‘business e-mail solution’ and
everyone thinks of Rediff’s and Indiatimes’ busi-
ness e-mail models. Undoubtedly, these are very
popular, but not necessarily the best solutions
for companies with more than 25 employees.
Let’s find out why…

Both Rediff and Indiatimes offer very sim-
ilar services, as you will see in the Comparison
Chart. Unfortunately, what they offer is just
plain e-mail addresses—no hosting, no domain,
and in fact, sometimes even the domain is not
registered in your name, though you pay for it. 

We compared them to GoDaddy.com’s most
basic offering to see whether it made any sense
to opt for these popular e-mail hosts. As you can
see, if your company has no more than five
employees, GoDaddy works out to be a little more
expensive. On the other hand, when you consider
buying even a minimum of 50 e-mail addresses,
the Indian solutions lose out completely. 

If you opt for
GoDaddy’s services,
remember that with the
Premium e-mail option
there is no domain
name included, so that
will be an additional
cost.

The ideal solution
seems to be to buy the
domain name from
GoDaddy.com, and then
buy the Web site
hosting as well. When
you buy even the most
basic Web site hosting
package from
Godaddy.com ($3.95 a
month or about Rs
2,000 a year), you are
given 100 e-mail IDs
with 500 MB space
absolutely free. 

Essentially, if you
are buying a new domain, all you need to do is
buy hosting and the business e-mail is pro-
vided at no extra cost. The only difference is
the smaller mailbox size of 5 MB per user! You
still get all the features of the premium plans
as well, such as spam filters, virus checks,
POP3 access and even Web mail…

In Summation
As you have now seen in this article, getting per-
sonalised e-mail addresses can hardly be con-
sidered expensive anymore; and it doesn’t
require a Linux guru to set up. The Web inter-
face means that anybody with just basic
Internet experience can start setting up e-mail
accounts for your employees.

The fact that the solutions mentioned here
cost next to nothing should make you consider
opting for an outsourced e-mail solution for
your business. Remember, you can’t make any
more excuses now; it’s time to  do away with
that amateurish appearance by giving your busi-
ness the professional look it deserves! 

robert_smith@thinkdigit.com

GoDaddy’s e-mail solutions are much cheaper for those
with more than 50 employees
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We never sidestep security—smart cards are
used across our seven locations in India.
Travel being frequent, it’s mandatory for

employees to carry individual smart cards. Entry
into the main office is enabled through smart
cards. Our server facility is secured through a two-
step access mechanism—using smart cards and
biometric fingerprinting for enhanced security. 

Only select personnel have secure access to the
server facility. To log in, employees swipe the smart
card and press their thumbs on the biometric
fingerprint reader. Having a LAN interface, the
smart card and biometric fingerprint devices can
be networked without a computer. 

Apart from employee identification, log in and
log out data, ‘timestamps’ are recorded in a
centralised Human Resource Information System
that captures online, real time data generated
nationwide, which can be accessed by the HR
department from anywhere. Since they are long
lasting and virtually maintenance free, smart
cards are indeed a smart choice. 

At present, the deployment of access
cards—proximity or smart—is limited.
However, we are in the process of

installing the access control system across
the company. Since we are a television
channel (CNBC-TV18) and a production
house, we have a fair amount of expensive
equipment and gadgetry that needs to be
kept away from unauthorised individuals. 

Another problem is that certain areas in
the office that are not in use through the day
end up becoming meeting points, specifically
server rooms and editing bays. Access control
systems and smart cards will enable us to
track the movement of employees in our
restricted areas. 

Installing a smart access system with
restricted entry levels would prevent this
occurence. If need be, the concerned
departments could also get a report of an
individual’s movement in office premises. 

This would obviously increase productivity.
As far as TV18 is concerned, rights to access
different areas are decided by the
Administration department, while the
implementation is done by the Systems and 
IT department.

Piyush Gupta
GM Operations, 
Television Eighteen 

Satish Mohan
Head—Engineering,
Red Hat India
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Smart cards are being increasingly implemented in the workplace to record employee
attendance, track their intra-office movement and maintain security. Is this just about
security or is there more to it?   

Smart Access



123SEPTEMBER 2005 DIGIT

Captain Sailesh
Head Security Systems,
Standard Chartered 

G Gopinath
Director of Rooms,
Grand Hyatt (Mumbai)

Zicom provides various corporations with security solutions.
With regard to access control systems, the most common ones
in use are proximity and smart cards. A great deal of

information regarding the bearer can be carried on a smart card.
They can also be programmed and customised depending on the
client’s need. 

We have set up and are maintaining the entire access and smart
system at iFlex. Here, apart from the usual attendance records, the
card also carries canteen credits of an employee. This allows an
employee to simply hold his card against a reader and the requisite
amount is deducted. The card, of course, is topped up with the
employee’s canteen allowance at the beginning of every month. 

The normal employee attendance and access permissions are also
programmed into the card’s chip and because of the centralised
nature of administration, records of an employee are constantly
updated in real time.

Dipayan Kar
Manager—Sales,
Zicom Security Services 

Any security or access system set up for an organisation like ours
needs to perform multiple functions. We have a number of critical
locations on our premises. Each has various levels of restrictions. 

It is therefore imperative for us to have these restrictions embedded into
the system. 

All the staff members at StanChart carry an Access Control card. This
takes care of the daily attendance muster and also generates reports on
areas visited by an individual. The card readers situated at various critical
and strategic locations in our office are connected to a central server
where these reports can be generated. 

These reports come in handy when it comes to ensuring that we have
a secure set-up, which is a must for a bank, and also with respect to
complying with the various Audits we conduct.

As told to Mithun Kidambi
(mithun_kidambi@thinkdigit.com)

Control
The Grand Hyatt has been using smart cards since March 2004.

Although our staff doesn’t use these cards for their daily access and
attendance, we use them in guest rooms and residences. 

The card is used as a room key that allows touchless opening of the
door. By using this technology, hotel management can trace up to 150
opening and closing actions of a particular door. Due to the details
entered of the opening and closing action, valuable statistical data can
be gained. Lock installation schedules can be created and administrated
flexibly with very little effort. The connection to other data pools via
suitable interfaces enables a more cost-effective total management of the
hotel due to faster sharing of information between departments.

The system also provides for a very high level of security. Also, every
key is easy to replace and we can disable a lost key easily. This is the
latest in room security and service and is in use at all the top hotels
worldwide. Entire system is monitored by the Security department and
administered by Front Office department.
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Renuka Rane

Have you ever used a gently
sloped keyboard that gives
you better comfort while

typing? Ever noticed how the
ergonomic design lets you
place your hands, wrists and fore-
arms in a natural position for
greater comfort? 

Ergonomics entails matching
the design of physical devices to
the needs and characteristics of
the human body. The term is
derived from the Greek words
‘ergon’, meaning work, and
‘nomoi’, meaning natural laws—
in other words, the study of
any man-machine interface,
whether physiological or
psychological. Keyboards and
mice that take ergonomics
into consideration are
designed to be as comfortable
as possible. They increase

productivity, reduce operator
fatigue, and improve the work
environment.

Edging Towards
Ergonomics
Ergonomics is becoming increas-
ingly important in the design
and use of computer peripherals.
Most conventional keyboards
cause painful and even perma-
nent injuries to the spine, fin-
gers, neck and wrist joints.
‘Overuse’ injuries and cervical
spondilitis are some of the per-
sistent hazards associated with
poor computer ergonomics.
Hence, most ergonomic key-

Technology Beyond Work130 160
Leisure
Digital

boards aim to get the hands and
wrists in the right position.

Keyboard makers have devel-
oped a variety of alternative,
ergonomic keyboard designs to
improve work performance for
users, protect them against Repet-
itive Stress Injury (RSI) and
thereby bring down professional
hazards to a minimum. 

Moninder Jain, country
manager, Logitech India, says,
“Comfort is usually a personal

Touched By Tech

143Let’s Play,
Gentlemen

Illustration Akhilesh Prasad

Ergonomics At Work

An All-Round
Genius

Time To Roll
Over

Improve your typing safety and performance—use ergonomically designed keyboards and mice



in the QWERTY format. The
Dvorak layout is an alternative to
the familiar QWERTY. But despite
the advantages of the Dvorak
layout, QWERTY has remained
the de facto standard. 

“I don’t routinely recommend
Dvorak to RSI patients, but encour-
age them to try out various modi-
fications to see what works for
them. At the very least, when they
first make the switch, the unfa-
miliar layout slows them down,
and assists the healing process in
injured arms and wrists,” says Dr
Deepak Sharan, a Bangalore-based
orthopaedic surgeon, who also
provides consultancy in Ergonom-
ics/RSI (and offers rehabilitation)
to top IT companies in India. 

Dr Sharan feels, “In general,
any design that promotes a
neutral posture of the wrist is
helpful. However, like every other
ergonomic tool, different people
respond differently to the same
product, and it’s impossible to
make generalised recommenda-
tions for everybody.”  

Preventing Injuries
The Carpal Tunnel Syndrome
(CTS) and RSI are caused by a
continuous stressful motion of
the fingers, wrists, elbows, shoul-
ders, back, and neck. Soreness,
numbness, a tingling feeling and
wrist pain are other symptoms.

“Over 75 per cent of IT profes-
sionals in India report
musculoskeletal
symptoms of
varying sever-
ity at work,”
says Dr Sharan.
Srikant Makarani,
underwent myotherapy
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treatment to heal a painful wrist
consition. Makarani feels that
had he used an ergonomic
keyboard and mouse at the
outset, the problem would not
have been so severe. 

Makarani, has now switched
to the Microsoft Natural Keyboard
Elite series, and vouches for the
comfort they offer over conven-
tional keyboards. 

Neeru Pahwa has been in the
IT industry for the past seven
years. An engineer with an MNC,
she is on leave to recuperate from
RSI. Pahwa says, “A year ago, I
developed a painful sensation in
my wrists. At first, most doctors
could not correctly diagnose the
reason for the injury. It was very
frustrating. In a few months, the
pain extended to my shoulders
and neck. And now, it has
affected and worsened the nerves
as well.”

At present, Pahwa is under-
going daily treatment for her
ailment. She strongly feels that
increased awareness about
ergonomic devices coupled with
information on correct posture
will spare others from facing a
similar predicament.

Preliminary findings from 
Dr Sharan’s four-year study on RSI
have revealed the following predis-
posing ergonomic factors respon-
sible for computer-related injuries
(percentage-wise):                               
Lack of appropriate breaks (86),
improper monitor height (60),
mouse being too high (54), resting
the arm or wrist on a hard surface
while typing (42), keyboard being
too high (40), and bizarre leg posi-
tioning (25).  

Safety And Health 
Dr Sharan feels that ergonomics
primarily play a preventive role—
an important role, but one that
cannot compensate for ineffi-
cient management or ineffective
practical training. 

He says, “While inadequacies
in the ergonomic design of key-
board and mice do not seem to
be major factors causing RSI, we
do encourage our patients to try
out the various input devices
available and see which one
works for them.”

He goes on to add, “One fun-
damental problem with the
design of alternative keyboards
and mice is that it initially feels
good because the stress shifts to
parts that aren’t injured yet.
However, it does not address

factor. However, there are specific
design traits that can determine
how comfortable a keyboard is.”

Jain adds, “Research indicates
that the keyboard height and
slope can increase wrist exten-
sion, thus increasing the risk of
hand, forearm and upper extrem-
ity discomfort. As a result, you
might want to consider a thin and
flat keyboard design.” 

“The Logitech Cordless Desk-
top LX and MX family of
keyboards, for example, are all
22.3 mm in height. They also
feature ‘zero degree tilt’, which
means the primary rows of keys
are all at the same height. Also,
keyboards that offer navigation
controls complementary to those
on the mouse also have
ergonomic benefits,” says Jain.

Indeed, in most ergonomic
keyboards, the key mechanisms
have become flatter and lighter,
and require less force. An ideal
ergonomic design should elimi-
nate the inadequacies of the
keyboard and mouse. It should
be flexible to meet unique user
needs, in regard to dimensions
and otherwise, of all users. 

Ergonomic input devices let
you adjust your position more
easily and stay further back
from the screen, aiding flexibil-
ity and easing stress on the eyes,
back and shoulders.

Basic Inadequacies
Have you noticed that the rows of
alphanumeric keys on the key-
board don’t line up in columns?
This arrangement was first intro-
duced in the mechanical type-
writer to prevent the levers from
colliding. Obviously, this design
serves no function on an elec-
tronic keyboard. 

There is no particular justifi-
cation for the layout of the keys

Balance your head above your torso: 
don’t roll your shoulders or neck forward
Place your monitor at a comfortable 
reading distance, just below eye level, 
tilted up a little, and free from glare
Place your keyboard and mouse on a 
tray so you don’t need to reach up 
to them
Keep your keyboard lowered and angled 
slightly away (negative pitch)
Keep your elbows close by your side: 
don’t reach out. The elbow should be at 
an angle of 100 to 110 degrees

Don’t bend your wrists up or out
Don’t rest your elbows or wrists on 
anything while typing - no armrests or 
wrist rests.
The feet should be placed firmly on the 
floor. Otherwise, use a footrest
The back should be supported against 
the chair’s backrest
Take a micro break: five seconds every 
five to seven minutes
Take a macro break: two minutes every 
30 to 40 minutes

Tips For A Balanced Computing Posture

Courtesy: Dr Deepak Sharan

Any design
which
promotes
a neutral
position of
the wrist is
helpful”

Dr Deepak
Sharan
Orthopaedic
consultant

The Logitech V500 Cordless
Mouse has an expandable chassis 
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some of the root causes of RSI:
repetition and static positions.” 

Take Your Pick
Alternative keyboards promote
neutral wrist postures. They use
different designs to change the
user’s posture. By and large,
designs try to tackle the issue of
wrist extension. 

For instance, fixed split key-
boards try to straighten the wrist
by increasing the distance
between the right and left sides of
the keyboard so that each half is
aligned with the forearm.

A complementary ergonom-
ic mouse allows you to work
comfortably for hours by keep-
ing the hand in a neutral posi-
tion. For instance, in the
Logitech V500 Cordless
Notebook Mouse, the patented
expandable chassis articulates
seven degrees to fit the hand
while in use.

Then there are multi-touch
fixed-angle split keyboards with a
touch sensitive surface, wherein
with a few finger gestures you can
issue multiple commands. Multi-
touch software can track and
interpret the motion of several
hands—and their corresponding
fingers—at a time.

In some designs, keyboards are
completely split (www.kinesis.
com). Vertically split keyboards
require the user to type with the
hands facing each other (www.
safetype.com). The Orbitouch
keyboard (www.keybowl.com) lets
users rest their hands on two
domed surfaces and then move
these surfaces to generate charac-
ters. Hunt-and-peck typists may
need time to get accustomed to
using such keyboards; touch
typists are easily able to adjust.

Increase In Productivity
Many designs result in demon-
strable productivity improve-
ments, with users improving
their overall work speed.

For instance, some key-
boards have one-touch buttons
that take you directly to the
most used programmes. By

merely pressing a single button,
you can start many of your
favourite media applications,
navigate videos and comfort-
ably adjust settings. 

In India, Microsoft (www.
microsoft.com) has introduced
special curved and split
keyboards in the Natural
Keyboard Elite series. The
keyboard is split into two, as a
result, only minimal movement
is needed to hit each key—and
the hands move very little. 

Ergonomic keyboards offer
health benefits, as we’ve
mentioned earlier. Still, the ubiq-
uitious conventional keyboard
has the largest number of takers
because of its low cost. 

Nevertheless, this equation
will change as businesses find
that ergonomically-designed
input devices increase productiv-
ity and offer less risk of injury.
Such devices could certainly
become the norm one day. 

If you spend a lot of time at
your computer, a keyboard featur-
ing cordless technology, a
comfortable design and conven-
ient controls, along with a
complementary mouse may be
worth the extra expense. 

renuka_rane@thinkdigit.com

The Dvorak layout is an ergonomic alternative to QWERTY
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“What is life but a game of cricket,” asks
the opening screen of Brian Lara
International Cricket (BLIC) 2005. You

may agree with that, but unfortunately, this game
is no substitute for the real thing.

To be fair to the Codemasters, the creators of
this game, no cricket game has been able to
emulate the true feeling of playing cricket, but BLIC
2005 comes the closest so far. The graphics are
great, as is the gameplay, but the player details and
commentary leave a lot to be desired. 

Match Time
Before you can actually start playing a match, you
have options to choose from… lots of options.
Choose between a Challenge Match (England v
Australia, 1887), World Series (multi team ODI
Series), World Tour (Test and ODI series) and World
Cup. We decided to pit India against Australia in a
four-match Test series and six-match ODI series.
Incidentally, six is the maximum number of ODIs
you can choose in this mode.

That done, another options box popped up
asking about the level of matches. Your choices are
‘Village’, ‘County’ or ‘Test’, with ‘Village’ being the
easiest and ‘Test’ the toughest. In this box itself, you
can also define the conditions for the match (Good,
Warm, Humid, Cloudy), pitch (Hard, Damp, Dry,
Crumbling) and the condition and make of the ball
(Kookaburra, Dukes and Club).

The next choice lets you pick your playing 11. All
Test-playing nations are included in the game, and
there are 16 players in each squad. The names of the
players have been garbled—perhaps due to licensing
issues. So Glenn McGrath is G MacGirth, Shane
Warne is S Worde and so on! You can, of course, edit
these names to put in the actual ones, but it’s a
cumbersome task. Finally, it was time to play.

Gameplay
The match starts off with the toss, and an uniden-
tified match referee accompanies the two captains
to the pitch. Ricky Ponting called wrong, much to
his chagrin, and India chose to bat.

All along, the commentators (David Gower and
Ian Botham were voices we recognised) are
apprising you of the conditions and how “they are
happy to be in the commentary box”.

The Match
J Guisseppe (Jason Gillespie) was the first to mark
his run-up. Among all the players, his was the face
that had the maximum resemblance to a real play-
er. As he runs up to bowl, we are scurrying to find
the controls. By default, [W], [S], [A] and [D] are the
controls during the game, and are also used to
manoeuvre back and forth between screens when
setting up the game.

There are three vertical bars on the bottom left
that tell us about the bowler’s confidence level,
the batsman’s confidence level and the timing
of a shot.

Confidence levels for bowlers and batsmen
change throughout the over, depending on how
many dot balls are bowled, or how many times the
bowler beats the batsman. Similarly, for the
batsman, they rise with every run scored or every
boundary hit. Normally, as one rises, the other falls. 

Gillespie lets the first one rip outside the off
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No, that’s not Lord’s. That’s the Motera at Ahmedabad

That’s the start of your challenge...

Field settings can be altered, but you cannot move one
fielder from a preset. You need to set the whole field

Let’s Play, Gentlemen
Not exactly the real thing, but Brian Lara International Cricket 2005 is by far
the best of the lot available
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stump and Sehwag connects pushing it through the
covers for one, getting India off the mark.

The ball is picked up in the deep and fired in
straight to the ’keeper right over the stumps. To
throw, there is a meter that has to be met right in
the centre for a flat, fast and accurate one. By
default, if you don’t interfere, the throw will be a
looping albeit accurate one.

We realised that judging a run takes some time
since the default (and only) angle of viewing the
match is not the usual 45-degree angle that shows
you the field at large. Rather, the cameras are at a
30-degree angle, from where you can only see the
umpire and ’keeper. And Sehwag ran three batsmen
out. Oh well!

On the whole, batting is not tough, and once
you get used to reading the three different meters,
you can easily judge what to do. Another little
marker in the middle of the pitch shows where the
ball is going to pitch and the general direction it
will move in. There are times, though, when this
can totally bamboozle you. It can show ‘good
length’ and suddenly be a half tracker. Watch out!

Look And Feel
The graphics look good, and the interface is rather
well done. But although details on the ground are
good, stadium layouts are not very realistic. An
appeal for an LBW that is turned down is explained

in the replay using Hawk Eye. The
same technology is also used to
show a bowler’s performance
after every over. This is indeed
realistic. Replays are also shown
after every boundary, using about
five different camera angles.

Characterisation
Bowlers are the most animated of
the characters on the field, and
also indulge in the occasional
banter or sledging. Batting skills
deteriorate as you go down the

order, and the tailenders are prone to the odd
swipe across the line leaving them vulnerable to
the swinging ball.

Create A Player
BLIC 2005 also lets you create a custom player that
you can add to any team. The player can be
customised to be a batsman, bowler or all-rounder,
and his skills with the bat can also be customised.
You can then give him a face, choose his kit (good
choice here) and define if he is stronger on the off
or the on side.

Conclusion
Considering there are only two real options
available for the cricket fanatic—EA Sports’ Cricket
2005 and this—we would recommend you choose
BLIC 2005 for the graphics and smoother gameplay.
While most other features would match, this game
is a tad better than the competition. None of them,
however, are up to scratch, and we hope they get
a lot better.

aditya_kuber@thinkdigit.com
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1. GTA Vice-City
Rs 1,299
E-xpress Interactive Software Pvt Ltd

2. GTA San Andreas
Rs 2,999
E-xpress Interactive Software Pvt Ltd

3. EA Sports Cricket 2005
Rs 999
Gayatri Impex

4. Brian Lara Int’l Cricket 2005
Rs 1,299
Origin Marketing Pvt Ltd

5. Counter Strike Condition Zero
Rs 699
Universal Music India Pvt Ltd

Brian Lara International Cricket 2005
Publisher Codemasters Price Rs 1,299 Web site www.codemasters.com
Minimum requirements Windows 98SE/ME/XP/2000, DirectX 9.0c,
Pentium III or Athlon at 1GHz, 256 MB RAM, Supported Graphics card,
DirectX 9 Compatible Sound Card, 8x CD-R Drive, 4.4 GB HDD Space
Distributor Origin Marketing Pvt Ltd

Match settings can be adjusted in 
relative detail 

Like your shot? Take another look. At
least five angles are available

Create a new player and decide what
he’s going to be good at

Scorecards are good and detailed—
batting, bowling and summary

Catch the throwing meter in the 
middle for a flat and fast throw

You can create custom teams of your
choice and play against friends
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CASIO EXILIM Z750

The Casio Exilim Z750 may not be the ‘newest’ sensation
around, but it is a sensation nonetheless. A couple of

years ago, Casio launched the Exilim
range, touted as the slimmest and
most compact camera available. Even
today, that billing stays. These
stunning works of art are now adding
to their capabilities and the Z750 has
a whopping 7.2-megapixel CCD. Makes
you wonder how they manage to keep
the camera so slim…

What will further make you
wonder how is when you find out
that the camera also has 3x optical
zoom, a 2.5-inch TFT screen and an
optical viewfinder.

You’ll now need to really stretch your
imagination to figure out how a very slim battery in a
very slim camera can capture 325 images per charge. Well,
it does. So there… you don’t really have to worry about how
long the battery will last and whether this is just a good-
looking camera.

Further proof that this beauty does indeed have brains
is the fact that there are 30 preset

best shot scene modes. All you need to do is set it and
shoot. But wait—there’s more.

In-camera special effects allow you have some fun and
not capture just photos. Speaking of not capturing just

photos, did we mention that you can also shoot MPEG-4
movies at up to 640 x 480 pixels at 30 frames per

second? No? Well, it can! Just so you know,
this is DVD-quality video. 

Ergonomically as well, the camera is
well-designed and features an EX
button to allow quick access to shooting
controls. Once in the controls, you can
also make the most of the post-shot
white balance and exposure
adjustments to make sure your photos
are looking their best.  

The Exilim Z750 is in competition with
cameras such as Canon’s SD500 and Sony’s
DSC-P200 in one of the most fiercely

competitive segments of the market and
offers by far the largest feature set in its class.

Priced at approximately Rs 19,000, this is one
camera that offers great value for money and is perhaps
the most stunning gift you could give anyone. Do you
know our address?

NIKON COOLPIX 5900

The megapixel count of digital cameras is ever on the
increase and today, a 4-megapixel camera is perhaps more

the norm than an exception. Digicam prices have fallen beyond
imagination, and a 4- or 5-mp camera is within reach for most.

One such camera that fits the bill for most casual users is
the Nikon Coolpix 5900. A 5.1-megapixel camera, the 5900 has
3x optical zoom, 13.5 MB of internal memory—and the Nikon
tag! What’s better, all this is available for just Rs 14,000!
Could you ask for more? Even if you did, there is!

The Coolpix 5900 combines state-of-the-art technology,
great image quality and speed with an all-metal design, and
is an eye-catcher. At the back of the camera is a big two-inch

LCD screen, the biggest yet in the
Coolpix line-up, and the
new Face-priority AF
feature.

Also inbuilt is the
D-Lighting feature that
can be selected in
Playback mode—
automatically
compensating for
insufficient flash or
excessive backlighting. It
ensures balanced
exposure throughout the
frame.

The Coolpix 5900
can also shoot VGA movies with sound at a

rate of 30 fps. Available across the country, the product
retails at approximately Rs 14,000 and is great as a gift—for
yourself or for your near and dear ones.

SONY DCR HC 90E

If you’re looking for
more than stills and

are interested in
venturing into the
moving-image arena,
here’s one product you
should consider: the
Sony DCR HC 90E.
With 10x optical and
120x digital zoom, this
camera is farsighted!

Armed with a Carl Zeiss Vario-
Sonnar T* lens, the clarity when you
capture the 530 lines of horizontal resolution is
simply stunning. The optics on this little baby are a treat
and perhaps the best available.

Features-wise, too, the camera packs a punch. It has a
2.7-inch wide touch panel swivel screen that rotates up to
270 degrees to provide multiple viewing angles. The truly
‘steady shot picture stabilisation system’ stabilises
without compromising on picture quality.

One great thing about this camera is the Analogue to
Digital converter that lets you connect any analogue
video source to digital using the provided inputs. But this
is not just a camcorder—you can also shoot stills at a
resolution of 2016 x 1512 (about 3 megapixels). 

Another thoughtful addition that would be of great
help to non-tech savvy users is the ‘Easy Handycam’
button. With a press of this button, most advanced
features of the camera are ‘locked out’, leaving
operational only the buttons essential for recording. 

Priced at about Rs 51,500, this is one great deal.

Tech Shopping

Rs 14,000

DIGIT SEPTEMBER 2005
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Rs 19,000

Rs 51,500
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BATTLEFIELD 2

Yet another war game, you’d grumble, but
hold on to your horses for a bit! Battlefield

is truly a game that’s in a class of its own.
This, of course, does not mean that its
predecessor was a shoddy offering. 

In Battlefield 2, players pick a side. It could
be one of three military superpowers: the
United States, China, or the newly formed
Middle East Coalition. Of course, if you’re
fighting for a superpower, you have the
latest modern weaponry. That means you
can control over 30 different types of
vehicles in combat and, here’s the best part:

you can engage over 64 players in
major battles. All of this over the
Internet. Is that one major war in
cyberspace, or what? 

A very interesting feature of the game
is the persistent character growth
possibility. This allows a player to literally
rise through the ranks and eventually
attain the rank of General. Talk about fair
and equitable promotion and
acknowledgment for your achievements.
Guess real life could draw inspiration from
the gaming world.

Battlefield 2 has a new game engine as well
as an new, improved physics system that
makes all the graphics seem realistic. Not
that you’d care about a new or old engine as
long as the game looks and plays good. The
game also brings about a lot of realism,
detailed environment and realistic maps. The
situations faced by a soldier in a battlefield
are also reproduced very well.  

We could just keep on and on about the
game, but it’s for you to play and experience.
Do we recommend a buy? By Jove, we do—and
at Rs 1,299, it’s quite a bargain.

EA SPORTS CRICKET 2005

T his is India, so whatever we do
will be influenced by the local

flavours. “If it’s sport, it has to be
cricket” sounds like a cliché, but
that’s the truth. So if any games
producer is looking for a bestseller in
India, they have to come out with a
cricket game. 

EA has been doing that over the
years with their Cricket series and
even though it has been way below
par as far as serious gamers were
concerned, they managed to reach
the bestseller charts. 

This time round, though, EA has
decided to give a fair deal to the
Indian gaming community. So the
latest cricket offering has a TV-style
presentation including a full action
replay mode, a third umpire,
animated ducks, TV-style overlays,
and a field position editor, among
other things. In addition to the
international teams and bonus
squads, you can also compete in the domestic seasons in
England, Australia, New Zealand and South Africa. 

Of course, you have a large number of stadiums, pitch types and
playing conditions to choose from. What is really new is the gameplay
with completely reworked graphics. Though the gameplay is realistic, the
character modelling leaves a lot to be desired. 

And yeah, mastering the game is as difficult as the real thing. So you
can check out this Rs 999 offering from EA while we work on our timing! 

GTA SAN ANDREAS - VICE CITY
No, we are not trying to be naughty by recommending this game. Don’t
use the Hot Coffee mod and the game still rocks! 

The latest offering from Rockstar carries on the GTA tradition of
climbing up the gangland hierarchy. You start off as a small-time guy who
has to work his way up the, ahem, gang he’s part of. Hot Coffee lets you
work your way up a lot of other areas! But let’s not go that way, shall we? 

So what’s the story this time round? You play Carl Johnson, a small-
time crook who has his mother murdered and is framed for another
murder by a group of corrupt cops. So you have to be on the run and
come up fast to save your skin as well your broken-up family. 

The gameplay and action are a treat to watch; the violence and sound
effects are very realistic. Though the game has come under severe
criticism from a lot of authorities in the US and a number of big stores
have yanked it off the shelf, we can still buy a legit version in India. 

Available for Rs 2,999, this is the game for you if violence and
experimenting with the underworld is your cup of tea! 

Games

Rs 1,299

Rs 999

Rs 2,999
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PHILIPS HTS3000

This is a model for the masses. A 5.1 home theatre system, this one
sure packs a mean punch. At 94W RMS, it is not an earth-shaker,

but is enough for a small living room. The system looks nice and has
an external amplifier with a 5.1 Audio output, PC/VCD/CD input and
5.1 inputs. 

Bundled is a remote control that handles individual speaker controls.
However, the feature that will attract shoppers is the ability to handle
almost any disk format, including SACDs and DivX CDs or DVDs in
addition to playing regular DVDs, VCDs and MP3 disks. 

This product is priced at a sweet Rs 9, 990, which is enough to tempt
any shopper to get one. Compared to other brands in the same price
category, this system takes the cake, considering the features and
performance. If you’re on a limited budget and looking for a reputable
system, your search ends right here!

SONY DAV-LF1

Let’s get one thing out of the way first: this is a high-end system and
costs Rs 99,990. Still interested? Read on… 
The highlight of this system is that it is wireless. Yes,

now no more wires to disrupt your interiors—well, almost.
The DAV-LF1 still needs a power cord from one of the rear
speakers and another main cord connecting it to the other.
The other speakers require wires as usual. Just place them
where you want, configure the system, and start watching
movies and listening to music.

The system is powered modestly enough at 600 W RMS.
However, it is the drop-dead gorgeous looks of this system
that will attract you more than anything else.

There are four ultra-thin column speakers with one
centre satellite speaker. You also have two wireless satellite
speakers that can be hung on the wall right beside the
centre channel. The subwoofer build quality is solid and is
sure to shock and awe your neighbours at peak volume. 

This may be a pricey system, but hey, if you want to
complement your plasma or projection TV, you just can’t go
wrong with this baby!

SAMSUNG HT-P50

For a user with a budget of around Rs 35,000, we recom-
mend the Samsung HT-P50 home theatre system. This

system has all the frills that you can think of and also
includes a USB port for connecting any USB devices and play-
ing content directly from the system. It also features an FM
tuner for when you just want to listen to radio. The media this
system can play includes DVD Video, DVD Audio, DVD-R (W),
CD-R (W), JPEG, MP3, WMA and DivX disks.

The form factor is extremely classy, with four satellite
speakers and one central speaker and subwoofer. The USB port
lets you connect your portable MP3 player and use it as a part
of your home theatre system. You can now listen to your MP3s
in 5.1 surround!

Inputs include auxiliary, an optical digital input
and the USB port. Outputs include a SCART socket
and composite video output, making it ready for
HDTV as well as regular TVs.

The system has ample power and peaks at 1000 W
RMS, enough for you to make yourself heard across
your building!

At a price of Rs 34,400 the Samsung HT-P50 does
not pinch your pocket too much, and does provide
you with a fashionable home theatre and powerful
features to boot.Rs 34,400

Rs 99,990

Rs 9,990
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ACER FERRARI 4000

A cer’s penchant for speed materialised in the form of
their alliance with Scuderia Ferrari as an official partner

for laptops. To commemorate this alliance, Acer introduced
a series of special-edition Ferrari laptops starting with the
Ferrari 3000 series introduced last year. The Ferrari 4000 is
the latest in this series, sporting a unique blend of cutting-
edge technology and exotic materials.

The 4000 sports a matte-black carbon fibre case with the
prominent prancing horse logo shouting for immediate
attention. The deep scarlet sides of the laptop make the
Ferrari connection come through clearly. Despite being
made of lightweight material, the Ferrari 4000 tips the scales
at 3 kg, which by today’s standards, is a tad too much on the
shoulders (or the lap). 

Acer doles out 1 GB of DDR 333 MHz memory to make
most of your applications zoom by. The 15.4-inch, crisp
display is powered by ATi’s Mobility Radeon X700 graphics
core. To cut down on the thickness, the Ferrari 4000 is
provided with a slot loading, multi-format, double-layer
DVD burner. 

While all common ports such as USB, FireWire, S-Video,
VGA and DVI are available, Acer has
also included a multiple card
reader capable of reading compact
flash (CF), Secure Digital (SD),
Memory Stick (MS) and xD cards.
Wireless connectivity comes in
the form of a Bluetooth and a
Wi-Fi 802.11g adapter, whereas
Ethernet and modem
connectors are provided for
wired communication.

Priced at
around Rs 1
lakh, this is
the gadget to
have if
you’re a
speed freak.

LENOVO THINKPAD T42 

The ThinkPad T42, a worthy successor to the almost-
famous T41 notebook, is the latest in the thin-and-light

series from Lenovo. The ThinkPad laptops have always been
appreciated by professionals for their rock-solid reliability
coupled with good performance, and the T42 doesn’t
disappoint on either count.

Beating at the heart of the T42 is Intel’s Centrino
technology, delivering
exceptional performance without
compromising on battery life. The
T42, like all other ThinkPads, has
the same understated design, with
most surfaces finished in black.

Build quality is top-notch,
and it oozes from every nook
and corner of the laptop. The
metal hinges that clamp the top
lid are tough nuts to crack and
will take the worst fall without
a scratch.

When it comes to the
configuration, the T42 isn’t
spectacular, but has enough
horsepower to get most of your
work done. It comes with a Pentium M processor
running at 1.7 GHz, 512 MB of DDR RAM, a 40 GB
hard drive and a combo drive. The upgrades, though
available, are unreasonably expensive. 

The T42 makes do with just two USB ports, a gigabit
Ethernet slot, a modem, two PCMCIA slots, a parallel port, a
serial port and a VGA port for connecting an external
monitor. Frills such as FireWire or Card readers don’t make
it to this laptop.

The Lenovo T42 comes preloaded with Windows XP
Professional and also boasts of out-of-the-box support for
Linux distributions such as RedHat and Suse. 

Priced at around Rs 1 lakh, the T42 is our choice for the
best executive-class laptop one can buy off-the-shelf.

DELL XPS GEN 2

The XPS Gen 2 from Dell is an exquisite gaming machine
loaded to the gills with features that stand to redefine

gaming on a mobile platform. Based on Intel’s Centrino
platform, it incorporates the latest avatar of this mobile
platform, known as Sonoma. 

Armed with a top-of-the-line
Pentium M 2.13 GHz processor with a
533 MHz front side bus and 2 MB of
cache memory, it has enough juice to
rock your games. 512 megs of DDR 2
memory comes as standard which can be
further upgraded to 2 GB for blistering-
fast game loading speeds. To make
gaming characters come alive, the Gen 2
incorporates nVidia’s best-in-class GeForce
Go 6800 Ultra PCI-Express graphics core. 

All the action can be viewed on the
crystal clear 17-inch display that Dell is
renowned for. Encased in silver-and-grey
plastic, this second-generation XPS laptop has
much better visual appeal. To liven up the
gaming experience, Dell has introduced colourful
lights on the top lid, air vents and speaker vents.
You can assign up to sixteen different colours to
these lights!

It’s not all looks, though. Ergonomics, too, is spot on;
the keyboard is sufficiently large, with a good amount of
real estate on which to rest your palms. 

The XPS Gen 2, being a desktop replacement, does not
fall short in offering the numerous
ports or connectors that a desktop PC
offers. In all, there are six USB ports, a
FireWire port, DVI and VGA connectors
for connecting an external display, and
an S-Video connector for hooking it to
a TV. For online gaming, the XPS
comes with an Ethernet port and
offers wireless connectivity via the
inbuilt Wi-Fi 802.11b/g adapter. Two
unique features are the Secure Digital

card reader and a PCIe card slot. 
If you’re an avid gamer
looking for a portable gaming

solution, this is a godsend.
But if you want to lay
your hands on this baby,
you’d better start bugging

your cousin in the US, as Dell is not
offering this in India yet.

Priced just short of Rs 1.5 lakh, the XPS
Gen 2 is the ultimate gaming laptop available.

Rs 1,50,000

Rs 1,00,000

Rs 1,00,000
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IPOD MINI 

Talk of MP3 players or portable music players and the first
image that springs up is the plain white face of the iPod. The

impact of the Pod has been so great that it has become
synonymous with portable music players. What was it that made
it a cultural phenomenon, a must-have accessory? 

We think
the intuitive
user interface
and a radical
yet minimalist
design might
have helped.
The fact that it
is a hard disk-
based player
means it can
store many
more files than
conventional
portable
players. Add to

this the image Apple had built up over
the years of being a niche über-cool
brand, and you have a winner. Apple also came
up with an online music download service, iTunes.
At 99 cents or around Rs 42 per download, this was a definite steal.
Pity iTunes isn’t accessible from India yet.

Available in different capacities, the Pod that has caught our
fancy was the iPod Mini. With a 4 GB (or 6 GB) storage capacity,
the Mini can hold between 2,000 and 3,000 songs of MP3 quality.
The metallic-coloured bodies also add to charm of this baby,
which is slightly larger than a credit card. 

With street prices starting at Rs 12,000 for the 4 GB variant,
this nifty little gizmo is well within the reach of
any average buyer. Of course, those with deeper pockets can
always go in for the 20 GB iPod or the U2 special-edition ones.

CREATIVE ZEN MICRO & ZEN NEEON

Creative’s MuVo2 never quite took the MP3
player market by storm. Many said it was the

clunky design that did the MuVo in. Not to be
upstaged, Creative has hit back with their
international bestsellers—the Zen Micro and the
Zen Neeon.

With refreshingly new designs coupled
with a 5 GB hard disk, these players are
out to deliver a one-two knockout punch. The
best thing about the players is that
you don’t have to convert or reconvert
your music files into any proprietary format—
something both Sony and Apple players
demand. 

The Neeon’s 5 GB capacity means that you
can store a large chunk of your music

collection on the player; of course, you can
also store other data files and use the player as

a portable drive. The interchangeable covers and
the changing neon backlight add a large dose of pizzaz to the gizmo. So go ahead and co-ordinate your MP3 player with
your wardrobe... and feel free to get right back at us if this showstopper doesn’t catch everyone’s attention!

At a starting price of Rs 15,000, the Zen Neeon is directly aimed at the would-be iPod Mini customer. For an MP3
player that sounds great and makes you look cool, it isn’t too expensive.

IRIVER H 10

They call it the soul machine, one look at the
Ferrari red and metallic colour combination

and you know why. The minimalist navigation
design and the colour TFT LCD screen gets any
gadget lover hooked. A visual treat, you say, plug
in those ear phones and this gadget sings as well.
With a 5GB solid state storage capacity and with
features such as FM recording, voice recording,
photo and text viewing and multiple language
support the H10 is a serious contender for the top
spot in its category. The player has the basic
equalizer modes and 30 preset ones as well but
what is sorely missed was a line in plug, which
comes only with a cradle. The H10 series however
does not offer support to all the different file
types, only the basic MPEG and WMA for audio
and JPEG for image. At Rs 16,000 this is priced at
a premium when compared to the competitors
but for a sub 100gm, pocket sized 5 GB mp3
player we think it just about makes the cut. 

Rs 12,000

Rs 15,000

Rs 16,000
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PALM LIFEDRIVE MOBILE MANAGER

If you need an integrated camera or a cell phone, look elsewhere.
But if you’re looking for a device that can manage your chaotic life

schedule, the aptly named LifeDrive Mobile Manager is for you. 
The device runs on Palm OS 5.4 (Garnet) and is powered by a

416 MHz Intel XScale Processor complemented by 64 MB of onboard
RAM, and offers a whopping 4 GB of storage space. It looks sleek
with a brushed, muted aluminium finish, a big screen (a 320 x 480
TFT touchscreen) and four dedicated buttons for music, photos, home
(main menu) and the file browser, along with four-way navigation
and a centre-click button.

The 65K colour screen is gorgeous.
Multimedia entertainment is provided
by the mobile version of iTunes. Other
pre-installed goodies include the Blazer
4.1 Web Browser and the Versa Mail 3.1
e-mail client. Apart from these, the
software disk provided has some more
cool stuff such as Adobe Reader for
Palm OS and Real Rhapsody 3.0,
amongst others. ‘Documents to Go’
allows you to work with MS Word 
and Excel files.

You can connect the LifeDrive to your
phone via Bluetooth and send and
receive SMSes and make calls. In terms of
connectivity, the LifeDrive has it all:
Wi-Fi, Bluetooth, USB 2.0—but no
infrared. But will you miss it? 

Synchronisation with a PC requires the bundled
application, but you can use it simply as a removable
mass storage drive by clicking a single button labelled ‘Drive
Mode’ on the touchscreen. You can then simply copy and paste files
onto the drive. All files—music, movies, and what have you—that are
added get updated automatically into the media library, and there is
no stifling requirement of using a proprietary software to transfer
media files.

A PDA phone or a camera this device is not, but what it is is a
brilliant organiser and portable entertainment centre that will
organise your life. And it does that job quite beautifully.

At Rs 26,500, it’s not that expensive either. Buy a cheaper cell, and
use this, what?

PALM ZIRE 31

If you’re a first time
user or if a basic

PDA is what you are
looking for, the Palm
Zire 31 is made for
you. This affordable
PDA runs Palm OS
5.2.8, and is
powered by a
relatively modest
200 MHz Intel ARM-
based processor. 

Inbuilt memory is only 16 MB, but
that should be enough for you to store
years of appointments and thousands of
contacts—with room to add software. The S-
DIO slot lets you add more memory, too.
Screen resolution is 160 x 160, supporting
thousands of colours. 

The design is compact and fairly attractive.
There are two hardware buttons that launch
calendar and contacts. You can also reassign
these buttons to applications of your choice. A
five-way navigation key is also provided.

Graffiti 2 lets you input text in natural
handwriting, either in the Graffiti area
beneath the screen or anywhere else on the
screen. You can even use the Zire 31 as an MP3
player, though you would need to invest in an
SD or MMC card for this.

Bundled software includes standard PIM
applications such as Contacts, Calendar, World
Clock, Memos, Tasks, Calculator, Expense, and
Note pad. Additional software included
features RealOne Mobile Player, palmOne
Photos, Audible, Handmark Splash Money and
Mobile DB, powerOne Calculator, Palm Reader,
AddIt, and Solitaire.

At just Rs 9,999, the Zire 31 is surely the
most affordable and easiest way to enter into
the world of mobile computing.

HP IPAQ HW6515 MOBILE MESSENGER

For those who gallivant around the globe, the
new iPAQ hw6515 Mobile Messenger is the

perfect companion. One of the latest PDA phones
launched by HP, the hw6515 Mobile Messenger is
true to its name and keeps you connected no
matter where you are.

Featuring a quad-band GSM phone
(850/900/1800/1900 MHz), the device also supports
GPRS/EDGE technologies, which provide high-speed
connectivity on the go. 

Boasting of an internal GPS receiver, the iPAQ
hw6515—coupled with GPS software and digital city
maps—is capable of pinpointing your exact location
and provides you with turn-by-turn driving instructions.
The integrated QWERTY keyboard allows you to easily
compose e-mail, notes, text, and instant messages. The
inclusion of two memory slots—one SDIO and one mini-SD—
allows expansion of memory as well as installation of
expansion cards such Wi-Fi, barcode scanners and more.

What’s more, you also get a 1.3-megapixel HP Photosmart

Camera inbuilt so you can capture stills and
videos—and share them instantly via MMS or e-
mail. 

Running Microsoft Windows Mobile 2003
Second Edition, the hw6515 is powered by an
Intel PXA270 Processor running at 312 MHz
complemented by 64 MB of ROM and 64 MB of
SDRAM. The 240 x 240 transflective touch
screen can display 64K colours.  

Connectivity options include Bluetooth v1.2,
Infrared and USB using the bundled cradle. The
1200 mAh rechargeable Li-ion battery is user-
replaceable.

HP has also bundled exclusive applications
like iPAQ Wireless, GSM/GPRS Settings Manager,

HP Profiles, MMS Composer, Bluetooth Manager,
iPAQ File Store, iPAQ Backup, Pocket Panel Lite,
and HP Image Zone for Pocket PC.

The package includes a removable flip cover
for the screen, as well as a belt clip so you can carry it
around wherever you go. Priced at Rs 29,990 excluding taxes,
this is one workhorse you should seriously consider.

Rs 29,990

Rs 26,500

Rs 9,999
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SONY ERICSSON K750I

This is the latest flagship model of Sony Ericsson’s extensive mobile
line-up in India. A one-line description would probably go: a tri-band

GSM phone with a 2-megapixel camera, FM radio tuner and an MP3
player, with a Memory Stick Duo (MSD) card slot. 

The K750i is stylish, but not overly so, making it a good phone for
professionals. The buttons have decent tactile feedback,

but the five-way joystick is too sensitive and results
in navigation errors—until you get used to it!

The camera is perhaps its best feature, and is
accompanied by a pretty decent flash. There are
various digital camera options such as 4X zoom,
Macro mode, night mode, a cool Panorama mode for
shooting wide scenes, and even a Burst mode for
capturing four shots in quick succession. In movie
mode, you are offered the option of either shooting
for MMS or high-quality video. Overall, the camera
is excellent.

Special controls include a media button on the
left, which launches either FM or your media

player. On the right are volume controls
that double up as zoom controls
when in camera mode and as the

shutter button for the camera. Above
the joystick is an application button

that gives you quick access to various
functions. In our case, this button let us end hung

games.
The speaker could have been louder, and can hardly be

heard on our noisy crowded streets. You cannot listen to FM
without plugging in the bundled handsfree, and you cannot set the
phone to ring both via the external speaker as well as in the handsfree
earphones—only when set to silent mode does it ring in the ear! 

Connectivity is achieved via Bluetooth, GPRS, infra-red, and the
bundled USB cable. Overall, the phone is great to use, has tons of
functions, a great camera and excellent battery life of about three days
normal usage. At Rs 19,995, the price may be a little steep, but the
camera makes it worth it.

SAMSUNG SGH-D500

Measuring just 93.5 x 45.7 x 23.6 mm and
tipping the scales at just 99 gm, the D500

is the latest head-turner from Samsung. A tri-
band GPRS mobile phone, the D500 boasts of
features like a slide-out keypad, MP3 playback,
external speakers and a 1.3-megapixel camera
with flash.

Encased in a beautiful glossy
black casing, the device sports a
176 x 220 LCD that can display
262,144 colours. Apart from the
screen, the front facia includes
a four-way navigation key with
a centre button, two soft keys,
a send and hang-up key, and a
cancel button. The left side of
the phone has a conjoined
volume control key and an IR
port, while the right side has
a dedicated camera key and a
port to connect the external
speaker. The bottom of the
phone slides out to reveal the
backlit 12-key numeric pad
and the camera at the rear. 

Connectivity options
include Bluetooth, USB and
SyncML apart from infra-
red. Other features include video
and voice recording, 64 polyphonic
ring tones, SMS, EMS, MMS, e-mail, and
Java 2.0. 

Standard applications such as World Time,
multiple alarms, Calculator, Converter, Timer,
Stopwatch and Organiser (with monthly,
weekly and daily views) are also available.
Three Java games—Forgotten Warrior, Freekick
and Arch Angel are pre-loaded. Memory capacity
is 96 MB, shared dynamically between
applications. However, there is no provision for
memory expansion. 

The 1.3-megapixel camera can capture stills
at a maximum resolution of 1280 x 1024, and
has three different quality settings. The
shooting mode can be set to single, multi,
mosaic or night. The ISO setting can be kept at
Auto, or set to speeds of 100, 200 or 400. 

The flash can be switched off or set to
Auto, Permanently On, or Shoot-Only modes.
Video can be captured in 3gp format at a
maximum of 176 x 144 pixels, again with three
quality options.

In terms of usability, the phone provides a
standard icon-based menu, accessible using
the soft-key and the navigation button. 

The size of the keys is a bit of an issue, and
you’ll have to use the tips of your thumbs to
operate the device. The slider can be operated
easily using one hand. The 262K colour screen
is vibrant. MP3 playback is quite decent using
the inbuilt speaker, and is even better with the
external speaker module. Battery life is average
at best, with the internal battery lasting
between two and three days. 

On the whole, the phone is great for users
who want a sleek model. Price? Just Rs 21,399!

NOKIA 6255 (CDMA)

The Nokia 6255 is perhaps one of the best CDMA
mobiles available in India. For Rs 14,995, it

seems packed to the brim with features as well as
two screens—an external mini screen and the
internal main screen—which are standard in flip
phones today.

The 6255 comes with an integrated VGA camera
with flash, capable of capturing still images as well
as video. It also features 5X digital zoom and a
night mode, as well as a self-timer. The phone is
Java capable—great for all the gamers! 

The main screen is 128 x 160 pixels with 65K
colours. The external mini screen supports 4K
colours. The keys include a five-way joystick and a
user-configurable soft-key plus standard keypad. 

In terms of entertainment, apart from Java
games, there’s the inbuilt FM radio tuner and music
player which supports MP3 and AAC files.

Connectivity options include Bluetooth, infra-red, and a
high speed CDMA wireless data IxRTT connection. There’s the
WAP 2.0 browser, and the Nokia PC Suite is bundled. The Li-ion battery
offers between 100 to 176 hours of
standby time.

Overall, this phone isn’t half bad for its price, and considering that
Indian CDMA consumers have long been demanding a larger variety to
chose from, this is one model that takes a step in the right direction.

Rs 21,399

Rs 19,995

Rs 14,995
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TISSOT T-TOUCH

What do you want in a watch? A
timer, stopwatch, accurate time,

and an alarm, right? How about
maybe a compass, a thermometer
and an altimeter? No, we haven’t
lost our head—such a product does
exist. 

What’s better is that it’s a
touchscreen wristwatch and not
some bulky device you would have
to lug around in a bag.

Also, the fact that it’s good-
looking and has the Tissot label
makes it even more desirable, don’t
you think? The Tissot T-Touch, a first-of-
its-kind wristwatch to include all these
features in a brilliantly-finished chrome-
metal casing is something you simply
must have on your wishlist.

In all, there are eight functions on the watch
including the Altimeter (in feet and metres),
Chronograph (split and add time), Compass, Alarm,
Thermometer (in °C and °F), Barometer as well as Date and
Time (with a choice of 12H and 24H).

Operated by gently tapping on the each of the crystals
underneath the watch face, you can activate any of the seven
functions. This simple feature allows quick access to the
features, unlike in many other watches where you need to
scroll through to access the functions. 

Although the touch-sensitive display is the T-Touch’s main
feature, other features are just as impressive. Of course, most of
these features are useless for the average day in the office. But
if you are an active person with an interest in hiking, climbing,
or swimming, you’ll find these functions very handy. 

At approximately Rs 28,000, the T-Touch is not too expensive
for a watch with so many functions. Hey, you wouldn’t be
buying it to wear it to the movies anyway, would you?

CASIO PRG 80 1V

A nother watch for the outdoor person, the Casio PRG 80 1V, too, packs in
some super features. Scoring over the competition, this watch has a solar

power cell in addition to a normal cell.
One of the main problems in using a watch is trying to view it in the dark. If

you thought Indiglo was the pinnacle of watch lighting, wait till you see this.
The PRG 80 incorporates an Auto EL backlight that automatically deactivates
when the surrounding light is sufficient, and activates it under dim light or
dark conditions. No more fumbling for the light button in the dark—on your
wrist, anyway!

Other features include an inbuilt compass, altimeter, barometer, and
thermometer in addition to the usual world time, stopwatch and timer. Before
you start wondering, yes, there is an alarm. Actually, there are five! 

Of the special features, the compass uses an inbuilt direction sensor to detect
the magnetic north, while a pressure sensor detects changes in air pressure and
converts the result into an altitude of up to 10,000 metres. The Height Gain
function sums all the metres you may have climbed, and you can see the total ascent
at a glance. 

Inbuilt pressure and temperature sensors measure the barometric pressure and the
temperature respectively, giving you all the necessary readouts at the push of a button. 

There are other, basic functions, such as world time, which displays the current time
in major cities and specific areas around the world.

The five daily alarms remind you about recurring events with an acoustic signal at the
time you set. You can also activate the hourly time signal that indicates each full hour. The
damages? About Rs 15,000. Not a bad deal at all!

OMEGA SPEEDMASTER X-33
MEN’S PILOT WATCH

A Quartz watch with broad arrow hands,
tachymeter bezel, sapphire crystal glass and

3ATM water resistance, the Omega X-33 is
something to die (or kill) for!

This watch looks as good as a watch possibly
can. The Omega Speedmaster X-33 simply leaves
you awestruck from the moment you lay your
eyes on it. 

It is equipped with a battery that will last 24
months on the average with the alarm and light
in use. If some of the functions are not used
often, battery life extends to almost 36
months. That gives you six months to
get to the moon at closest passage, a
year on the Martian surface, and
six months to return!
Incidentally, that’s what the
watch has been designed to
endure. What’s earth?

The X-33 is equipped
with a digital readout in
the centre that displays
time, alarm status,
Mission elapsed time,
mission elapsed alarm,
Digital Universal Time
(DigiUT), its alarm, and
yes, countdown and
chronograph.

The dial is covered with a
scratch-resistant sapphire crystal
and is encased in a solid
titanium case and bracelet. You
want the price? It’s about
Rs 1,30,000. What did you expect? It’s
supposed to last a trip to the moon!

Rs 28,000

Rs 1,30,000

Rs 15,000
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The Guardian, August 11, 2005

When Laptops Are A Pain 
In The Neck
JACK SCHOFIELD WRITES about the horrors of an
increasingly wirefree world. What? Yes, the notebook
computer has its negatives thanks to the ergonomic
disaster that it is or so Schofield and Jeremy Clarkson seem
to agree...

Jeremy Clarkson and I seem to have something in common: we’ve
both been laid low partly by our laptops. Physically, if not
financially, he’s much worse off than me. According to his column
in The Sunday Times, he’s visiting an osteopath for a slipped disc,
whereas I’m just having physiotherapy for a cricked neck. But in a
world where Wi-Fi and notebook computers are replacing wired
desktops, this is very likely to become an increasingly common
problem for computer users over the next few years.

Clarkson got the same instructions as me: sit up straight.
When computing, you should
try to keep your ears, shoulders
and hips in line, with the top of
your computer screen just
below the height of your eyes.

“Fine, but I use a laptop
and if I get the screen high
enough, I can’t see any of the
keys,” wrote Clarkson on the
subject.

As a touch-typist, I don’t
need to see the keys, but any

laptop with a fixed keyboard makes it impossible to get both the
screen and keyboard in an ergonomic position at the same time.
To do that, you need to plug in either a separate monitor or
keyboard.

My problem arose partly because of the perfectly natural
tendency to use the fastest machines around, and both my
newest computers - an IBM ThinkPad X31 and an Apple iBook -
were notebooks. Both have Wi-Fi, too, and if you work at home,
you get extra points for staying-home time.

As a result, I’ve spent too much of the past 18 months
slumped over a notebook rather than sitting upright at a desktop.
This helped accustom my upper spine to being in a bad position.
Then I woke up one morning with a cricked neck, and the pain
didn’t go away in a couple of hours, it got worse. And worse.
Soon, the only way I could raise my right arm was using my left.

As someone who has read more than one book on computer
ergonomics, I was surprised to find my physiotherapist so hostile
to notebook PCs. With the keyboard at the correct height, I felt
my typing position was comfortable, and my posture was not
particularly different from the one used when reading books.

However, keen readers can change their posture at frequent
intervals, holding the book in a different position. That’s much
harder to do with a notebook computer, and I haven’t been doing
it. Nor have I been taking 10-minute breaks every hour, which is
something that I tell everyone else to do.

Notebook computer ergonomics are dreadful, and the built-in
keyboards have become far worse as notebooks have become
thinner. Few, if any, now offer keys with decent amount of travel.

There are solutions. For example, if using a notebook for any
length of time, buy a “notebook riser” or ergonomic stand to lift
the screen, or a docking station, and plug in a separate keyboard
and mouse. Wireless versions are a good idea. As I can testify, the
alternatives can be extremely painful.

To read the complete column, go to: http://snipurl.com/mediawise1

NY Times, August 16, 2005

From Blog To Stage, A Pundit
Examines The Power 
Of Politics
LEE PAPA, A blogger, shows his face in “The Rude Pundit in
the Year of Living Rudely,” a one-man show at the New York
International Fringe Festival

Who knew that the Internet would turn out to be a new frontier
for theater; a stage that lets us choose our exits and entrances
while playing any part we please? Everyone with a blog is a solo
performer. And all theatrical forms are blogworthy, from
diarylike realism to explosive satire.

Political theater thrives on the Web. No censorship, no
compromise. Mainstream news media writers and cartoonists
get to shake off time and tone constraints. New talent shows 
up regularly.

The Rude Pundit roared into the blog arena two years ago,
and his audience keeps growing. His ferocious column (subtitled
“Proudly Lowering the Level of Political Discourse”) hurls
analysis and abuse at the war in Iraq, religious fundamentalism,
America’s immigration policies, Congressional scandals and press
timidity (rudepundit.blogspot.com).

The author’s identity is unknown to most readers. Last week,
though, he unmasked himself in a one-man show, “The Rude
Pundit in the Year of Living Rudely,” part of the New York
International Fringe Festival. “He” is Lee Papa, a tall, stocky

young man in his 30’s
with long hippie-
esque blond hair,
who is a writer,
professor and
sometime actor.

Mr. Papa was
seated in a chair with
his back to us when
the stage lights came
up. (“Us” being the
40 or so people who
lounged on couches

and secondhand chairs at Dixon Place, the hip performance
space on the Bowery that looks like a vintage living room.)

Naked, pink-flesh figures were propped up on the wall
behind him. They wore the masks of the famous: Ronald Reagan;
President Bush and the first lady, Laura Bush; Vice President
Dick Cheney; the presidential adviser Karl Rove; and the
conservative commentators Rush Limbaugh and Ann Coulter.
Some had penises, some didn’t. You could hear people asking
whose was bigger. Why did Mr. Limbaugh and Mr. Rove have
breasts instead? And what about Ms. Coulter? Like the versatile
Greek prophet Tiresias, she had been granted breasts and a
penis, but she bested him, she had both at once.

Mr. Papa is a tornado of a writer. So it was refreshing when
he began the show with memories of his adolescence. We’re all
under some kind of blight as adolescents. His blight was Ronald
Reagan, the man who “hounded my life for eight years.” In the
Rude Pundit’s world, Mr. Reagan was the cruel patriarch who set
the world on its downward spiral of greed and aggression.

What followed was a set of free-form riffs, separated by
blackouts. If you have qualms, prepare to feel them now. I felt
fine most of the time, and so it seemed did the rest of the
audience. ... (more)

For complete column, go to http://snipurl.com/mediawise2

MediaWise
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The iPod’s Achilles’ Heel
DAVID CARNOY, EXECUTIVE Editor, CNet Reviews has a few
gripes with the (gulp!) Apple iPod. Yes, he managed to find
some and now he puts them in black-and-white

Before all the diehard Apple and iPod fans get out their
flamethrowers and torch the hell out of me, let me start by saying:
I’m with you, the iPod rules, it’s great, I own one, I bought one for
my wife, and I plan to name my next baby Apple--and not just
because Gwyneth Paltrow did. OK, so I’m lying about the baby part,
but the rest is true. I like the thing--a lot. But at the same time, it’s
not totally for me.

First off, I’m pretty lazy when it comes to organizing my music.
Or, more accurately, I just
don’t have the time to deal
with it. Sadly, I recently
resorted to having someone
else rip the remaining half
of my CD collection--about
200 discs--for me. I used a
new service called Awaken,
which sent me a
preaddressed FedEx box. I
dumped the discs into the
supplied cake boxes and a
few days later got back

three DVDs filled with my MP3-ified tunes and all of my CDs neatly
organized in a giant binder. Awaken, like several other companies
that provide this type of service, charges around $1 per disc for its
deluxe package, which gives you those little extras such as the CD
carrying case.

If you have a substantial CD collection, you’ll easily end up
paying as much for ripping as for the iPod itself. But if you’re
strapped for time, it’s money well spent. But the fact that such
services even exist exposes a dirty truth about Apple’s little white
music player: a lot of iPod owners fail to use their players to their
fullest potential. You know the whole line about how we only use a
fraction of our brain’s power--the same goes for the iPod. I don’t
have any hard numbers, but I would bet, judging from the informal
polling of friends and coworkers, that only about a quarter (or
fewer) of iPod users are really getting the most out of their iPods. I
meet plenty of people who have 20GB models and only have a
couple of gigabytes worth of tunes on them. Their iTunes databases
are a mess, they don’t make use of playlists, they couldn’t care less
about podcasts and audiobooks, and they end up listening to the
same songs over and over. These are the same people who tend to
ask me, “How do I get my friend’s collection off his computer onto
my iPod?”

The long and short of it is that the iPod is a great device, but it’s
wasted on a lot of people. As easy as it is to use, it’s not for
everybody--particularly not for lazy or ultrabusy music lovers who
can’t afford to impulsively download new albums from the iTunes
Music Store at $10 a pop. (An unnamed CNET vice president reports
that he’s particularly susceptible to this phenomenon--especially
after a few glasses of wine--and that iTunes hangovers are nasty,
even for VPs).

Ironically, the biggest chink in the iPod’s seemingly
impenetrable armor is users’ failure to take full advantage of it. 
And that’s exactly why I’d venture to say that ultimately the way for
any manufacturer to truly challenge Apple will require both an
elegant hardware solution as well as a revolutionary, new music-
delivery system. ... (more)

For the complete column go to: http://snipurl.com/mediawise3
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AdWise

Lost?
The age old way of taking directions on a piece of paper has
been enhanced by technology. That’s the point this ad
makes and it does well. The reference to directions on a
paper in the background with the same directions on the
new Garmin device in the foreground connect instantly.

Tech For Babies
Neonatal monitors that are created around a premature
baby’s first few days is what this ad is for. Add to it the
tagline “sense and simplicity” and we have a winner. Tech 
at its best.
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To use a stock phrase,
it’s a delicious irony.
Google’s chief

executive Eric E Schmidt is
miffed at the fact that
CNETNews.com published
personal details about him—
details that became available
through a Google search.

In the first week of
August, Google told
CNETNews.com, a
technology news Web site,
that they would not answer
any questions from CNET’s
reporters until July 2006.
This move came after CNET
published an article in July
that discussed how Google
can uncover personal
information, and which
raised questions about what
information Google collects
about its users.

The article, by Elinor
Mills, a CNET staff writer,
gave several examples of
information about Google’s
chief executive Schmidt,
which could be gleaned

from the search engine.
These included that his
shares in Google were worth
$1.5 billion (almost Rs 6,525
crore), that he lived in
Atherton, California, that
he had been a fund-raiser
for Al Gore’s presidential
campaign, and that he was
a pilot.

After the article
appeared, David Krane,

Google’s director of public
relations, called CNET
editors to complain, said
Jai Singh, the editor-in-
chief of CNETNews.com. 

“They were unhappy
about the fact that we

used Schmidt’s private
information in our story,”
Singh said. 

He added, “Our view is
what we published was all
public information, and
we actually used their
own product to find it.”
Singh also said Mr Krane
called back to say that

Google would not speak to
any reporter from CNET 
for a year.

Singh, who has worked
in technology news for more
than two decades, said he
could not recall a similar
situation. “Sometimes a
company is ticked off and
won’t talk to a reporter for a
bit,” he said, “but I’ve never
seen a company not talk to a
whole news organisation.”

Think you have the most beautiful,
most innovative desktop around?

E-mail with subject ‘My Desktop’
and your postal address to
mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm,,  and
Digit will publish the most 
eye-catching of them each month.

There is no winner for this month. The majority of entries we
received used desktop theme packs. This is not allowed!

My Desktop

Ah! Those
ubiquitous

devices that all of
us draw out of our
pockets like
gunslingers and
shoot off calls and
messages to
anywhere in the world… but
wait! It’s not always that
simple—especially if you’re
using the Reliance IndiaMobile
service in India.

We took a look at a Nokia
(yes, the same reliable, easy-
to-use Nokia) model—the 2112
CDMA—available from Reliance,
and tried to send an SMS. Here
are the steps involved:

Menu > Messages > Text
Messages > Create Message >
Add Number > [Number
selected] > Options > [Option
4] Edit Message > Type
Message > Options > Send.

Whew! But there’s another
way too… scroll down to the
number you want to send the
message to and then:

Options > [Option 13] Send
Message > [Type Message] >
Send. That’s roughly 11 (or
about five) steps to send a
message. Actually it’s 15 (or 18)
if you count having to scroll to
choose ‘Edit Message’, but we
will be nice! 

Now, we wonder why
Nokia went ahead and
messed around with a
perfectly good, fast, intuitive
and easy-to-use menu system
and created this monster. Or
was it Reliance’s doing? 

Most other Nokia phones
(read GSM) allow three-step
access to the message window
(and just one step in some of
the new Symbian 60 phones).
Whoever the culprit, the menu
system is just terrible!

Nokia CDMA 2112

Gadget Can ‘Cure’ Cellulite
A gadget that removes cellulite has been a success in the US.
The gadget works by using infra-red light to break up the fat
that causes the cellulite. The Syneron Vela-Smooth then gives a
deep massage, followed by a suction action. The treatment
costs £80 (Rs 6,300) per session. 

Stampede For Used Laptops
Nearly 5,500 people had gathered to buy 1,000 used
laptops for $50 (Rs 2,200) in Richmond, Virginia in the US
on August 16. When the shop opened, a stampede ensued—
someone tried to drive a car through the crowd, and an
elderly man was thrown to the pavement. 

Next
month’s
winner will
receive  
EA Cricket
2004 Game

WE ARE NOT AMUSED

Google’s Chief Gets Googled
Ill
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FINALLY!

A Multi-
Buttoned 
Mac Mouse

Apple users may possibly
frown at this new,

think-outside-the-box
offering. It’s just not
Apple’s style. It’s a mouse
with more than one
button—four, to be precise.

And there’s a 360-degree
scroll ball, one that can
scroll diagonally as well!
Apple is calling it the
‘Mighty Mouse’. 

And mighty it is,
compared to the ghastly
hockey-puck mice that
shipped with the colourful
iMacs, and other stubbornly
single-buttoned Apple mice.

For some it is Apple’s
finest mouse ever. Others
call it a Trojan
horse—one of
several entry
points into the
Windows-user
territory. Another
indication of
popularising Mac
culture amongst
Windows users.

Although a

departure from the
traditional one-button
mouse, the Mighty Mouse
looks similar to the other
Apple models.

A major difference is the
small scroll ball at the head
of the mouse, which can
move cursors diagonally,
even up and down across
display screens, and can be
pressed to ‘click’ functions.

Since long, Apple has
built added functionality to
its OSes to accommodate
multi-button mice. But there
were no Apple mice to take
advantage of this. We
wonder why Apple took this
long to bring mouse
technology to 
the nineties!

Mighty Mouse, which
connects via a USB port, will
retail for $49 (Rs 2,130). It is
PC-compatible, but cannot
move the cursor diagonally
on Windows.

So, is this the beginning
of the end of the

traditional difference
between PCs and
Macs? A multi-
button mouse
eliminates one of
the important
differences. 

Recall that in
May, Apple said it
would cease using

IBM processors in favour of
Intel chips. With the new
mouse, Apple is seeking to
tap into the market for
accessories. 

This may be a leap
forward for Mac users, but
need Windows users pay any
attention? Lara Luepke of
ZDNet Australia sums it up
best: “For Apple Mac OS
Tiger users, the
scrollwheeling Mighty
Mouse is worth a look; for
everyone else, better options
are available.”

“MIND THE BOMBS”

Outrage Over
London
Underground
Terror Game

UK tabloid The Sun
recently discovered an

online game in which
players have to stop bombs
detonating on the London
Underground system.

In a sick take on the
“mind the gap” warning
(referring to the gap
between the train and
platform) that sounds over
the Underground every time

This month’s winner is 
Ravneet Randhawa
House 138, Katari Bagh,
Kochi - 682 004

Born in Hungary, John Luis
von Neumann was a child
prodigy. After his early

education in
Budapest, he
moved to
Zurich and
later to
Berlin, where
he received
degrees in
chemical
engineering

and mathematics. 
Von Neumann was a

brilliant mathematician
and a staunch supporter of
the stored-program concept.

His first association with
computers was with the
Harvard Mark I (ASCC)
calculator. His greatest
contribution to computing
was the EDVAC in 1945—his
single-handed creation. This
is when the elements of the
stored-program concept
were introduced to the
computing world.

The foundations of von
Neumann’s work were laid
out in the “First Draft of a
Report on the EDVAC” in
1945. It presented the first
written description of the
stored-program concept.

The report organised the
computer system into four
main parts: the Central
Arithmetical unit, the
Central Control unit, the
Memory, and the Input/
Output devices. This is
popularly known as the ‘von
Neumann architecture’.
Sounds familiar? It’s this
that has become the CPU-
Memory-IO system that all
computers use today!

The Institute of Electrical
and Electronics Engineers
(IEEE) continues to honour
von Neumann through the
annual IEEE John von
Neumann Medal, “for
outstanding achievements in
computer-related science
and technology.”

An All-Round
Genius

People Who
Changed

Computing

He wins 
The Unix
Programming
Environment 
by Brian W.
Kernighan & 
Rob Pike 
Published by
Pearson Education
(Singapore) Pte. Ltd.

Well Receiving Transmission

WIN!
Send in your entry and you could win a CCaannoonn  PPiixxmmaa  iiPP  11550000  just by sharing an amusing picture with a
tech angle to it. The picture should be shot by you, and should not have been published anywhere
earlier. E-mail your picture with the subject ‘DigiPick’ and your postal address oonn  oorr  bbeeffoorree  1155tthh  ooff  tthhiiss
mmoonntthh  to digipick@thinkdigit.com. One prize-winning picture will be published each month.

John von 
Neumann



a train stops, the game is
called Mind the Bombs!

The game’s Web site
invites you to “do your part
in the war against terrorism:
e-mail this FREE game to all
your friends, family and
associates to enjoy!” 

It also declares itself as
“dedicated to the good
people of Britain—
specifically those individuals
directly affected by terrorist
activity in London. God save
the Queen”. 

A disclaimer, evidently
by creator Keith Fieler to
avoid litigation, states: “This
game is in no way affiliated
with Transport for London.”

The Sun quoted London
Transport spokesman:
“Passengers on the
Underground and their staff
were faced with horrific
scenes on July 7. Anybody
involved in the making or
viewing of this game would
do well to stop and think
about that. We will never
forget those who were killed
and injured in the attacks.”

A representative of
London Transport Users
Committee raged:
“Londoners are just getting
on with it and we think
people should show this
game the contempt it
deserves. I don’t think
anybody will find it very
funny or very pleasant.”

Remember, a lot of people
actually died in the exact
same situation— trivialising
it does nothing but hurt.

IPODIFIED BABIES

Your Baby’s
An iPod

Some people have weird
ideas—like the folks at

ipodmybaby.com. Based on
the idea that some people
treat their iPods as if they
were real babies, this site is
selling baby clothes—you can
dress babies in them to
make them look like iPods!

At the iPod My Baby Web
site, you can order a pink,
blue, or white baby ‘onesie’
emblazoned with the
signature iPod scroll wheel.
But why? Obviously because
“the only thing cuter than a
baby, is an iPodified baby,”
as the site states. 

People hooked on their
iPods will probably find it
cute. But the rest of us just
don’t get it—why would you

want to make a baby look
like an iPod of all things?

Anyway, the onesies
come in three sizes and cost
$15.95 (Rs 695 approx). Also
available at the site is a
service called iPod My Photo,
which turns a picture of
your child—or anybody else—
into a mock iPod ad that can
be transferred on to T-shirts,
greeting cards and more. 

Ho-hum. Yet another
indicator of how popular
Apple’s portable music
player is…

GAME STUFF FOR REAL CASH

Mugged
Online!
A Chinese exchange student
has been arrested in Japan
on suspicion of an online
mugging spree—he used
software bots to beat up and
rob characters in the online
game Lineage II. 

The student then sold
the characters for cash, the
Mainichi Daily News reported

via New Scientist. The
audacious stunt
involved robbing online
gamers of several online
goods, including the
‘Earring of Wisdom’
and the ‘Shield of
Nightmare’. 
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Microsoft .NET
To be honest, .NET is a lot of
things. Actually, we know so
little about .NET that we
were ourselves tempted to
bluff our way through it
this month! 

Well, anyway, .NET is
“software that connects
information, people, systems,
and devices. It spans clients,
servers, and developer
tools”—whatever that
means. Just remember to
use those words when
talking about .NET! 

Now, Microsoft .NET
consists of many things:

The .NET Framework 
1.1, used for building 
and running all kinds 
of software
Developer tools, such as
Microsoft Visual Studio
.NET 2003
A set of servers
Client software such as
Windows XP
Now you at least know

what .NET is. So, what’s the
.NET Framework? Basically, it
is “an integral Windows
component for building and
running the next generation
of software applications and
Web services.” 

In addition, it is
composed of the common
language runtime (CLR) and a
unified set of class libraries.

Pay attention! The CLR is
responsible for run-time
services such as language
integration, CLR security
enforcement, and memory,
process, and even 
thread management.

Here’s how to sound as
though you know about .NET
programming: just say, “I’m
currently working on cross-
language exception
handling. That has a lot to
do with strong typing: and
runtime binding as well;
.NET makes it easy for
me to use class libraries
to do the exception handling
without having to go
into the intricacies of
Windows Forms.” 

Of course, that doesn’t
make any sense, but then
again, who’ll ever know?

While we were busy in a story idea
meeting, the Rain Gods were releasing

a century of frustration on Mumbai—and we
had no idea!

As the warnings started, panic slowly
filled our hearts as water seeped into our
office. While some preferred to stay back,
others were eager to reach home. Preethi,
the bravest of us all, firmly wrapped
herself in her red windcheater and left—
not knowing that her usual two-hour
journey was to become a 48-hour ordeal. 

People who lived nearby, Ram and our
ed Deepak, were home without a fuss.
Renuka was lucky too; she reached home in
an hour, albeit sans footwear. But some of
us—Ishan, Mithun, Raaabo, Aditya, Vijay and
Sanket—stayed overnight. We played cricket
in the corridors using a stress ball—releasing
stress. We ordered pizza, watched movies
and slept on the carpeted floor
(some used the conference
table). Meanwhile, the
water level rose

alarmingly and some cafeteria windows
were broken to let the murky water out.
Then, Raaabo and Vijay decided to brave
Mother Nature and headed home at 3 am,
despite pleas, and only reached at 11 am. 

The rest of us woke up bleary-eyed to
another urgent situation—a homesick
tantrum-throwing Mithun. Finally, we
resolved to troop back. Some walked 40 km
for 12 hours through waist-deep—and at
times neck-deep—water. Avoiding carcasses,
debris and open manholes, it’s a miracle we
reached home safe and sound. 

An enforced holiday followed. And now,
post the rains, our meals are served in a
small foyer that has sunlight streaming
through the glass ceiling. Our café remains
uninhabitable. Once, when we tried to
lunch there, it was like sitting on the
beach… the rain lashed at us through the

broken windows: surf’s up! 
And so is our team—back to

our schedules and
enjoying every moment!

When The Heavens Opened  
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The mugger was an
invincible character
controlled by a software
bot, and the stolen stuff was
sold on a Japanese auction
site, Lineage II publisher
NCsoft claims. So how was
the unnamed student able
to do this?

The thing is that bots are
pretty much invincible in
games of this sort—human
players don’t stand a chance.

If you’re wondering what
this means, recall that we
reported in this space about
the game EverQuest, where
game items can be
exchanged for cash. 

How this works is people
play online and try hard to
gather game items. And they
value the items so much
that they’re willing to buy
and sell them. 

In other words, the
players are literally living
online: their online
experiences are actually
translating into trade in the
real world. And items can be
sold, usually online, for
thousands of dollars.

New Scientist quotes
security guru Bruce Schneier
as noting in his blog: “I

regularly say that every form
of theft and fraud in the real
world will eventually be
duplicated in cyberspace.
Perhaps every method of
stealing real money will
eventually be used to steal
imaginary money, too.”

Ren Reynolds, a UK-based
PC games consultant says,
“There’s an ongoing war
between people who make
bots and games companies,”
Reynolds told New Scientist.
“And making real money
out of virtual worlds is
getting bigger.”

Reynolds says the
growing number of online
game players will only
increase the incentive for
scammers. “There’s nothing
exceptional about the virtual
world. Wherever there is
that sort of money, there’s
always crime too.”

There are reports that
some online scammers are
using ‘sweatshops’ in China
and Indonesia, where people
monitor teams of bots to
generate money while trying
to avoid bot traps! 

Compiled by Aditya Kuber,
Ishan Prakash, Ram Mohan Rao 

and Renuka Rane

Seriously… what were they thinking? Hudson Forest Equipment,
as the name suggests, deals in forest equipment. Since the

name hudson.com may have been taken, they’ve chosen
hud-son.com. OK, understandable. But one look beneath the
address bar and you will leap with fear. We did.

The top left of the first frame—yes, there are many frames—
has a photograph of a forest. Relevant, but it’s hugely under-
exposed and looks tacky. And it gets tackier. The right part of the
top frame has links placed one below the other and squeezed.

The second frame is a scroll line that says “Scroll down to view
our many products”. Thanks for pointing out the obvious! The next

frame shows a flag of France with a
link—“Our Canadian Office”. Click
that, and you are taken to page
that’s entirely in French, with a link
to Freetranslation.com. Whatever.

Scrolling down (as advised—
remember?), the shock deepens as
seven rows of nearly 40 photos
and links appear. These are their
products. The background is a
deep green (the ‘forest’ theme all
over again), and there are more

scrolling marquees saying a bunch of things. 
The real reason we got stuck here was a picture of a newborn

in the second frame from top. The caption says “New Addition at
Hud-son: Taylor David Hollenbeck”. Now, the owner’s name is
Hudson and the company is Hud-son. Assuming Taylor is a new
entry to the Hudson family, why should they ever write about a
new addition to Hud-son? Unless this is a new tool we don’t know
about… once more, we suggest, don’t go here. Will you listen?

whatweretheythinking.com

Cliques, Clicks, Bullies And Blogs
http://spaces.msn.com/members/hatefilledchild/

I am the Walrus
I am one of a long list of people, you shall see.
But I will never reveal my true identity. 
Crack the mystery and you shall win a prize.
But beware of my most frequent lies.
The name that though call me upon
is not that, of which my father titled his son.
Some would say that I speak a total of zero
Colonel Klink is not fond of my heroes
You would know who I am by now, 
if you’d followed the quest.
I hold a golden badge upon my chest. 
The very person that I most defame is myself
Jackson is my name, and I am a shit-dang-woozit-
head…..shelf… 
Or maybe I am none of the above.
I may be someone you all hate, 
or someone you all love. 
Rest assured my identity will not be found tonight.
So you can all just go and fly a fucking kite.

Nina Turns 40
http://ninaturns40.blogs.com/nina_turns_40/

light verse geekitude
I believe I mentioned that we at eVil corp. moved to a
new office suite in June, whereby I lost the perk of my
own private office and now share a bigger, better-

viewed office with two co-workers. This arrangement
has its disadvantages, but one of the fun things about
it is that one of the said co-workers is quite funny (he
does a kick-ass Kermit THE frog impression which
never fails to crack me up). He is young and charming
and cute, an advantage to anyone, but what won him a
special place in my wee little heart is that he partakes
in email limerick smackdowns with me. We fire emails
to each other filled with silly limericks composed on
the fly. You’d be amazed at how much this relieves
stress, and how much joy it brings me... Feeling
emboldened by this, I asked him the other day if he
liked to write double dactyls. He gave me a look. That
look means you’ve crossed the line from fun, silly,
office goofing into pure geekitude. He had no idea WTF
I was talking about. Sigh.

Naked Conversations
http://redcouch.typepad.com/weblog/

$100m VC Fund for RSS companies started
Silicon Valley Reporter’s Tom Foremski reports: Jim
Moore and John Palfrey have launched RSS Investors
with $100m of capital. It is the first VC fund with a
focus on Really Simple Syndication, (RSS), the syndica-
tion technology at the heart of media technologies
such as blogging and corporate news communication.

This shows that at least in some sectors, venture
money is getting smarter after several years of demon-
strating it had less vision than Ray Charles.

We bring you another
eclectic selection of
blogs this month: 
from a bard blogger
who dares you to
guess his or her
identity, to an 
office-goer who
reflects on the
experience of 
e-mailing limericks
and finally to 
funding on RSS in
Silicon Valley 

www.hud-son.com

www.hud-son.com
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Identify the correct domain
name for Palestine?

a. .pl b. .ps
c. .pt d. .pe

What are Super Scorpios?
a. A species of scorpions

b. A video game
c. Underwater robots used by the

US Navy
d. Satellites sent by NASA to Mars

Kevin Turner, the new COO of
Microsoft, was formerly

employed with which company?
a. Sun Microsystems
b. IBM
c. Wal Mart
d. McDonalds

What is the size of the
world’s largest digital

panoramic photo? 
a. 6.5 million pixels
b. 8.1 million pixels

c. 1.9 billion pixels
d. 2.5 billion pixels

What does LLU stand for?
a. Local Loop Unbundling

b. Laser Light Unicode
c. Last Leap at UCLA
d. Local Label Uniform

According to a recent 
study by SciVisum, a UK-

based Web site testing firm,
which department of an
organisation was held responsible
for majority of the company’s
Web site crashes? 
a. Human Resources
b. Information Technology 
c. Marketing 
d. Logistics 

Who are Palamida and 
Black Duck? 

a. Mathematicians 
b. Hackers
c. Software licensing specialists
d. Cartoon Characters  

What incentive is the
Scottish government

offering its adult citizens who
take up IT training? 
a. A weekend cruise to Hawaii
b. A personal computer 
c. £100
d. Guaranteed employment 

What does the e-border
scheme of the UK

government pertain to? 
a. A border surveillance
programme, it collects biometric
data on visitors to the UK 
b. It creates a virtual boundary
around all government offices in
the UK
c. It is a military strategy
developed for the UK Army
d. It rewards citizens who provide
information about infiltration 

10
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Across
7. Working at home and communicating through e-mail
or fax (13)
8. Natural state paper symbol in place of a 
character (4,4)
9. International Data Encryption Algorithm
(abbr) (4)
10. Electricity flow (7)
12. Representative program that gathers
information in the background (5)
14. Adaptive Differential Pulse-Code
Modulation (abbr) (5)
16. Microsoft’s multimedia encyclopedia (7)
19. Short for Any Transport over MPLS (4)
20. Sample shareware or HTML Assistant
Pro? (8)
22. Known as ‘tunneling’ in networking (13)

Down
1. Binary prefix multipliers breaks bite (4)
2. Text title (6)
3. Segments of addresses that specify an
organisation (7)
4. Wireless data transfer widely used in 
Japan (1,4)
5. Cord series of alphanumeric characters (6)
6. LANs connected through protocol (8)
11. Changing of data to present day and 
time (8)
13. Put a programme onto a computer 
system (7)

15. Common Random Access Memory (abbr) (6)
17. Unit of electrical power disperses bat wat (6)
18. Category of objects (5)
21. System base (4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
tq@thinkdigit.com
Mark ‘TQ’ in the
subject area.

Of Black Ducks
Name the mouse with a 3600

scrolling ability designed
specifically by Apple to work with
Mac OS X Tiger. 

a. Multi-mouse
b. Mighty Mouse
c. Mac Mouse
d. Major Mouse

1

August 2005 Solution 

Answers

Script kiddies are
inexperienced crackers, who

download software from the
Net that automatically
performs the cracking. 
It’s a derogatory term for
those who use scripts and
programmes developed by
others to compromise and
launch attacks on computers. 

Did You
Know?

Send your answers to the crossword
with complete contact details to
TQ@thinkdigit.com on
or before Sep 15. 
One lucky participant
will win: The UNIX
Programming Environment
by Brian Kernighan and Rob Pike 
published by Pearson Education
(Singapore) Pvt Ltd
(Indian branch in New Delhi)

7.Marketing 
8.Software
Licensing Specialists
9.£100
10.A border
surveillance
programme, it
collects data on
visitors to UK 

1.Mighty Mouse
2..ps
3.Underwater
robots used by the
USNavy
4.Wal Mart
5.2.5 billion pixels
6.Local Loop
Unbundling

Win!

There was no winner for the August 2005
crossword. 

Crossword by Nitta Jaggi



Four Marvellous Years 
First of all, kudos for bringing out such a
magnificent tech marvel and congrats for
completing four successful years as India’s
best tech magazine. I am a budding geek
and although I am not a subscriber, I keep
an eye on every issue of Digit and buy the
best of the issues. 

Your 4th anniversary issue was really
above par but I regret to inform you that I
was unable to enjoy it fully since the
DVD had a corrupted
structure...

I hope in future
you will not give me
a chance to complain.
I bought your July
issue too, which was
excellent; especially the
article on gadgets was
awesome. Hope you will
keep bringing such
excellent issues and tools through your
DVDs and CDs.

Rohan Malik
New Delhi

Dear Rohan,
Please accept our sincere apologies for the
damaged DVD. We have forwarded your problem
to the Help Desk and you should have heard from
them by now. Thank you very much for your kind
words and we assure we will do our best to
continue providing you the very best.

—Editor

I Am Now Tech Savvy!
I had been suffering from a phobia of
computer jargon till I started reading
Digit. Earlier, I used to see the huge packet
of Digit with CDs and wonder how people
read this hi-fi magazine… I would just
console myself saying “they must have
born with extraordinary brains”. 

But thanks to Digit, now even I am
comfortable with most of the
terminologies and am now considered
among the tech-savvy people in my
college! I hope Digit will keep on injecting
the technological fuel in me! 

Vineet Gaurava
Bangalore

Dear Vineet,
It is our pleasure to have been able to turn you
into a ‘tech savvy’ geek! And no, you don’t need
to have extraordinary brains to understand Digit.
That’s our whole aim: Make technology
understandable. Keep reading!

— Editor

Computing Nirvana
I recently read the editorial on your latest
issue of Digit. It really made me think. It
made me think whether we should be
made numbers or whether we should
fight for our own privacy? It is a question
that has been asked since the Internet was
created. Man needs both, his personal
space and peace of mind.

The Net, unfortunately, cannot
provide both. We have to learn to
compromise if we are to get anywhere. In
the real world, do people mark us as
numbers? Do they come up to us and ask
us what we have been doing every 10
minutes? No. But, in the digital world,
this will happen soon enough. 

As you so rightly stated, all Net users
will be classified by numbers and will
have neither a real identity nor privacy.
All they’ll have is a false sense of security. 

So, no matter what safety precautions
we take, there will always be those who
will find a way around it. But there is an
old saying, “The darkest hour of the night
is just before dawn”. 

That is the one sparkle of light and
hope that we must cling on to if we are to
make to computing nirvana. 

Manik Sinha
Via E-mail

Dear Manik, 
Well said. Nirvana is “the state of being which
follows the state of happiness in the growth of
the self”. Like Nirvana in real life, computing
Nirvana can also be achieved only through self
discipline and the state of happiness preceding it
can only be achieved through self knowledge.
Before I sermonise any more, suffice to say that
knowledge is the biggest step on the way to
Nirvana and educating yourself the only way to it!

—Editor

The Price Hike Is Justified. 
Or Is It?
I am a regular reader and a subscriber of
Digit. To me, it is like ‘a drug for my life’!
Each month I wait for my Digit and the
first week of each month is very crucial
time for me for I must get my issue before
the 7th or 8th of each month! 

One thing I would like to tell all
readers is that the rise in the price from
Rs 100 to Rs 125 was not too much
considering all the things provided by
Digit, which includes a DVD, a CD, Fast
Track and not to forget Digit itself. 

Regardless of what others pay for the
magazine, I get my copy at Rs 66.66 per
month because ‘wise men subscribe when
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Digit Forum

To post your comments on Digit Forum, 
visit www.thinkdigit.com/forum

C’mon, you can win a game!

chinmay_d
Warmed-Up Nerd
Location: Gurgaon, India
Whoa .. articles look nice ... seems I’ll have
to hurry to buy my copy ...  
My favourites topics:
Biometrics
30 Days With...
Geek Dreams
A Lossless Compression
Agent001
Tech Critique
Seems DIGIT is improving. There was no
article which didn’t interest me.

****************************************

ShekharPalash
Digitized!
Location: Toyland v8.0 BETA
Was little excited when I saw the
*BIOMETRICS* on cover... I thought this time
DIGIT covered lot of articles on Biometrics... I
thot *A Biometrics  Special Isue*... wow!
Unfortunately, It wasn’t. Article was good,
but kind  of small :(

Thanx for PDFs... as I forgot my last
month’s issue in the train! Lol... this month I
realized tht CD & DVD contents are different
for the last couple of months... lol... I used to
ignore CDs thinking it’s all n DVD...  !!

****************************************

QuickFire
Analogue Novice
Location: India
Received my issue tday due to mumbai
rains. Excellent Cricket 2005 review by
Raaabo but c’mon u can win a game easily.
Its not that difficult. The Q&A and other
regular sections are good. Yet to go
through all the contents but overall looks
ok. The editor’s post abt improvement in
quality of digit is not correct. Maybe
quantatively, digit has improved.  

More contents due to that Fast Track
booklet and I appreciate that but quality
needs a lot of improvement. Even the paper
quality of last couple of issues is not upto
the mark. I think you people should come
up with more interesting articles!

****************************************

Biplav
In-House Geekc
Location: U REALLY WANNA KNOW???
I must say the Fast track was superb this
time round. Although I had a  
fair bit of knowlegde in most of the things
written down; but then the “fair bit” was
enhanced like hell!!!. Make no mistake
about it, this was an awesome read.
i read the entire thing on my journey in the
train. The Magazine was good (although I
am not interested in MFDs and printers).  
Another thing: has the magazines paper
quality reduced???
All in All hats of to the Fast Track Writers
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the time is ripe. The unwise keep waiting
for a better offer that may never come’!

Shalabh Agarwal
Lucknow

I am a student of class XII. I am reading
this magazine for a long time now. I really
like the contents. But I am unhappy with
the price hike. Students like me who are
interested in technology and are from a
middle class family find it tough to shell
out Rs 125 every month. Last month, when
I saw the price, I thought of not buying it.
But after a few days, I could not resist. 

This magazine has become an
essential commodity to serve the hunger
of knowledge. Now that we are obliged to
bow our heads to such blackmailing, I
think we have the right to ask for
something more. I think one (or more)
page (s) could be added to deal with career
guidance in this field for all students. I
would also like to see some part-time jobs
being offered for students. 

Anindya Sadhu
Kolkata

I have been a reader of Digit ever since I
came to India seven years ago. Now I am a
subscriber and I wear the tag proudly. In
fact, I have even bought a CD album to
preserve the CD/DVDs I get every month.

A couple of things I wanted to say: why
are people cribbing about a mere Rs 25
hike in the price? For crying out loud, it’s
just Rs 25. Even a litre of fuel costs more.

Thought number 2: you guys have the
best sense of time and punctuality I have
known ever since I came to India. Even
when ‘Mumbhai’ went underworld (pun
intended), you said, you would deliver
your copies within the 15th and you did.

Matt
Bangalore

Dear Shalabh, Anindya and Matt,
What can I say? Two of you support the price hike,
while Anindya is opposed to it. One glaring
difference here is that Shalabh and Matt are
subscribers and hence, were not hit by the price
hike. Anindya, I thank you for your unflinching
support but the price hike was inevitable. Prices
of raw materials and all other aspects involved
have gone up and for the magazine to survive, we
had to take this rather difficult decision. 

All I can say is I hope we continue to have you
with us. May I suggest going in for a subscription?
It would bring down your per copy cost. On the
whole, though, thank you all for your support and
your suggestions have been noted and we will act
on them ASAP.

—Editor

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar
Building, MIDC, TTC Industrial Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages.
Letters may be edited for clarity. YYoouu  mmuusstt  iinncclluuddee
yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the Help Desk at 
022-27629191/9200, Fax 022-27629224, or 
send an e-mail to help@jasubhai.com

Is Backup Legal?

Recently, a senior citizen had written to
Digit sharing his experience, which
prompted me to write as well. I am sure
that like me, many of your regular
readers are senior citizens. I was
working in the R&D department in a
multinational prior to retirement. 

I have been a regular reader of Digit
since inception and a subscriber since
March 2004. I am a very choosy person
in every aspect of life and, therefore, my
loyalty as a Digit reader over the years
could not have been sustained without
some powerful reasons—reasons that I
regularly see in the words of other
readers, month after month, in the
“Inbox” column-words that I mostly
agree with and am, therefore, not going
to repeat. 

As for the context of this letter,
suffice to say that articles covering
various IT-related technical as well as
legal issues published in Digit have
inspired me to raise a related issue that
has not been addressed clearly so far. I
am talking about the question of
possible copyright violation by innocent
PC enthusiasts trying to backup their
collection of old audio/video material
currently on media that are becoming
obsolete and/or are fast deteriorating
with age.

As for analogue to analogue backup
of audio/video content, my
understanding is that if one makes a
single instance (backup) copy of a
copyrighted material (that was legally
procured), solely for one’s own use and
does not share the copy with anyone
else (not to speak of selling!), or use it
for any profit making purpose (public
shows, for instance), there is no
violation of any law. That is only the
basic principle, however. 

Possibly, that is exactly where the
trouble lies! The law was simpler and
straightforward in the analogue era.
Things began to change with the advent
of the digital era. For a common IT
enthusiast, the situation is becoming
progressively restrictive vis-à-vis the
entertainment industry, particularly
with the availability of mass-marketed
DVD recorders and PVR solutions. 

Although creating a backup of one’s
legally procured commercial software is
still allowed, the right of the consumer
to make a “backup copy” of his/her
(commercial) DVD movie has been

successfully contested in the US apex
court by the Hollywood studios recently,
or so I heard. I have no problem with
that, but what about an old-to-new
trans-format backup? I have no clue!

Nobody talks clearly about the
legality of backing up one’s collection of
analogue audio/video content to digital
media, although suggestions (and even
step-by-step instructions) for such
activities abound in highly
respected publications: “Rip
Your Records: If you miss
those tunes, here’s the
good news: You can
easily make clean digital
copies of them”, “So now
you can easily backup to
CDs all your treasured
music on those old vinyls that
you have held on to for so many years”,
or something to that effect! 

However, is such an activity strictly
legal? The situation is even hazier for
video. For example: “So where does that
leave that pile of old VHS videocassettes
you have up in the attic? Fortunately,
converting your old tapes to digital form
allows you to... output them to DVD,
preserving them for the future”, so goes
an article (Not in Digit). 

That brings me to the issue of trans-
format backup. I have a large collection
of my favourite Indian music on LPs, EPs
and analogue cassette tapes, and an
even larger collection of video
recordings on old VHS cassettes (movies
as well as other programs of my
interest), either on original, legally
purchased cassettes, or recorded off the
cable. Many of these audio/video
contents are not available on digital
media and many are not available in any
format today. 

My quandary is very obvious: Would
it be a violation of existing copyright
laws if I backup (to CDs and DVDs) any
of the following from my collection:
(1) Recorded from live broadcasts
(2) (Legal editions) purchased from the
open market?
If the answer to any of the above is “Yes
that would be illegal”, does the answer
change if such audio/video content is
not available in the digital format, or is
no longer available in the market in any
format at all? Answering this may just
help dispel the confusion among many
other Digit readers too.

Subhendu Joardar
Via e-mail 
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People And Events That Grabbed Headlines—For Better Or For Worse

Aswimwear manufacturer
in Britain has come up
with an innovative idea

to give you an even tan—a
bikini that reminds sunbathers
to turn over so they don’t
get sunburnt.

The Tan-Timer Bikini has
an electronic timer that beeps
every 15 minutes to remind its
wearer to roll over or seek
shade, depending on the
settings. With research
revealing that 59 per cent of
the beachgoers in the United
Kingdom have a tendency to
fall asleep in the sun, the

company hopes to find a large
enough market for the £20 (Rs
1,500 approx) bikini. 

The bikini will be available
at the New Look stores,
Britain’s third-largest women’s
clothes retailer. A New Look
spokeswoman said a male
version is likely to be designed
and launched in the near
future. Imagine wearing a
timer in your boxers or briefs!

The next time you walk
past a sunbathing beach
beauty in Goa or Kerala and
hear a beep, it would probably
be the timer going off...
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In weird goings-on at eBay
this month, we have two
cases of corpses being put

up for sale. Not just any old
corpse, but the bidders’
own corpses.

A UK man called Daniel
O’Dee put up a listing where he
offered his own corpse for sale.
Such auctions are usually
pulled down quickly by eBay,
but often this happens a little
too late. In this case, a response
got to O’Dee from a German
who called himself ‘Donnie,
the Hannover cannibal’. 

Donnie said he’d pay
£2,000 (Rs 1,60,000) if O’Dee
could get him a “fresh corpse.”
O’Dee later got a death threat
after he failed to reply to this
message. Talk about bringing
trouble upon oneself...

But that’s not all in the
eBay department this month.
24-year-old Andrew Beutin, a
“dangerous-sports fanatic with
a morbid sense of humour”,

put up his corpse for sale as
well. Beutin claimed to be in
good health, and said he
“didn’t have any reason to
expect his demise any time in
the near future.” But he cited
some of his “dangerous” habits
in his item description:

“You are bidding for the
sole right to advertise on my
corpse... as soon as my corpse
is discovered and otherwise
legally available to you. As
the winning bidder, you will
have the right to advertise on
my corpse, definitely during
the funeral. You are welcome
to photograph the ad after it
is finished as well as attend
the funeral.” 

That got all of us
wondering who would bid on
this ‘item’. GoldenPalace.com is
a likely candidate. This, as you
may remember, is the company
that had the winning bid to
advertise using a tattoo on a
girl’s forehead.

Death Becomes Him!

JK Rowling, author of the
billionaire Harry Potter
series, has been called a

“Luddite fool” for inadvertently
encouraging fans to pirate the
latest Harry Potter book only
hours after its official release. 

The sixth instalment of the
popular series was released on
July 16 and is expected to
further enhance what has
become a multibillion-dollar
publishing phenomenon. But
within hours, Harry Potter and
the Half-Blood Prince had been
scanned and put online by an
underground collection of fans
capitalising on Rowling’s
decision not to release an
official e-book version. 

By midnight of July 16th,
hundreds of users were already
reading the book thanks to
Potter fans who organised over
Internet Relay Chat (IRC) to scan
and distribute the book. 

Potter fans co-ordinated a
worldwide effort to turn the

book’s 672 pages into a home-
brew digital copy—now available
on most file-sharing networks.

Just 11 hours, and all the
secrecy maintained for months
went down the drains of the
Internet! Wonder if Harry has
any tricks to stop these muggles!

Rowling’s Howler

For any quiries regarding the Digit Patron programme, e-mail us at digitpatron@jasubhai.com

Bikini wearers now need not fear getting sunburnt—thanks to the timer

Time To
Roll Over




